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Technology Licenses

The hardware and/or software described in this document
are furnished under a license and may be used or copied
only in accordance with the terms of such license.

Warranty

The material contained in this document is provided “as is,”
and is subject to being changed, without notice, in future

editions. Further, to the maximum extent permitted by appli-

cable law, Agilent disclaims all warranties, either express or
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implied, with regard to this manual and any information con-
tained herein, including but not limited to the implied war-
ranties of merchantability and fitness for a particular
purpose. Agilent shall not be liable for errors or for inciden-
tal or consequential damages in connection with the fur-
nishing, use, or performance of this document or of any
information contained herein. Should Agilent and the user
have a separate written agreement with warranty terms
covering the material in this document that conflict with
these terms, the warranty terms in the separate agreement
shall control.

Restricted Rights Legend

If software is for use in the performance of a U.S. Govern-
ment prime contract or subcontract, Software is delivered
and licensed as “Commercial computer software” as
defined in DFAR 252.227-7014 (June 1995), or as a “com-
mercial item” as defined in FAR 2.101(a) or as “Restricted
computer software” as defined in FAR 52.227-19 (June
1987) or any equivalent agency regulation or contract
clause. Use, duplication or disclosure of Software is subject
to Agilent Technologies’ standard commercial license
terms, and non-DOD Departments and Agencies of the U.S.
Government will receive no greater than Restricted Rights
as defined in FAR 52.227-19(c)(1-2) (June 1987). U.S. Gov-
ernment users will receive no greater than Limited Rights as
defined in FAR 52.227-14 (June 1987) or DFAR 252.227-7015
(b)(2) (November 1995), as applicable in any technical data.

Index



Contents

About this Manual ... sn e s sn e naas 6
IN ThiS MANUAL.......ooee e Ji
Related DOCUMENTS ........oouiecccccc ettt 9
How to Use this Manual ...ttt 11

0T TG T PP 15

Looking at 2100 EXPert ...t ss e se e s s e s sss e e s e s s e ssessesasnnsens 32
Introduction to the Key Features of the 2100 expert.........cccoeveveeeceecccceceeeeeee, 33
STArting 2100 EXPEIt ...ttt 35
2100 EXPEIt WOIK AT ...ttt st ss e s seaes 37
ClOSING 2100 EXPEIT....vveeeeieeee ettt ettt bbb s s s e 49
The Security Pack of 2100 @XPErt.........ccoeiiiiiecceceee e 50

Running and Evaluating Electrophoretic ASsays .......c.ccccoerrrrrrcccnnsssssessess s e 66
Principles of Nucleic Acid and Protein Analysis on a Chip.......ccocooeeeeereisececeee, 67
Preparing and Running an Electrophoretic ASSay.........cccovvvveieievecccrccccee e, 71
Analyzing and Evaluating the Results of an Electrophoretic Method........................... 104
RESUIL FIagQiNg ...t 175

Contents A3V Index



Running and Evaluating Flow Cytometric Methods...........ccccrverrrrrrcnrcrcrcececerees 189

Principles of Flow Cytometric Measurements .........ccocooeeeeeeeeeeseseeececeeeeeeesesesee e 190
Overview of Flow Cytometric Methods ... 199
Preparing and Running a Flow Cytometric Method ............ccccooovviieiicccccccccc, 202
Analyzing and Evaluating the Results of a Flow Cytometric Method ........................... 235
Working with Chip Data and Methods............ccoceoveerrrccrsrr e 288
2100 Expert Data DVEIVIBW ..........ccuveeviecieeeeceeeeeeeeeee ettt 289
Handling MEethOds ...ttt 293
Handling Chip Data........c.ccuvieioiceeeeececcee ettt 301
Organizing, Backing up, and Archiving 2100 Expert Data ........cccccoovvvvevcecicececeeecene 303
IMPOrtING DAtA........cuieiicicicee ettt 305
EXPOrtiNG DAt ....c.cocvcveiie ettt e 312
Printing REPOIS ....covee ettt e 324
ConfigUIING TADIBS ...ttt s s 329
Administering System Functions and the Security Pack...........cccovrvrrrrrrcercevcencenenne 335
ACCESS CONTIOL ... 337
Configuring 2100 EXPEIt......c.cceeveeeeeeee ettt s 344
Exporting and Importing Multiple Data Files..........cccoeveeeiviceeeecececeeeeeceee e, 353
ArChIVING DAta........coiiccccccee bbb 356
USING LOG BOOKS ...ttt s s 360

Contents A4V Index



Running Instrument DiagnostiCs ..........ccoceeeriincncnnsn e sns e ssesnens 369

How to Run Instrument Diagnostics Tests......cccoviceiiciccecccceeeccee e, 374
Performing Verifications ... s s snssnssesnens 378
Products, Spare Parts, and ACCeSSOIIeS.........cccocrrrerrrrcrcsscrs st saeas 387
] [T 1 o 391

Contents ALYV Index



About this Manual

Welcome to the User’s Guide for the Agilent 2100 expert software. This manual provides
beginners and advanced users with information needed to successfully run
electrophoretic and flow cytometric assays with the bioanalyzer.

The 2100 expert software allows the control of the bioanalyzer (including diagnostic
functions) and, in combination with a LabChip kit, the acquisition, interpretation and
result presentation of data generated during the analysis of DNA, RNA, proteins, and
cells.

Contents A6V Index



In this Manual

This manual provides bioanalyzer users with the following information:

« “About this Manual” on page 6 gives an overview of the subjects in this manual, and
lists major innovations and improvements of the 2100 expert software. It also lists
supplemental literature and shows you how to make efficient use of this manual.

e “Quick Start” on page 15 is meant for experienced users. It briefly summarizes the
necessary steps to prepare and run a method. Please note that in terms of the
2100 expert software, a method resembles an extended assay, which also includes
additional administrative data such as operator, instrument, reporting, and workflow
settings.

e “Looking at 2100 Expert” on page 32 shows how to get started with the 2100 expert
software, and outlines its main operational possibilities.

* “Running and Evaluating Electrophoretic Assays” on page 66 explains how
electrophoretic measurements are made using the bioanalyzer, gives detailed
descriptions of all steps necessary to run electrophoretic methods, and shows how to
analyze and evaluate results using electropherograms and gel-like images.

* “Running and Evaluating Flow Cytometric Methods™ on page 189 explains how flow
cytometric measurements are made using the bioanalyzer, gives detailed descriptions
of all steps necessary to run flow cytometric methods, and shows how to analyze and
evaluate results using histograms and dot plots.

e “Working with Chip Data and Methods” on page 288 shows you what to do to open,
save, import and export files, and how to print the results.
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“Administering System Functions and the Security Pack” on page 335 explains the user
management features and is your guideline for configuring the 2100 expert software.

“Running Instrument Diagnostics” on page 369 shows how to use the diagnostic tests
to check the bioanalyzer hardware for proper functioning.

“Performing Verifications” on page 378 describes how you can validate your
bioanalyzer system.

“Products, Spare Parts, and Accessories” on page 387 lists all parts and
accessories—including reorder numbers—that are required for electrophoretic and
flow cytometric measurements.

“Glossary” on page 391 explains terms in context with flow cytometry, electrophoresis,
and terms specific to the bioanalyzer software and hardware.

If you have any questions this manual cannot answer, please refer to the supplemental
literature listed in “Related Documents” on page 9. If you still have questions, contact
Agilent for additional support at:

http://www.agilent.com/chem/labonachip
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Related Documents

A collection of supplemental literature is given in the following.

Bioanalyzer Manuals

Publication Number Title

G2938-90006 Agilent 2100 Bioanalyzer Installation and Safety Manual

G2946-90003 Agilent 2100 Bioanalyzer Maintenance and Troubleshooting
Guide

CD-ROM

Publication Number Title

G2946-60002 Agilent 2100 Bioanalyzer — How to Use Multimedia CD-ROM

Reagent Kit Guides

The Reagent Kit Guides give you information on how to perform specific methods,
including sample and chip preparation.

Publication Number Title

G2938-90300 Kit Guide Binder English (including all Reagent Kit Guides)
G2938-90010 Reagent Kit Guide DNA 500 and DNA 1000 Assay
G2938-90020 Reagent Kit Guide DNA 7500 and DNA 12000 Assay
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Publication Number Title

G2938-90030 Reagent Kit Guide RNA 6000 Nano Method
G2938-90040 Reagent Kit Guide RNA 6000 Pico Method
G2938-90050 Reagent Kit Guide Protein 200 Plus Method
G2938-90060 Reagent Kit Guide Protein 50 Method
G2938-90070 Reagent Kit Guide Cell Fluorescence Methods
G2938-90080 Reagent Kit Guide Cell Fluorescence Checkout Kit

Application Notes and Technical Notes

Application Notes and Technical Notes are available from the Agilent 2100 Bioanalyzer
Help Desk or from the lab-on-a-chip web pages:

http://www.agilent.com/chem/labonachip

Newly Published Documentation

Follow this link to see if there is any new documentation:

http://www.chem.agilent.com/scripts/Library.asp
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How to Use this Manual

This manual uses convenient online navigation features and follows certain typographic
conventions.

Online Navigation

Use the interactive bookmarks in this Use Acrobat Reader’s navigation bar
frame to move to your desired topic. to move around within a topic.
E& Adobe Acrobat - [eBook._pdf]
E File Edt Document Tools “iew ‘Window Help _|5’|5|
I ki
EEEEEE - A8 E 4P|« 2k -aODdE -
° Bl T B Bookmark = Quick S
; ) Agilent 2100 Bioanalyzel= uick Start
:E E-[]2100 expert User's Guid
b= -] About this Manual
...... 9 Quick Start Eleafszl::::? i::sp-h‘ﬁ-::ep; i;:ftru-:tior::::::l:::iz\e the basic steps nesded to perform a
p &[] Operating Basics twith the Agilent 2100 binanalyzer.
£ []____D Switching Eetwean E Preparing the Agilent 2100 Bisanalyzer
g []____D Running and Evaluatil 1 E1su|r|35hatthe; pro'!.je:icamidie is installedd ilnherf hioanalyzer. You can identify the
,E installed cartridge by the number engraved in its front:
B[] Running and Evaluati ’ ’
WW_ -] Configuring 2100 exp i (I8 Engraved number
I B[] Running Instrarment C =
§ ------ [ Performing Qualificati
© []"--D 2100 expert Software :
Click here to go to the table of contents. Click here to go to the index.

Here is the current page number.
A Displays the previous page.

WV Displays the next page.
Y Y
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After you have chosen a topic with the bookmarks, use the buttons in Acrobat Reader’s
toolbar to move around within the topic.

Displays the next page. Returns to the previous view.
Click several times to undo

more view changes.

Displays the previous page.

8- B 144 >|||l dleF= ~e|0EmE|s-

EEESa &

Returns to the next view.
Click several times to redo
more view changes.

Displays the first page.

Displays the last page.
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Layout Conventions

The following typographic conventions are used in this manual:

Highlight Meaning

Italic On-screen element
Example: ... the OK button.

Emphasis
Example: Right-click the ...

Term
Example: Dot plots show events as dots.

Reference to another document
Example: Refer to the Agilent 2100 Bioanalyzer Troubleshooting and
Maintenance Guide.

Blue Cross-reference or hyperlink
Examples:
“Introduction to the Key Features of the 2100 expert” on page 33
http://www.agilent.com/chem/labonachip

Courier Code
Example: .. the command line parameter -port 2 ...

Courier User input
bold Example: Enter 50 MB.
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Safety Notices, Notes and Tips

Safety notices, notes and tips in this document have the following meaning:

WARNING

A warning notice denotes a hazard. It calls attention to an operating procedure,
practice, or the like that, if not correctly performed or adhered to, could result in
personal injury or death. Do not proceed beyond a warning notice until the indicated
conditions are fully understood and met.

A caution notice denotes a hazard. It calls attention to an operating procedure,
practice, or the like that, if not correctly performed or adhered to, could result in
damage to the product or loss of important data. Do not proceed beyond a caution
notice until the indicated conditions are fully understood and met.

NOTE
A note contains important, helpful, or additional information.

TIP
A tip usually points out a timesaving feature.
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Quick Start

The following step-by-step instructions guide you through a measurement with the
Agilent 2100 bioanalyzer.

Preparing the Agilent 2100 Bioanalyzer

1 Ensure that the proper cartridge is installed in the bioanalyzer. You can identify the
installed cartridge by the number engraved at the front.

Engraved number

Note that there are also electrode cartridges
without an engraved number.

@ = Electrode Cartridge for electrophoretic methods
@ = Pressure Cartridge for flow cytometric methods
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2 If you have to change the cartridge, follow the instructions in “Loading the
Electrophoresis Chip into the Bioanalyzer” on page 80 or “Loading the Cell Chip into the
Bioanalyzer” on page 212, respectively.

Switching on the Agilent 2100 Bioanalyzer
1 Make sure the bioanalyzer is connected to line power and connected to the PC.
2 Turn on the line switch at the rear of the instrument.
The status LED at the front of the bioanalyzer should light up.
Lid
Status LED
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The status LED shows you the current status of the instrument.

Signal Meaning

Green light Instrument is switched on and ready for measurement.
Green blinking Measurement is running.
Orange blinking  Instrument is busy (running self diagnostic, for example).

Red light Instrument is not ready for measurement. Switch the instrument off
and on again. If the problem persists, call Agilent service.

Running a Measurement

1 To start the 2100 expert software on the connected PC, go to your desktop and
double-click the following icon:

ia b
2100 ex;l%t

2 The accesstothe 2100 expert and its functionality is controlled by the installed security
pack. You need to authenticate yourself with your user name and password.
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2100 expert - Logon

Enter user name, password and seleck rale thak is valid
for the 2100 expert user,

Uset narme : I advaoper

Full name : rlr. Advanced

Passwiord I A

Roles : I.ﬂ.dvanced Operakar j

K I Zancel | Cpkion :=-:=-|

For more information on the user management of 2100 expert, see “The Security Pack
of 2100 expert” on page 50.
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After startup of the software, you enter the /nstrument context:

LY

Fle Context W“iew Method Instrument Windows Help

Instrument

Instrument D\agnostlcsl

Mame: COM Port Ingu s
Serial#: Method Selection: M
Cartridge:

SkartySkop Run:
Wendor: 0 s

Praduct 10 Methaod: 4. .Demo DHA 7500 Cuskom. xsy

o Instrument 3

Firmware: Simulation Mode: Data File:

Assay Comments:
r~ Destination

Copyright @ 2003 Agilent Technologies
% f+ Default C:\...sDMA\DNA 7SO0\Demo DA 7500 Custom

€ Custom €:...5DNAIDNA 75001 Demn DA 7500 Custom |

File Prefix (2100 expert (max 16 characters)

Data Acuisition Parameters —Start Run Checklist
Is the instrument ready?
Run samplz: 1 to [z = L4
l_ =l o Is a chip detected?

o Is selected instrument valid For this assay?

of Does the cartridge and the selected assay match?
o Are all required licenses applied?

of Is current instrument valid For the selected method?
of Does the user have rights to start a run?

Chip Setup

\ \OFFIme (Dema Made) |sMr. Advanced as Advanced Operator Auto Export | Auto Print

NOTE

If you started 2100 expert for the first time after installation, you first need to activate
the different software modules with your license keys. See Figure ,“"How to Activate
Software Licenses” for details.
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The Instrument tab shows you the status of the bioanalyzer:

Icons Meaning

Bioanalyzer detected, lid is open.

Bioanalyzer detected. Lid is closed, but no chip is inserted.

No bioanalyzer has been detected.

Check the COM Port setting (see figure under step 3), the RS 232
connection cable, the power cable, and the power switch. For
details on how to set up the bioanalyzer and connect it to a PC, see
Agilent 2100 Bioanalyzer Installation and Safety Guide.

3 Make sure that a bioanalyzer has been detected before continuing.
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4 Select a method for the chip run.
On the Instrument tab, click the Methods button.

—0OR-
Click the Methods menu.
Both will open a menu, allowing you to select a method for the measurement.

Note that you can also select File > Open File to Run. This opens a dialog box allowing
you to load either a method (.xsy) or a chip data file (.xad).

5 Prepare the samples and the chip.
For detailed information on sample and chip preparation refer to:

— Reagent Kit Guides that are available for each reagent kit

— Application Notes that are available for specific kits and applications

NOTE

When preparing chip and samples, pay attention to the essential measurement
practices described in “Essential Measurement Practices (Electrophoretic Methods)”
on page 77 and “Essential Measurement Practices (Flow Cytometric Methods)” on
page 210 or as described in the respective Reagent Kit Guide.
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6 Insert the chip in the Agilent 2100 bioanalyzer:
a Open the lid.
The status of the bioanalyzer is updated on the Instrument tab.

b Check that the cartridge is inserted properly and the chip selector is in the correct
position (“1” for electrophoretic methods, “2” for flow cytometric methods).

For details, please refer to “Loading the Electrophoresis Chip into the Bioanalyzer”
on page 80 or “Loading the Cell Chip into the Bioanalyzer” on page 212, respectively.
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¢ Place the chip into the receptacle. The figure shows this for an electrophoresis chip.

Chip

The chip fits only one way. Do not force it into place.

Do not force the lid closed. This may damage the cartridge.

d Carefully close the lid.
Electrophoretic methods: the electrodes in the cartridge fit into the wells of the chip.

Flow cytometric methods: the adapter with the gasket in the cartridge fits onto the
priming well of the chip.
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When the chip is detected, the image on the /nstrument tab changes to a chip.

4
£
g
E
¥
g

If the chip is not detected, open and close the lid again.

7 On the Instrument tab, click the Start button.

() start |
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8 Before the chip run starts, you are prompted to confirm this action with your electronic
signature. This action is then recorded and will be available for reviewing in the
signature log and the audit trail.

Electronic Signature

List of changes:

Description

nm Starting run in the instrumen

Meaning: Started Chip Run j

Comment:

Dema DNA 7500

—Signature
LUser: M. Advanced as Advanced Operator

User v Jadvaoper

Password: |********

Domairn: IPC_MM_SK j

OF I Cancel Help

NOTE
The signature must be saved with the correct setting in the Meaning field. If this
setting cannot be pre-selected by 2100 expert, you must do this selection manually.
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NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

The chip run starts. The Raw Signals sub-tab shows an electropherogram of the currently
measured sample. The name of the sample is displayed above the graph. The graphis a
“live” plot of the migration time against fluorescence units (raw data, including
background fluorescence, for example).
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32100 expert == x]

File Context Miew [Method Instrument  Windows Help

Instrument - |@ “EH ;’-t E!

Contexts

Instrument

$* Running

Diagnostics I

Mame: COM Port IDsmu e

v Instrument 2
o Instrument 3

Serial#:
L] Method Selection: g 11t
"*\"n Cartridge:
SkartySkop Run:
Wendor: @ Stop
Praduct 10 Methaod: 4. .Demo DHA 7500 Cuskom. xsy
Firmware;  Simulation Mode Data File: Cil... 2005-05-19 14-01-59.xad

Sample 3

Fluorescence
w
=
=

T

=

i}

=}
T

1 L

150+

I
30 40 50 B0 70 &0 an

Time [5]
Chip Setup | Raw Signals
4| »
|Readlng Sample 4 ... (LLL[1] \OFFIme (Dema Made) |sMr. Advanced as Advanced Operator Auto Export | Auto Print

The number of the sample that is currently being measured is indicated on the
information bar:

€ Eunning

The status bar at the bottom of the window shows the measurement progress for the
chip run and the COM port number used for data acquisition.
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During the chip run, you can do the following:

* View the chip data file in the Data context by clicking on the name of the Data File:

COM Pork IDeml:u vI

Method Selection: E Methods

Skart)Stop Run: @ Stop
Methiod: .. .Demo DS 7500 Cuskam, xsy
Drata File: .., Z005-05-19 14-01-59,xad

» Switch to any other context. For example, you can evaluate any chip data file in the Data
context, or compare samples in the Comparison context.

* If necessary, abort the chip run by clicking on the Stop button. You need to confirm this
action with your electronic signature.

All data that was collected up to the stop point will be saved.
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Viewing the Measurement Results

To view the results, switch to the Data context. The data file that has just been

generated by your chip run is displayed. The Chip Summary tab shows information on
your chip data file, and lets you enter comments regarding chip, samples, and study.

Eile Context “iew ‘Workflows ‘Windows Help

=18]x]

Import.,.. | Export... |

2100 expert_DNA 7500_00 ’
[ Al Samples Data File @ 2100 expert_DNA 7500_00000_2005-05-19_14-01-59,xad
-] Sample 1 Lacation : i:...2100 expertiSecuredarealDataldsDNAIDNA 75000Dema DA 7500 Custom
|| Sample 2
0] Sample 3 Created : Mai 19, 2005 14:02:05
~|Ll] Sample 4 Modified :  Mai 19, 2005 14:04:07
|| Sample 5
|| sample & Software ; Created by version B.02,01,5I211, modified by B.02,01,51211
E ::z;: ; File Wersion : 1 {Latest version)
~|]] sample 9
|1 Sample 10
IC]| Sample 11 Sample Mame | Sample Comment | Rest, Digest | Status Observation Result Label Result Color Approved
~-{]] Sample 12 [t |pcRmicl ref. - o b, Mot Reviewed
-|L1] Ladder aEC r v I Mot Reviewed
3 |Sample 3 [l a ¥ Mot Reviewed
4 [sample 4 [l & &y Mot Reviewed
5 |Sample 5 [ & % Mot Reviewed
& |Sample 6 [l a & Mot Reviewed
7 [sample 7 [l & &y Mot Reviewed
& [Sample & [ & ! Mot Reviewed
o |Sample 9 [l a % Mot Reviewed
10 [Sample 10 [ [ o« b, Mot Reviewed
11 [Sample 11 [ & % Mot Reviewed
12 [Sample 12 [l a ¥ Mot Reviewed
[ Chip Lot # [ Reagentkitlot# |
Chip Comments :
prepared by laura
Sample Infarmation ‘ Instrument Information | Standard Curve

| @ Mr. Advanced as Advanced Operator
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9 Inthe tree view panel, click any sample name or the ladder.

This selects the Electropherogram tab, which displays a data plot of size/migration
time versus fluorescence intensity.

Y#2100 expert - C\..ea'Data’dsDNA'DNA 75004 Demo DNA 7500 Custom’;2100 expert_DNA 7500_00000_2005-05-19_14-01-59.ad - | = ﬂ

Eile Context “ew Electropherogram ‘Workflows Windows Help

Data RHos|ENE 8 ke OO0 |00 OM|.2E | M- -3 [E& B /|-
Ele...CR Mix 3a (Mot Reviewed) Analysis

- W Al Files General Properties I Assay Propetties I Chip Summary 1 el 1 Electropherogram | Result Flagging ] Log Eﬂﬂk}
ﬁ £ [ 2100 expert_Dha 7500_00
Instrument [ &l Samples [FU] = PCR Mix 3a
- 200~

@ Sample 4

O] sample 5 400
(] sample &
@ Sample 7

O] sample 8
(] sample 9 2004
@ Sample 10

O sample 11
{0 sample 12
@ Ladder 200

1004

o4 —_—
A
L T T T T T T T T T
S0 300 500 700 1000 2000 10380 [bp]
Size [bp] | Conc, [ngjpl] | Molarity [nmolfl] | Observations -
1|4 50 8,30 251,5 |Lower Marker
2 74 8,80 179,7
K] 113 1,92 25,7
4 165 0,95 87
5 215 2,56 18,0
& 261 1,55 9,0
7 310 1,58 9,7
[} 417 2,94 10,7
a 514 7.6 22.6 LI
Results | Pealk Table | Legend | Errors ‘
| [ [ | @Mr. Advanced as Advanced Operator [t Export [Auka Print

Peaks have automatically been detected, and their characteristics such as size,
concentration, purity, or molarity have been calculated and are shown in the Peak Table
at the bottom of the window.
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What You Can do When the Measurement is Finished

When the measurement is finished, you can:

Document your chip run by entering sample names, chip comments, and study
information, for example.

Evaluate the measurement results by analyzing gel-like images and electropherograms
(electrophoretic methods), or histograms and dot plots (flow cytometric methods):

— “Analyzing and Evaluating the Results of an Electrophoretic Method” on page 104
— “Analyzing and Evaluating the Results of a Flow Cytometric Method” on page 235

Print the results to document them on paper or an electronic format, such as HTML or
PDF.

See “Printing Reports” on page 324.

Export the results or parts of them for further evaluation in other applications.
See “Exporting Data” on page 312.

Compare the results with the results of other chip runs in the Comparison context. See
“Comparing Samples from Different Electrophoretic Chip Runs” on page 166.

Pass the results through the predefined workflow.
See “Workflow Control” on page 64

Insert the next chip in the bioanalyzer and start a new chip run.
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Looking at 2100 Expert

Before you start running methods on the Agilent 2100 bioanalyzer, you should familiarize
yourself with the 2100 expert software:

e “Introduction to the Key Features of the 2100 expert” on page 33
e “Starting 2100 Expert” on page 35

e “2100 Expert Work Area” on page 37

e “Closing 2100 Expert” on page 49

e “The Security Pack of 2100 expert” on page 50
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Introduction to the Key Features of the 2100 expert

The Agilent 2100 expert is characterized by the following key features:

* 2100 expert provides a single software platform with a common user interface for
running, analyzing, evaluating, presenting, and comparing DNA, RNA, protein and cell
parameters.

* 2100 expertis installed in one go. After installation, the functionality for electrophoretic
and flow cytometric methods can be activated separately with license keys.

» 2100 expert provides an optional security pack that needs to be ordered separately as
G2949CA and is then activated with a license key. This security pack activates user
management functions and electronic signature to meet the Food and Drug
Administation (FDA) requirements (21 CFR Part 11).

» 2100 expert provides detailed installation verification and system verification tests on
both the bioanalyzer hardware and software.

e 2100 expert allows having multiple chip data and/or method files open at the same
time.

« 2100 expert features a new integrated data evaluation tool (Comparison context)
allowing comparison of measurement results (of same method class) from different
chips directly. A separate data evaluation tool is no longer necessary.

« 2100 expert features improved integration including manual integration (available for
DNA and Protein methods only).

e 2100 expert allows color-coded result flagging with pre-defined or custom result
flagging rules. Flagging rules can be applied to measurement results.
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2100 expert now has customizable result tables and gel-like images.

2100 expert has improved instrument control. Two bioanalyzers can be controlled at
one time. It is possible to run measurements as well as diagnostics tests on two
bioanalyzers at the same time.

2100 expert has improved printing and reporting functions.

2100 expert has extended instrument diagnostics functionality.
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Starting 2100 Expert

To start 2100 expert:
1 Go to your desktop and double-click the following icon:

i
2100 ex;l%t

—0OR-

From the Windows Start menu, select Programs > Agilent 2100 Bioanalyzer > 2100
expert.

2 The accessto the 2100 expert and its functionality is controlled by the installed security
pack. You need to authenticate yourself with your user name and password.

2100 expetrt - Logon

Enter user name, password and seleck role thak is valid
For the 2100 expert user.

R
[ User name | I advaoper

Full name ; Mr. Advanced
Password : I |
Roles : I.ﬁ.dvanced Operakar j

K I Cancel | Cipkian :>:>|
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For more information on the user management of 2100 expert, see “The Security Pack
of 2100 expert” on page 50.
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2100 Expert Work Area

The 2100 expert software has standard elements such as pull-down menus and toolbars,
and the main working area, which contains several tabs, some of which have sub-tabs.
The 2100 expert work area has the following regions (demonstrated at the Data context):

Title Bar
Menu Bar

I

ta

Toolbar

Info Bar

e

Instrument

Context Bar

Gel...CR Mix 3a (Not Reviewed)

B Al Files

Tree View

Tabs

Method

Sub-tabs

%2100 expert - Ci4...ea'Data’,dsDNADNA 7500' Demo DNA 7500 Custom', 2100 expert_DNA 7500_00000_2005-05-19_14-01-50.xa
iContext  Wiew Gel Workflows Windows Help

TR HO & tEd Flud O00Q QO PER|E &8F|a-|=-

General Properties 1 Assay Properties 1 Chi

=18l

Analysis

Summary ] Gel | Electropherogram 1 Result Flagging I Log Bnnk]

Lower
Panel

Status Bar

B 2100 expert_Dha 7500 _00
~{E| all samples [bp] La.. P..|P..|5a..5a4.. 5k 5&.. 53, 53, 54, 54,0, 5a0, Sa. [bp] Lucal] Global I
oY ] - Collapse
|C] PR Mix 3a i £
= |g| Sample 3 Inkegration start time [5] 26
- |g| Sample 4 Integration end time [s] a4
E! Sample 5 Slope Threshold 05
- IQI Sample & Area threshold 0,5
-1 Sample 7 Height: threshold [FU] s
E! Sample & 10300 — s— e e e e e S e e | — 1 (J3E0) Peak filker width [s] 05
~{C]| Sample 9 000 — == — — — —_— — 7000
t=Sample-t0 3000 — —— sy — — — — 3000
2] 5ample 11 B-——" |m—|| == =— = |-1=w
-1 Sample 12 1000 — — ol — . — —_— —— - 1000
~{]| Ladder e ——— —— —_— =
700 — —— 1 T - ——— -—700
SO0 —_— I ——— -—5o0 |
300 — — — — — — —am
S+ — —_—————————— — 5 H
L 1 2 3 4 S ] 7 8 9 10 11 1z
Size [bp] | Conc, [ngful] | Molarity [nmalfl] | Cbservations | |;||
v 4 50 5,30 51,5 Lomer Marker - 1
2 74 8,80 179,7 NSQS BEEEo
3 113 1,92 25,7 Configure Columns. ..
4 165 0,95 8,7 % Copy Ta Clipboard Chr4C
5 215 2,56 18,0 4 I o
5 261 1,55 a0 1 Manually Set Lower Marker
- 310 1,98 a7 ’@ Manually Set Upper Marker
s s
B 417 2,94 10,7 7% Exclude Peak
B c1a 7 r 27 e T = DeFaults Help
Results | Peak Table | Errors —

Contents
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jito Export ‘Autn Print
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The 2100 expert software can be operated in six modes, called contexts™:
¢ Instrument Context

 Data Context

* Verification Context

e Comparison Context

* Method Context

» System Context

NOTE
The contexts work independent from each other regarding their data. This means, for
example, that you can review data and run measurements at the same time.
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Using the Contexts bar, the Context menu, or the selection list in the toolbar, you can
switch between the contexts:

Cantexks

)

Insktrument

Context | Wiew Gel W

@ Instrument

a Data % Diaka

Methad @ verification Instrument

—— 9 Campatisan

Werificakion

& Methad Comparison
Methiod
@ System System

NOTE
Menus, toolbars, the tree view, and the main working area (tabs) significantly change
when you switch between the contexts.

An introduction to the six contexts is given in the following.
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Instrument Context

On startup, 2100 expert enters the Instrument context, where you can run DNA, RNA,
protein or cell methods by selecting a method file and starting the chip run—provided
that the bioanalyzer is properly connected, a chip is inserted, and the bioanalyzer lid is
closed.

¥¥2100 expert _|&x]
; All Instruments
‘ Dema it 8 COM Port
w7 Instrument 2 ame: o IDEWU j'
5 Instrument 3 Serial#:
Method Selection: E Methods
Cartridge:
SkartySkop Run:
Wendor: 0 S
Product 1Dt Method: i:4...Dema DHA 7500 Custon,xsy
Firmware: Simulation Mode: Data File:
Assay Comments:
r~ Destination
Copyright @ 2003 Agilent Technologies
% f+ Default C:\...sDMA\DNA 7SO0\Demo DA 7500 Custom
¢ Custom Cri...sDHAYDNA 75001 Dems DA 7500 Custom |
File Prefix (2100 expert (max 16 characters)
Data Acuisition Parameters —Start Run Checklist
Run sample |—1 to 13 = of Is the instrument ready?
=l o Is a chip detected?
o Is selected instrument valid For this assay?
of Does the cartridge and the selected assay match?
o Are all required licenses applied?
of Is current instrument valid For the selected method?
of Does the user have rights to start a run?
Chip Setup
\ \OFFIme (Dema Made) |sMr. Advanced as Advanced Operator Auto Export | Auto Print
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NOTE
If two bioanalyzers are connected to your PC, you can run both in parallel.

During the chip run(s), you can view the status of the bioanalyzer(s): instrument
information and real time acquisition data.

In the /nstrument context, it is also possible to run hardware diagnostic tests on all
connected bioanalyzers. Refer to “Running Instrument Diagnostics” on page 369 for
detalls.
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Data Context

In the Data context, you can

* view, analyze, and evaluate the results of your chip runs that are presented as
electropherograms, gel-like images, histograms, dot plots, and result tables.

 export and print the results of your chip runs.

42100 enpert - C\....ea'Data’,dsDNAYDNA 75004, Demo DNA 7500 Custom', 2100 expert_DNA 7500_00000_2005-05-19_14-01-59:3ad 1= x|

File Context Wiew Electropherogram Workflows Windows  Help
Loz EE cE Bue 00000 OE|~EB| - -RES EwP|
Ele...CR Mix 3a {Not Reviewed) Analysis
e ¢ iles General Properties I Assay Properties I Chip Surmary 1 izel 1 Electropheragram | Result Flagging ] Log Eook}
"“ =+ 2100 expert_Diua 7S500_00
[ All samples [FU] PR Mix 33
IOl Per mie 1 =004

- |

Instrument

@ Sample 3
O sample 4
(] sample 5 4004
@ Sample &
O] sample 7
(] sample 8
@ Sample 3 200
O] sample 10
(] sample 11
@ Sample 12
O Ladder 2004

100+

o
A
T T T T T TT T T T T
50 300 500 700 1000 2000 10380 [bp]
Size [bp] | Conc. [ngjpl] | Molarity [nmolfl] | Observations -
1|4 50 8,30 251,5 |Lower Marker
2 74 3,50 179,7
3 113 1,92 25,7
4 165 0,95 8,7
5 215 2,56 18,0
[} 261 1,55 9,0
7 310 1,98 9,7
8 417 2,04 10,7
a 514 7. 22.6 LI
Results | Peak Table | Legend | Errats ‘
‘ \ |sMr. Advanced as Advanced Operator Auto Expart |Auto Print

The measurement data is stored in .xad files.
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Verification Context

The Verification context is used to run and document qualification tests.

4% 2100 enpert lent',2100 bioanalyzer', 2100 experthSecuredArea’¥alidati Yerification_19-05-2005_14-32-09.xvd = x|

Fle Context Wiew Windows Help

verfication = | ] (% = & B Qaart

005_14-32-09.xvd

- ications Configuration Results} LogBookl
F ification_19-05-2005_14-32-09, xw
Installation Yerification Available Tests:
Instrument
System Yerification
{itii] X Software Apphy Mame Description Executions Status select Al
=9 PC_MM_SK []  |ACE Eukaryote mRMA pico |Analysis Calc... 1| o Executed, passed
D Files and Environment [1 |ACE Eukaryote mRNA ... Aanakysis Calc... 1| of Executed, passed Unselect All
-3 Electrophoresis DA []  |ACE Prokaryote mRNA p... lnalysis Calc.., 1| of Executed, passed
~of ACE DNA 500 []  |ACE Prokaryote mRMA n... Analysis Calc... 1| o Executed, passed
X ACE DNA 1000 [1 |ACE Eukaryote total RM... @nakysis Calc... 1 XExecutedJ Failed
4 ACE DNA 7500 [] |ACE Eukaryate total RM... |Analysis Cale... 2% Executed, all executions Failed
Ly -of ACE DA _12000 ] |ACE Prokaryote total R... |Analysis Calc... 1| o Executed, passed
B-3X Electraphoresis RIA b| [ |ACE Prokaryote totalR... |Anabysis Cale... 1| of Executed, passed
q - ACE Eukaryate mR|
- of ACE Eukaryote mR
’\", o ACE Prokaryotem  Test Properties
- o ACE Prokaryote mi ;I
Metho -9 MCE Eukaryate ot
x ACE Eukaryots tot MHame: ACE Prokaryote total RNA nano
- v ACE Prokaryote tal Description: Analys\_s iZalculation Engine Test — eleckrophoresis Prokaryote botal RNA nano, Test checking features of analyses
- of ACE Prokaryote to used with the Prokaryote total RNA nano assay.
= D Electropharesis Proteiny Approximate Time: 305
[ D FlowCytometry Assay
= Hardware
Ly
I-]
4 3
| verification Run Complete. | @ mMr. advanced as Advanced Operator [ ko Export [Auta Print

For both the bioanalyzer hardware and software tests can be run for:
¢ Installation verification

* System verification
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Verification results are automatically saved in .xvd files. You can re-open .xvd files to
review verification results.

For details, refer to “Performing Verifications” on page 378.
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Comparison Context

In the Comparison context, you can open multiple electrophoretic chip data files and
compare samples of the same assay class (DNA 1000, for example). It is possible to
overlay electropherograms recorded by the bioanalyzer and compare the results.

42100 expert - C:\..ent’, 2100 bioanalyzer, 2100 expert'SecuredAreaiComparison’,2005-05-19% ComparisonFilel DNA7500.5ac i - | = ﬂ

Eile Context Wew Electropherogram ‘“Windows Help
Comparison " RAEHO&S lE‘ a8 00 @] 2B ﬁ' @ JBE - overaid Samples

Electropherogram - PCR Mix 3a
¢ @ Al Comparison Files

Comparison Summaryy 1 Gel 1 Electropherogram | Comparison Log Bnnkl

[FU] PCR Mix 3a

1000+

004

——
|

< | »
b Select Data Files T T T T T T T

I‘ 2005-05-19_14-01-59.xad & 40 =0 &0 70 en 90 [5] .

PCR Mix 1
PCR Mix 33 Yiewport 2

Sample 3 # PCR Mix 3a

Sample 4 *
Sample 5 PCR Mix 1

Sample &

Sample 7 [%
Sample &
Sample 9
Sample 10
Sample 11
Sample 12
Ladder

Legend | Errats

[ | §Mr. Advanced as Advanced Operator [t Export [Auka Print

Comparison results can be saved in .xac files. You can re-open .xac files to review the
comparison results and to add further samples for comparison.
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Method Context

In the Method context, you can create your own methods based on Agilent templates by
modifying certain data (for example, data analysis setpoints). Within a method, you also
define general settings, which include the instrument(s) to be used, the relevant study,
the workflow to be followed, and the reporting elements.

Y% 2100 enpert - 2100 bioanalyzer, 2100 enpert’SecuredArea’Method'Demo Templates',dsDNA"Demo DNA 7500 Custom.xs! - | = ﬂ

Eile Context Wiew Assay Properties Windows Help
Method Rpdes|ENEcE B

.

¢

Released for Use

esult Flagging I Log Books

General Properties Chip Summary

Demo DNA 7500 Custam.xs|

o r [ il Samples Assay File :  Dema DMA 7500.xsy ] 1 Global l
nstrument
- :::;: ;  Title : Dema DMA 7500 l—_INormal = i
Larcation : Ch...aiMethod|Dema Templates)dsDMa
Sample 3 Ul \ P U -| : General assay setpoints
Sample 4 Assay Class 1 DMNA 7500 _=| - Electrophoresis properties
Sample 5 i
D‘ ———t. Vel o 13 Ladder Concentration 4
Sample 6 S, Ladder standard areas  Table ...
Samp:e 7 y Modified : Mai 19, 2005 13:41:40 (Concentration unit naful
Sarmple 8 =] -
- -| : Sample setpoints
g::D:: ?U ‘ _=| : Integrator
Samp\e I Commenhts i q N Integration start time [s] 26
Sam;e 2 Copyright @ 2003 Agilent Technologies Integration end time [s] 94
Ladder Slope Threshold 0,5
Area threshald 0,5
Height threshald [FU] 8
Peak filker width [s] 0,5

General Analysis Settings

Nurnber of svailable sample and ladder wells {max.) @ 13
Minimum wisible range [s] : 25

Maximum visible range [s] : 95

Stark analysis time range [s] @ 26 %
End analysis time range [s] : 94

Ladder Concentration [ngful] : 4

Uses standard area faor ladder fragments

Lower Marker Concentration [ng/ul] @ 8,3

Uppet Matker Concentration [ng/ul] @ 4,2

Used upper marker For quantitation

Standard curve Fit is Point to Point

r Show data aligned to lower and upper marker
Ea E

[ 7+ o] -
E Integrator Settings

Labchip Analysis | Ladder
Import Setpoints. .. Defaulks Help |

| [ | @ Mr. Advanced as Advanced Operator [t Export [Auka Print

Methods are stored as .xsy files.
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System Context
In the System context, you can

« define System Wide Settings for the 2100 expert software such as settings for default
file names and directories, signal colors, or auto export functions

* view the contents of the System Log Book

 add or delete users and assign the required roles to the users (available to 2100
administrators only)

* make use of the import/export and archiving functions (available to 2100
administrators and backup operators only)
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LY

File Context Miew Windows Help
System -|H@\ [ I
Released for Use

"" Users and Roles 1 System Wide Settings | Archiving I Impart - Export 1 System Log Eook}
2100 Expert System Wide Settings —
— —— Data File Name
=i --Data Files
Run and Result Create Data file names by combining
Ao Export . . [V Prefix 2100 expert
~Default Export Directories
¥ | Assay Class
?’f [ Serial Mumber
¥ | Date
n
= Timz Example
€ Counter 2100 expert_ASSAYCLASS SRMUM_2005-05-19_13-38-28
——— Data File Directary
5
N % Default Directary { :\ProgrammelAgilent}2100 bioanalyzer\2100 expertiData )
e Browse .. Reset
M

~—— DataFile Format

= Binary Format
% &Pl Formeat

]

| & Mr. Admin as 2100 Administratar futo Expart [ Auto Print
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Closing 2100 Expert

To close the 2100 expert software:
1 From the File menu, select Exit.
If a chip run is in progress, the following message appears:

2100 expert x|

\lj) Run is being performed in the Instrument Context, Cannaok kerminate application,

Click OK and wait until the chip run is complete.

NOTE
This dialog box may also appear if you try to switch between contexts while there is

unsaved data.

2 If the currently open file has not yet been saved, 2100 expert asks for your electronic
signature in order to save the file.

TIP
When opening a saved data file later, you can always load earlier versions of the file if
required.

After you have confirmed the messages, 2100 expert quits.
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The Security Pack of 2100 expert

The 2100 expert software with the security pack license provides functionality for

¢ Access Control

Data Integrity

Handling of Electronic Signatures
Workflow Control

With access control functionality, only authenticated and authorized users can access
and modify data, i.e. any electronic record created or managed by 2100 expert security
pack. It is part of the concept to guarantee the security and integrity of all analytical data
created with the Agilent 2100 bioanalyzer instrument and managed by the 2100 expert
software on a validated PC system. This data security protects all raw data, methods, and
results from unauthorized access. Together with the functionality provided for handling of
electronic signatures and workflow managment, the security pack renders the Agilent
2100 expert application compliant to the regulations and guidelines of the Food and Drug
Administration (FDA) for electronic records and electronic signature, 21 CFR Part 11.

With the workflow management functions, only dedicated users can perform
measurements and create result data. This data must then be reviewed in a way that is
configurable, but always requires a 4-eyes principle in order to approve results. The
review levels are configurable regarding to who will be allowed to perform them, but also
regarding to how many levels of reviews have to be accomplished for a certain method.
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Access Control

The 2100 expert provides configurable access control and user management
functionality to ensure that only authorized users can access the software and the
measurement data:

 User control (login, access to functionality and data)

Each user must log on to the 2100 expert system by entering his/her user name and
password. Access to data as well as to functions is only permitted to authenticated and
authorized users according to their user roles. Each user is identified and checked for
his or her function at all times.

Some program settings (configuration) are specially protected and can only be edited
by the 2100 administrators.

 Application lock

If the 2100 expert workplace is not used within a specified amount of time, the screen
is automatically locked. In such cases, only authorized users can unlock the computer.
Furthermore, it can be configured, whether all 2100 expert users are able to do the
subsequent unlock, or this is reserved for the user who caused the lock.

¢ Windows user accounts

2100 expert deploys and integrates windows operating system technology for the
configuration of user and password management. Thus, options of configuration are
versatile and also pre-existing configurations can be easily applied to 2100 expert.
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User Role Model

The 2100 expert user role model ensures that every user is allowed to access only those
functions he/she is authorized to use (functional security).

User Account

The 2100 administrator takes care of the 2100 expert user accounts. To work with the
2100 expert software, you have to log on first (password protected).

Roles and Access Rights

Depending on your tasks, you are assigned to one or several user roles, for example,
administrator, operator, or advanced operator. Rights that are associated with your roles
provide access to specific functions of the 2100 expert software.

By default, the following roles are used within the 2100 expert software:

e 2100 Administrator

Is responsible for user accounts and roles. Additionally, can perform data export and
archiving and can open methods and data files. The 2100 administrator also has rights
to access the secured area with the Windows explorer for backup and archiving
purposes.

e Backup Operator

Is responsible for batchwise export and import, archiving and dearchiving, and backup
possibilities with external tools. The backup operator also has rights to access the
secured area with the Windows explorer for backup and archiving purposes.
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» Standard Operator

Can create and run methods and analyze the data, cannot change advanced setpoints
nor perform manual integration.

e Advanced Operator

Can create and run methods and analyze the data, including changing the advanced
setpoints and performing manual integration. Can additionally validate instruments.

* Verification Operator

Is responsible for validating the Agilent 2100 bioanalyzer instruments and software,
usually an Agilent service engineer.

* 2100 Unlock Operator

Is needed in case of a private lock applied or if another user needs access and the user
corresponding to the private lock unexpectedly is not available.

e 2100 Guest
Merely has got read-only access to methods and data, but no operating functionality.
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More specifically, the users with the different roles have access to the following

functions:
. & £
s . 5 £ ® &
E & ® 8 3 2
2 & 8 2 & ©
E 8 & © = 3§ =
y E 2= % § £ ¢
x : < 5 & 28 8§ S5 o
£ Function o = = 8 £ o o
S S & & £ 5 2 g
o o m (72} <C > o N
= User management X
£ Archive/de-archive data X X
>
“ Import/export multiple files X X
«= Verify system and X X
<2 instruments
Open method files X X X X
- Create and modify methods X X
§ (except advanced setpoints
§ and result flagging rules)
Modify advanced setpoints X
and result flagging rules
£ Run methods on instruments X X
o=
Contents Ab4V

Index



i . 5 §
g 5 € 8 £ &
E .S E — g o
® & 8 2 o ©
E &8 & © = 3§ =
= =) - ° 2 1= HH
X . f 5 &8 g8 8§ S5 &
& Function e =X B &8 ¥ o o
[ P— (£) © > —- P— P—
= — o o = 1) — —
o o~ m (72} <t > o (2
Open data files X X X X
Analyze measurement data X X
s (except advanced setpoints
A& and manual integration)
Modify advanced setpoints X
and use manual integration
© Read log books X X X X X X X
c
& Change password X X X X X X

In most cases 2100 expert displays all data for reviewing independent of the user role.
However, only that functionality is available that is associated with the specific role. Note
that a user may have more than one role.

If you have several roles and need to perform a task associated with a role other than
your current role, you have to log out and log back in with the other role.
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Data Integrity
2100 expert provides functionality to ensure the integrity of all data:

* Data protection

The measurement data is stored in the restricted area of the file system. It cannot be
accessed with the Windows Explorer by ordinary means. This means that viewing files
and data with the Windows operating system explorer is restricted.

* Audit trails and log books

User actions in the 2100 expert software are logged in so-called audit trails and
signature logs. These are records of access-controlled actions and cannot be manually
modified. They are subject to data protection and are saved within the data files or with
the 2100 expert system file.

The audit trails and signature logs capture the following actions:
— Service access and all administration activities

— Changes to access rights of users

— Modifications to measurement data

— The logins and logouts of users, as well as failed attempts to log in and opening and
closing of sessions

» Additional concepts are provided for
— Version control to identify original files and to control versioning of file copies
— Archiving funcionality and data access for backup purposes for particular users

— Disaster recovery
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Handling of Electronic Signatures

All activities such as creating or modifying data must be confirmed by the user with his or
her electronic signature to proof their authentication.

To ensure data security, no user can sign two consecutive steps in the workflow. If, for
example, one user executes a measurement, another user has to review and approve the
results.

The different levels of the review workflow are completed by signing them. Once a user
has performed a step (for example, reviewed the results), he/she has to sign it. The data
is then released for the next workflow level. Then the next user is responsible for the
method and the previous user can no longer reject the step. He/she would have to inform
the next user to reject the results.

The complete sequence of steps is documented in the audit trail and the signature log,
even if the desired result was not achieved.
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How to Sign your Work Steps

You have performed an action that requires to be signed with your electronic signature
such as creating or modifying data.
To sign your work within 2100 expert:

1 If you choose to save the current data or if you try to switch to another file or context,
2100 expert asks for your signature:

Electronic Signature

List of changes:

| |Descripti0n | Timestamp|Time Zone |Setp0int|Dperat

b | +| Assigned user to workfow level

Meaning: alkered Analysis Set Poinks

Comment:

—Signature

LUser: M. Advanced as Advanced Operator

User I I

Password: |

Domairn: IPC_MM_SK j

OF I Cancel Help
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2 Atthe top of this dialog, you see the list of changes. Click the plus symbol to expand the
sections of the list.

Electronic Signature

List of changes:

Description

| Timestamp|Time Zone |Setp0int|Dperation

[01d value[t

=| Assigned user to workflow level

%ssigned uzer to workflow level Apr-29-2005 11:10:27 [GMT +02:00) UserlD
Aszzigned user to workflow level Apr-23-2008 1110027 [GMT +02:00] Users
Aszzigned user to workflow level Apr-23-2005 1110027 [GMT +02:00] UselD
Aszzigned user to workflow level Apr-23-2008 1110027 [GMT +02:00] Users
Aszzigned user to workflow level Apr-23-20058 1110016 [GMT +02:00] UselD
Aszzigned user to workflow level Apr-23-20058 1110016 [GMT +02:00] Users

Modified
Item added in collection
Modified
Item added in collection
Modified
Item added in collection

3 The Meaning field is used to state the main purpose of your modifications. In some
cases, however, the meaning is unequivocal and you don’t need to select it here. This
is, for example, when starting a chip run. Then the meaning is aleady preselected and
cannot be changed.

Meaning:

Comment:

Altered Analysis Set Points

Changed Result Flagging
Started Chip Run
Aborted Chip Run
Archived Files

Restored Files

Started Verification Run

|Abarted verification Run

L bl

4 Use the Comment field to specify your intention in more detail.

5 In the Signature section you need to enter your User ID (login name) and your
Password. Furthermore, the displayed Domain name must be correct. This is either the
local PC name or the network domain, depending where your User ID is defined.
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6 Click OK to finish the electronic signature.

How to Approve/Reject the Current Workflow Level

With every method, an appropriate workflow must be defined in order to release it for

use. This means that one or several users must be explicitly specified to approve the

work of each workflow level. When executing a method, these users can then approve

the measured results and move the method to the next workflow level.

To approve the current workflow level:

1 As the analyst who was running the method, you need to check the measured results
of all samples. For this purpose, switch to the Data context and review the results.

2 Then switch to the Chip Summary tab to access the sample table.
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3 Inthe Approved column of the sample table, specify for each sample whether the
results can be approved or must be rejected.

el Result Colar Approved
o fpproved
o fpproved
o fpproved
o Spproved
A Mok Rev,
i, Mok Reviewed

3 Rejected

B Mot Reviewed
By Mot Feviewed
By Mot FReviewsd
By Mot Reviewed

4 Only if all samples are approved, you can select Approve current workflow from the
Workflow menu.

Workflows | Windows Help
@ Approve current workFlow [:

@ Reject current workflow
W, Revoke Finalization

5 Confirm your changes to the state of the samples with your electronic signature.
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6 Additionally, confirm the workflow level approvement with your workflow signature.

List of zamples:

Sample Mame Skatus Changed -
1 |Sample 1 Approved []
z |Sample 2 Approved []
3 |Sample 3 Approved []
4 |Sample 4 Approved []
5 |Sample 5 Approved []
& [Sample & Approved []
7 |Sample 7 Approved []
g |Sample Approved []
9 |Sample 2 Approved []
10 |Sample 10 Approved [] LI

Function:  Analysis

Meaning:  Finalize current workflow level and proceed to next workflow level

Caomment:
All zamples OF.
—Signature
LUser: M. Advanced as Advanced Operator
User I Jadvaoper
Password: |********
Domairn: IPC_MM_SK j %

OF I Cancel | Help |

The method is moved to the next workflow level (review).

Only the users that are specified in the method for this level are authorized to do the
review. The number of required review levels is also specified in the method.

If you are reviewing the method in a later workflow level and the results are not as
required, you can also reject the method by selecting Reject current workflow from the
Workflow menu. The method must then be taken care of the users of the previous level
again.
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If you are assigned to two subsequent workflow levels, you cannot approve both levels.
When trying to approve the second subsequent level, the following message appears:

2100 expert x|

Q The current user already finalized the previous workflow level!

The user doing the final review finalizes the method by approving the final workflow level.
However, he/she has the option to revoke this finalization in case errors are observed
afterwards. This can also be done from the Workflow menu.
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Workflow Control

All measurements follow a determined workflow. This workflow includes steps such as
the execution of methods, peer reviews, and the final approval. The workflow also
defines that only pre-defined users in certain roles can take these actions and that any
other user is restricted from doing so. Every action in the workflow must be signed by the
user with an electronic signature, before it can be passed on to the next
review/workflow level. The workflow management in praticular provides means of
reproduceability and traceabiltiy for the measurements, thus providing data and result
reliability.

For every measurement done with the Agilent 2100 bioanalyzer, the following workflow
must be followed:
1. Method setup

Methods are created from method templates and can be modified as required for a
particular measurement, typically done by an advanced operator.

2. Method execution

The available methods are used to run measurements. This includes the following
steps:

— Preparing the required samples, reagents, chip and the instrument
— Entering the required administrative information in the method

— Executing the method
The methods are typically executed by a standard operator.
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3. Analyst review(s)

Every measurement must be evaluated by one of the analyst reviewers. The reviewer
decides whether the measurement gets approved (moved to the next workflow level) or
rejected (moved one workflow level back).

4. One or more peer reviews and approval (depending on your system configuration)
Some labs require the approval of several reviewers. The number of required reviews
can be specified in the method.

5. Final review
With the evaluation of the final reviewer, the measurement is finished, in case the
evaluation results in an approval.

6. Exception route

Revoke of the final approval brings back the file into the state, where one of the final
reviewers can modify the file and do a changed approval in case of a sample or a
setpoint had been accidentally set in a wrong manner and needs to be adjusted before
the final state of the document.

This workflow is valid for all methods and measurements and can only be operated in this
exact order.
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Running and Evaluating Electrophoretic Assays

For running and evaluating electrophoretic assays you need to know the following:

e “Principles of Nucleic Acid and Protein Analysis on a Chip” on page 67

e “Preparing and Running an Electrophoretic Assay” on page 71

e “Analyzing and Evaluating the Results of an Electrophoretic Method” on page 104
* “Result Flagging” on page 175
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Principles of Nucleic Acid and Protein Analysis on a Chip

The electrophoretic assays are based on traditional gel electrophoresis principles that
have been transferred to a chip format. The chip format dramatically reduces separation
time as well as sample and reagent consumption. The system provides automated sizing
and quantitation information in a digital format. On-chip gel electrophoresis is performed
for the analysis of DNA, RNA and proteins.

The chip accommodates sample wells, gel wells and a well for an external standard
(ladder). Micro-channels are fabricated in glass to create interconnected networks
among these wells. During chip preparation, the micro-channels are filled with a sieving
polymer and fluorescence dye. Once the wells and channels are filled, the chip becomes
an integrated electrical circuit. The 16-pin electrodes of the cartridge are arranged so that
they fit into the wells of the chip. Each electrode is connected to an independent power
supply that provides maximum control and flexibility. Charged biomolecules like DNA,
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RNA, or protein/LDS micells are electrophoretically driven by a voltage gradient—similar
to slab gel electrophoresis. Because of a constant mass-to-charge ratio and the presence
of a sieving polymer matrix, the molecules are separated by size. Smaller fragments are
migrating faster than larger ones. Dye molecules intercalate into DNA or RNA strands or
protein/LDS micells. These complexes are detected by laser-induced fluorescence. Data
is translated into gel-like images (bands) and electropherograms (peaks). With the help
of a ladder that contains components of known sizes, a standard curve of migration time
versus fragments size is plotted. From the migration times measured for each fragment in
the sample, the size is calculated. Two markers (for RNA only one marker) are run with
each of the samples bracketing the overall sizing range. The “lower” and “upper”
markers are internal standards used to align the ladder data with data from the sample
wells. This is necessary to compensate for drift effects that may occur during the course
of a chip run.

For DNA and protein assays, quantitation is done with the help of the upper marker. The
area under the upper marker peak is compared with the sample peak areas. Because the
concentration of the upper marker is known, the concentration for each sample can be
calculated. Besides this relative quantitation, an absolute quantitation is available for
protein assays, using external standard proteins.

For RNA assays, quantitation is done with the help of the ladder area. The area under the
ladder is compared with the sum of the sample peak areas. The area under the “lower”
marker is not taken into consideration. For total RNA assays, the ribosomal ratio is
determined, giving an indication on the integrity of the RNA sample. Additionally, the
RNA integrity number (RIN) can be utilized to estimate the integrity of total RNA samples
based on the entire electrophoretic trace of the RNA sample, including the presence or
absence of degradation products.
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The 2100 expert software plots fluorescence intensity versus size/migration time and
produces an electropherogram for each sample:
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The data can also be displayed as a densitometry plot, creating a gel-like image:
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Preparing and Running an Electrophoretic Assay

NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

NOTE

Please note that in terms of the 2100 expert software, a method resembles an
extended assay, which also includes additional administrative data such as operator,
instrument, reporting, and workflow settings.

An electrophoretic chip run requires the following steps:

1.

Switch on the Agilent 2100 bioanalyzer and start the 2100 expert software.
See “Starting 2100 Expert” on page 35.

. Select an electrophoretic method.

See “Selecting an Electrophoretic Method for a Chip Run” on page 73.

. Prepare reagents, chip, and samples.

See “Preparing Samples, Reagents, and Chips for Electrophoretic Methods” on page 76
and the appropriate Application Note or Reagent Kit Guide.

. Load the chip into the bioanalyzer.

See “Loading the Electrophoresis Chip into the Bioanalyzer” on page 80.
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5. Start the chip run.
See “Running an Electrophoretic Method” on page 86.
When the chip run has finished, you can:

* Have a first look at the results (see “Displaying the Measurement Results
(Electrophoresis)” on page 95).

* Document the chip run (see “Entering Chip and Sample Information” on page 92).

* Analyze and evaluate the results:

— See “Analyzing and Evaluating the Results of an Electrophoretic Method” on
page 104.

— See “Result Flagging” on page 175.
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Selecting an Electrophoretic Method for a Chip Run

NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

To select a method:
1 Switch to the Instrument context.

2 Inthe Tree View Panel, select the bioanalyzer you want to use.

& All Instruments
.............. g}l Instrument 1

______________ * miEm

In the upper left of the Instrument tab, an icon shows the status of the bioanalyzer. You
should see one of the following icons (lid open/closed), indicating that the bioanalyzer
is detected by the system:
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3 If you do not see one of these icons, check that the bioanalyzer is switched on and
properly connected:

— Check the COM port setting.

— Make sure the bioanalyzer is physically connected to the PC (over the serial
interface).

— Check the power connection.

— Check the power switch.

If you need additional help, please refer to the Agilent 2100 Bioanalyzer Maintenance
and Troubleshooting Guide.

4 Select a method for the chip run.
On the Instrument tab, click the Method button.

—0OR=-

Click the Methods menu.

Both will open the Methods menu, allowing you to select a method from the submenus.
—0OR-

Select File > Open File to Run. This opens a dialog box, allowing you to load either a
method (.xsy) or a chip data file (.xad).

The type of method you have to select depends on the required measurement and the
Reagent Kit you use to prepare your samples. Details on these methods are described
in the Application Notes available for each method and in the Reagent Kit Guide.
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5 Select the desired method, DNA 71000, for example.
The method is loaded and its name appears on the Information Bar:

DE11700058 - DNA 1000

NOTE

After a chip run, the results can be evaluated using parameters from a different
electrophoretic chip data file (.xad) of the same method type (DNA 1000 in this
example). Refer to “Importing Data Analysis Setpoints” on page 308.

NOTE

The chip data file (.xad) that will be generated as the result of the chip run will be stored
to the indicated Destination folder in the Secured Area.

6 Specify an appropriate File Prefix for this file.

— Destination

% Default Ci\...\DataldsDMANDNA 7S000ema DA 7SO0

 Custom CH..\DataldsDMAIDMA FS000ema DG 7500 |

File Prefix |21|:||:| Experk

fmax 25 characters)

= Daka scquisition Pararmeters

Runsample |71 to [12 j
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Preparing Samples, Reagents, and Chips for Electrophoretic Methods

Before you can load a chip, you have to prepare the samples and reagents. To find out
how to prepare the samples and reagents, refer to the various Reagent Kit Guides
available for each LabChip kit. Please refer to these documents for further information
and analytical specifications.

In general, preparing an electrophoretic method involves the following steps:

* Check that you have everything that is listed in the appropriate Reagent Kit Guide.

Be aware that there can be small but important differences between the different
methods even for the same type of molecules (for example, between DNA 1000 and
DNA 7500 methods).

* Make sure you are familiar with the essential measurement practices (see next page).
« Before running the first RNA method: decontaminate the electrodes.

 Prepare all the reagent mixtures (for example, the gel-dye mix).

* Load the gel-dye mix using the priming station.

* Load the DNA/RNA marker solution and buffer.

* Load the destaining solution for protein methods.

* Load the chip with ladder and samples.
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Essential Measurement Practices (Electrophoretic Methods)

General:

WARNING
Wear hand and eye protection and follow good laboratory practices when preparing
and handling reagents and samples.

WARNING

No data is available addressing the mutagenicity or toxicity of the dye/DMSO0
reagent. Because the dye binds to nucleic acids, it should be treated as a potential
mutagen and used with appropriate care. The DMSO mixtures should be handled
with particular caution as DMSO0 is known to facilitate the entry of organic
molecules into tissues. We strongly recommend using double gloves when handling
DMSO mixtures.

* Handle and store all reagents according to the instructions given in the Reagent Kit
Guides.

* Avoid sources of dust or other contaminants. Foreign matter in reagents and samples
or in the wells of the chip will interfere with method results.

* Always insert the pipette tip to the bottom of the well when dispensing the liquid.
Placing the pipette at the edge of the well may lead to poor results due to the formation
of a bubble on the bottom of the well.
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* Protect dye and gel-dye mix from light. Remove light covers only when pipetting. Dye
decomposes when exposed to light.

* Use a new syringe and electrode cleaner with each new LabChip kit.

* Do not touch the Agilent 2100 bioanalyzer during a chip run and never place it on a
vibrating ground.

* Keep all reagents and reagent mixes refrigerated at 4 °C when not in use.

 Allow all reagents and samples to equilibrate to room temperature for 30 minutes
before use.

 Use loaded chips within b minutes. Reagents might evaporate, leading to poor results.

RNA Methods:

* Always wear gloves when handling RNA, and use RNase-free tips, microfuge tubes and
water.

 Itis recommended to denature all RNA samples and RNA ladder by heat before use
(70 °C, 2 minutes).

* Always vortex the dye concentrate for 10 seconds before preparing the gel-dye mix.
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Protein Methods:

 Store Protein sample buffer at -20 °C upon arrival. Keep the vial in use at 4 °C to avoid
freeze-thaw cycles.

» Allow the dye concentrate to equilibrate to room temperature for 20 minutes before
use, to make sure the DMSO is completely thawed. Protect the dye from light during
that time. Vortex before use.

 Allow all other reagents to equilibrate to room temperature for 10 minutes before use.

e Use 0.5 ml tubes to denature samples. Using larger tubes may lead to poor results,
caused by evaporation.
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Loading the Electrophoresis Chip into the Bioanalyzer

The Agilent 2100 bioanalyzer uses different cartridges for electrophoretic and flow
cytometric methods. For electrophoretic measurements, the electrode cartridge is
required.

The electrode cartridge contains 16 electrodes that fit into the wells of DNA, RNA, and
Protein chips. Each electrode in the cartridge has an individual power supply. All
electrophoretic methods (DNA, RNA, and Protein) require an electrode cartridge. The
electrode cartridges will either have an engraved “1” at the front, or will have no
engraving at all. Cartridges with a different number are not electrode cartridges.
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If the bioanalyzer is set up for flow cytometric methods, but you want to run
electrophoretic methods, proceed as follows:

1 Open the lid and pull down the metal locking lever into the open position as shown in
the figure below.

Metal lever
in open
position

The cartridge is pushed out.
2 Gently pull the cartridge out of the lid.

NOTE
Store the pressure cartridge in the provided box.
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3 Slide the electrode cartridge into the lid as shown below.

Push here to ensure
tight connection

Metal lever

Do not touch the electrodes while the cartridge is in the Agilent 2100 bioanalyzer. The
electrodes and the high voltage power supplies can be damaged.

4 Push the metal front of the cartridge to ensure a tight connection.

5 Push the metal locking lever into the flat (closed) position.
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To load the prepared chip into the Agilent 2100 bioanalyzer:
1 Open the lid and remove any chip.

2 Adjust the chip selector to position “1” as shown in the following figure.

To avoid using
incompatible chips and
cartridges, a chip selector
is installed in the
bioanalyzer. This ensures
that the chip matches to
the installed cartridge.

. I
Move chip |
selector in

These steps are required for inserting DNA, RNA, and Protein chips in the bioanalyzer.
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Do not force the chip selector handle when a chip is inserted in the bioanalyzer.

3 Place the prepared chip into the receptacle.
The chip fits only one way. Do not force it into place.

Chip

Chip selector
in position “1”

4 Carefully close the lid.

Do not force the lid closed. This may damage the cartridge. If the lid does not close
completely, check that the cartridge and chip are inserted properly, and the chip
selector is in the correct position.
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When the chip is detected, the image on the /nstrument tab changes to a chip.

—
= 8
- S ¢

DMA LabChip

sicing / Analyiis

If the chip is not detected, open and close the lid again.

w
.
m
=
|
=
B
=
=@
=

NOTE

The displayed image depends on the assay selcted in the software, not the type of chip
inserted. If you would like to run a DNA chip but a protein chip appears, you have
selected the wrong method.

NOTE
If the AutoRun option is active, the chip run starts automatically once a chip has been
detected and the lid has been closed.
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Running an Electrophoretic Method

NOTE
You can stop a chip run at any time, for example, if errors occurred or if you are not

satisfied with the quality of the measurement results that you can observe during the
chip run. See “Stopping a Chip Run” on page 90.

NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

Starting the Chip Run

When you have loaded the chip, you can start the chip run:

1 On the Instrument tab, click the Start button.

() start
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2 To start the chip run, you need to confirm this action with your electronic signature,
which will be recorded in the audit trail.

Electronic Signature

List of changes:

Meaning: Started Chip Run j

Comment:

Dema DNA 7500

—Signature

LUser: M. Advanced as Advanced Operator

User v Jadvaoper

Password: |********

Domairn: IPC_MM_SK j

OF I Cancel | Help |

The chip run starts. The Raw Signals sub-tab shows an electropherogram of the currently
measured sample. The name of the sample is displayed above the graph. The graphis a
“live” plot of the migration time against fluorescence units (raw data, including
background fluorescence, for example).
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The number of the sample that is currently being measured is indicated on the

information bar:

€ Eunning

The status bar at the bottom of the screen shows the measurement progress for the chip

run and the COM port number used for data acquisition.
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During the chip run, you can do the following:

* View the chip data file in the Data context by clicking on the name of the Data File:

COM Pork IDeml:u vI

Method Selection: E Methods

Skart)Stop Run: @ Stop
Methiod: .. .Demo DS 7500 Cuskam, xsy
Drata File: .., Z005-05-19 14-01-59,xad

« Switch to any other context. For example, you can evaluate any chip data file in the Data
context, or compare samples in the Comparison context.

* If necessary, abort the chip run by clicking on the Stop button. You need to confirm this
action with your electronic signature.

All data that was collected up to the stop point will be saved.
After the chip run is completed, you can:

« Switch to the Data context, where you can view, analyze, and evaluate the results of
your chip run (see “Displaying the Measurement Results (Electrophoresis)” on page 95
and “Analyzing and Evaluating the Results of an Electrophoretic Method” on page 104).

 Stay in the Instrument context and start a new method, for example.
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Stopping a Chip Run
You can stop a chip run at any time, for example,
« if the quality of the measurement results does not meet your expectations,

« if, for example, after three samples you already have the information you desired and
you want to start another chip run.

NOTE
You cannot resume a stopped chip run.

NOTE
If you stop a chip run, automatic export (see “Exporting Chip Run Data Automatically”
on page 317) does not take place.

To stop the method:
1 Click the Stop button

@ Stop

—0R-

Select Stop from the Instrument menu.

NOTE
Data acquisition of the current sample will be aborted.
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You need to confirm this action with your electronic signature.
When the chip run is aborted, you can:

« Switch to the Data context, where you can view, analyze, and evaluate the results (if
any) of your chip run (see “Displaying the Measurement Results (Electrophoresis)” on

page 95 and “Analyzing and Evaluating the Results of an Electrophoretic Method” on
page 104).

 Stay in the Instrument context, where you can start the next chip run, for example.
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Entering Chip and Sample Information

NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

During or after a chip run, you can document the run by entering information on chip and
samples.

1 In the Data context, select the Chip Summary tab.

2 0n the Sample Information sub-tab, you can enter additional information such as
sample names and comments.
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General Properties ] Assay Properties ] {? Chip Surmary l Gel ] Electropheragram ] Result Flagging ] Log Book]
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g
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Data File :
Lacation
Created :
Modified :

Software !

2100 expert_DMA 7500_00000_2005-05-19_14-01-59,xad

C:ih.. . 2100 expertiSecuredArealDataldsDNALDNA 75004 Demo DNA 7500 Custom

Mai 19, 2005 14:02:05
Mai 19, 2005 15:03:35

Created by version B.0Z.01,51211, modified by B.0Z.01,51211

File Wersion : 3 {Latest version)

223

]

Chip Comments :

Sample Mame | Sample Comment Rest, Digest | Status Observation Result Label  |Result Color Approved

1 |PCRMix1 25, 35, 50, 53, 70, ... [l V & Mot Reviewed
2 |PCRMix2 150, 158, 200, Z10.., - V & Mot Reviewed
3 |PCRMix3 500, 550, 600, 650, - V & Mot Reviewed
4 |PCRMix1 75, 35, 50, 53, 70, ... - V & Mot Reviewed
5 |PCRMix2 150, 158, 200, Z10.., - V & Mot Reviewed
6 |PCRMix3 500, 550, 600, 650, - V & Mot Reviewed
7 |PCRMix1 75, 35, 50, 53, 70, ... - V & Mot Reviewed
& |PCRMix2 150, 158, 200, Z10.., - V & Mot Reviewed
9 |PCRMix3 500, 550, 600, 650, - V & Mot Reviewed
10 |PCR Mix 1 75, 35, 50, 53, 70, ... - V & Mot Reviewed
11 |PCR Mix 2 150, 158, 200, Z10.., - V & Mot Reviewed

»|PCR Mix 3 500, 550, 600, 650, - V & Mot Reviewed
[ Chip Lot # | Reagentkitlot# |

prepared by laura|

Sample Information | Instrument Information | Standard Curve

Irnpork. .. |

Expork... |

NOTE

You may find some input fields already filled in, because chip, sample, and study

information are taken over from the base method or chip data file.
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3 From the File menu, select Save.

TIP

You can import chip, sample, and study information from .txt or .csv files. This is
especially helpful and time-saving, if you already have documented a similar chip run
in another chip data file. Refer to “Importing Chip and Sample Information” on

page 310 for details.
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Displaying the Measurement Results (Electrophoresis)

NOTE

The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

You can view the measurement results of an electrophoretic chip run as
electropherograms or gel-like images.

* You candisplay the electropherograms either one sample at a time, or all samples at the
same time to get an overview of the chip run, for example, to see the progress of a
reaction. See “How to Switch Between Single View and Grid View
(Electropherograms)” on page 96.

* You can navigate through the samples. See “How to Navigate Through the Samples” on
page 97.

* You can change the display of electropherograms and gel-like images to make details
better visible. See “How to Change the Display of Electropherograms and Gel-like
Images” on page 98.
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How to Switch Between Single View and Grid View (Electropherograms)

To switch between single view and grid view:

1 From the Electropherogram menu, select View Single Sample or View All Samples.

—0R-

Click the View Single Sample = or View All Samples = button on the
Electropherogram toolbar.

—0R-

Click the All Samples entry in the Tree View Panel to switch to the grid view, or any
sample name to switch to the single view.

—0OR-

Double-click any electropherogram the grid view to switch to single view:

O 2 — |PCR..
EE ] @ & om0 M| A e M 0 0s
1 R Mix 2 R Mix 3
e e = | | .
E N ) 4 @ M o 1w L)
. ——+—+—+— — t
4 8 @ W 1a 4 @ W W @ 5| W e 01 s
LI 2
Size [bp] | Conc. [ngjpl] | Molarity [nmalfl] | Observations -
» 4 15 4.20 4242 |Lower Marker
2 151 2,35 23.6
3 159 3.83 36.6 =
4 197 3.78 29.0
s 206 4.62 35.4
6 293 342 17.7 |

Results Pealk Table | Legend | Errors

Contents

TFL] PCR Mix 2 PCR ...
100
o S—
< |
= —
o«
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How to Navigate Through the Samples

At any time—even during a chip run—you can scroll through all samples—either in
electropherogram or gel view.
To navigate through samples using the Tree View Panel.
1 If the tree view is not visible, select View > Tree View.
The tree view panel appears to the left of the tabs, and shows all chip data and method
files as nodes.
2 Click any sample name.
Electropherogram view: the electropherogram of the selected sample is shown in
single view
Gel view: the lane of the gel-like image corresponding to the selected sample is
highlighted.
To navigate through samples using the Lower Panel:
1 If the lower panel is not visible, select View > Lower panel.
The lower panel appears in the lower left corner.

2 Electropherogram view: Click any lane of the small gel image.
Gel view: Click any well on the chip icon.
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To browse through samples:

1 From the Electropherogram or Gel menu, select Next Sample or Previous Sample.
—0OR-

Click the Next Sample @ or Previous Sample & button in the toolbar.

To switch between electropherogram and gel view:

1 Click the Electropherogram or Gel tab to display the results of the selected sample as
an electropherogram or as a gel-like image.

How to Change the Display of Electropherograms and Gel-like Images
It is possible to change the display of electropherograms and gel-like images.
In electropherograms and gel-like images you can:

* zoom (enlarge or reduce using the mouse) the graphs to display details, for example.
In electropherograms, you can additionally:

* show data points.

* pan and scale the graph using the mouse.

* change the background from a gray-to-white gradient to white.
* add a grid to the electropherograms.

In gel-like images, you can additionally:

e change the gel color.

* change order of gel lanes in gel like images.

Contents AIY Index



To zoom into an electropherogram:
1 From the Electropherogram menu, select Graph Mode > Zoom (default setting).

2 Position the mouse pointer in the electropherogram.

3 Click and hold down the left mouse button.
The mouse pointer changes its shape to a magnifying glass e :

4 Drag the mouse.
A rectangle shows the part of the an electropherogram to be enlarged.

b Release the mouse button.
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To pan and scale an electropherogram:
1 From the Electropherogram menu, select Graph Mode > Pan or Scale.

2 Position the mouse pointer in the electropherogram.

3 Click and hold down the left mouse button.

The mouse pointer changes its shape to a double-arrow or to a double crosshair.

4 Drag the mouse.

As you drag the mouse, the electropherogram curve moves in the drag direction (Pan
mode), or the scales of the X and/or Y axes change (Scale mode).

b Release the mouse button.

You can perform several zoom, pan and scale steps in a row.

To undo the last zoom, pan, or scale step:

1 Click the Undo Zoom #~ button or double-click in the electropherogram.
To undo all zoom, pan, and scale steps:

1 Click the Undo All 'E button.
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To display data points in an electropherogram:

1 From the Electropherogram menu, select Show Data Points or click the E putton in the
toolbar.

Data points used to generate the graph are now shown as bullets. Data points are 0.05
seconds apart.

To remove the gray-to-white gradient from the background of an electropherogram:
1 From the Electropherogram menu, select Show Gradient.
The color gradient disappears and a white background is displayed.

To show/hide the grid lines on an electropherogram:
1 From the Electropherogram menu, select Show Grid.
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Cleaning the Electrodes after an Electrophoretic Method

When the method is complete, remove the used chip from the bioanalyzer and dispose of
it according to the guidelines established by your laboratory safety officer. Remove the
chip quickly to prevent a buildup of residues from the solutions on the electrodes.

Electrodes

Then perform the cleaning procedure to ensure that the electrodes are clean (i.e., no
residues left from the previous method). The cleaning procedures are described in detail
in the appropriate Reagent Kit Guide and in the Agilent 2100 Bioanalyzer Maintenance
and Troubleshooting Guide.
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Good Practices
e Empty and refill the electrode cleaner at regular intervals (e.g., every five methods).

* The electrode cleaner can be used for 25 methods.

Never use a cloth to clean the electrodes. Electrostatic discharge could damage the
high-voltage power supplies.

Wet electrodes can cause severe damage to the on-board high voltage power
supplies. Always make sure the electrodes are dry before inserting them into the
bioanalyzer again.
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Analyzing and Evaluating the Results of an Electrophoretic Method

The purpose of electrophoretic methods is to separate sample components and
determine their size, concentration, purity, or molarity. Results for a particular sample are
calculated after all data for that sample has been read.

The steps in data analysis differ depending on the type of method in use:
« “Data Analysis: DNA” on page 105

e “Data Analysis: RNA and Cyb-Labeled Nucleic Acids” on page 110

e “The RNA Integrity Number (RIN)” on page 113

« “Data Analysis: Protein” on page 127

e “Smear Analysis” on page 135
Further steps in analysis are:

e “Changing the Data Analysis” on page 139

e “Manual Integration” on page 154

* “Reanalyzing a Chip Data File” on page 164

e “Comparing Samples from Different Electrophoretic Chip Runs” on page 166

e “How to Use the Form Mode” on page 182

NOTE

The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

Contents A104V Index



Data Analysis: DNA

The data analysis process for DNA methods consists of the following steps:
1. Raw data is read and stored by the system for all of the individual samples.

2. The data is filtered and the resulting electropherograms of all samples are plotted. You
can change the settings of the data analysis after the run and reanalyze your data.

3. Peaks are identified for all samples and are tabulated by peak ID. You can change the
settings of the peak find algorithm and reanalyze the data after the run has finished.
(Note that peak find settings can be changed for all or only certain samples.)
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4. A sizing ladder (see the following example electropherogram), which is a mixture of
DNA fragments of known sizes, is run first from the ladder well. The concentrations and
sizes of the individual base pairs are preset in the method and cannot be changed.

[FUT, Ladder Ladder

40+

Laclder

UL

a0 an 50 &0 70 a0 a0 100 10 [s]

L
Sizge [bp] | Conc. [ng/pl] | Molarity [nmolfl] | Observations -
3K ] 15 4,20 424,27 Lower Marker
2 |l 25 2,00 121.2 |Ladder Peak [
3 |k ] 2,00 60,6 |Ladder Peak
4 |k 100 2,00 30,3 |Ladder Peak
5 |k 150 2,00 20,2 |Ladder Peak |
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5. A standard curve of migration time versus DNA size is plotted from the DNA sizing
ladder by interpolation between the individual DNA fragment size/migration points.
The standard curve derived from the data of the ladder well should resemble the one

shown below.
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6. Two DNA fragments are run with each of the samples, bracketing the DNA sizing range.
The “lower marker” and “upper marker” are internal standards used to align the ladder
data with data from the sample wells. The figure below shows an example of assigned

marker peaks in a sample well.

Ladder
v Lower marker

[FUle

0T Upper marker

40+

10+

T UV

a0 an 50 &0 70 a0 a0 100 10 [s]

NOTE
The software performs alignment by default. Turning automatic data analysis off

suspends data analysis until you turn it on again.

1. The standard curve, in conjunction with the markers, is used to calculate DNA fragment
sizes for each sample from the migration times measured.
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8. To calculate the concentration of the individual DNA fragments in all sample wells, the
upper marker, in conjunction with a method-specific concentration against base-pair
size calibration curve, is applied to the individual sample peaks in all sample wells.

NOTE

The software allows you to redefine the peaks chosen as upper and lower markers. A
change in marker selection will cause quantitative changes in the calibration
procedure, however, and therefore in the entire data evaluation.

9. If the check box Rest. Digest on the Chip Summary Tab is enabled, the 2100 expert
software flags peaks that may have co-migrated:

Size [bp] | Conc. [ngfpl] | Molarity [nmolil] Observations

1 |4 15 4,20 4242 Lower Marker

z 2z 1.71 116.6 |Possible Co-Migration of 4 Peaks
& =5 1.31 35.8

4 104 4,22 61,3 [Possible Co-Migration of 2 Peaks
5 141 3.19 34.4

=] 157 3.587 315

7 235 4.74 30.6

g 330 6.581 31.3

9 351 7.99 3158

10 476 10,34 329

11 512 9.31 276

12 | 1,500 2.10 2.1 [Upper Marker

Resulks | Peak Table | Legend | Errors
Since it is assumed that the molarity of all the fragments in a restriction digest should
be the same, any peaks or clusters having a molarity that is significantly larger than the
rest are flagged as potentially co-migrating peaks, allowing you to examine them in
more detail.
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Data Analysis: RNA and Cy5-Labeled Nucleic Acids

The data analysis process for RNA and the Cyb-labeled nucleic acids methods consists of

the following steps:

1. Raw data is read and stored by the system for all of the individual samples.

2. The data is filtered and the resulting electropherograms of all samples are plotted. You
can change the settings of the data analysis after the run and reanalyze your data.

3. Fragments are identified for all samples and tabulated by peak ID. You can change the
settings of the peak find algorithm for any or all samples and reanalyze the data.

4. An RNA ladder (containing a mixture of RNA of known concentration) is run first (see
the electropherogram below). The concentrations and sizes of the individual base pairs

are preset in the method and cannot be changed.

[FUly Ladder

12+

10+

ot

Ladder
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20 25 a0 35 40 45 0 S5 &0 &5 [s]

L

Electropherogram of RNA 6000 Ladder (Ambion, Inc. cat. no. 7152)
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NOTE
Peak ratios for the RNA ladder may vary from one batch of RNA 6000 ladder to the
next. Method performance will not be affected by this variation.

5. For the Eukaryote or Prokaryote Total RNA method, the RNA fragments (either 18S and
28S for eukaryotic RNA or 16S and 23S for prokaryotic RNA) are detected. After
detection, the ratio of the fragment areas is calculated and displayed.

[FL]y Sampe 12 Sampl...

121
lower marker
1T4e

=k

Sample 12
|

L./\/\V_Mﬁf“ B
Bl [

f
| ; ; ; ; t t "é? ; f t ;
20 22 20 35 A0 15 S0 55 50 &5 [=]

ik

6. To calculate the concentration of the RNA, the area under the entire RNA
electropherogram is determined. The ladder, which provides the concentration/area
ratio, is applied to transform the area values into concentration values.
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Alignment of RNA Samples

The marker solution that is part of each RNA LabChip kit, contains a 50 bp DNA fragment.
This fragment is used as lower marker to align all samples.

By default the RNA alignment and the subtraction of the lower marker are enabled for
RNA Nano methods.

The marker is displayed as the first peak in the electropherogram.
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The RNA Integrity Number (RIN)

The RNA integrity number (RIN) is a tool designed to help scientists estimate the
integrity of total RNA samples. The RIN extension automatically assigns an integrity
number to a eukaryote total RNA sample analyzed on the Agilent 2100 bioanalyzer. Using
this tool, sample integrity is no longer determined by the ratio of the ribosomal bands
alone, but by the entire electrophoretic trace of the RNA sample, including the presence
or absence of degradation products. In this way, interpretation of an electropherogram is
facilitated, comparison of samples is enabled and repeatability of experiments is
ensured.

Scope
What the RIN can do:
* Obtain an assessment of the integrity of RNA.

* Directly compare RNA samples (e.g. before and after shipment, compare integrity of
same tissue across different labs, etc.).

 Ensure repeatability of experiments (e.g. if RIN shows a given value and is suitable for
microarray experiments, then the RIN of the same value can always be used for
microarray experiments given that the same organism/tissue/extraction method was
used).

What it cannot do:
 Tell a scientist ahead of time whether an experiment will work or not if no prior
verification was done (e.g. RIN of 5 might not work for microarray experiments, but

might work well for an appropriate RT-PCR experiment. Also, an RIN that might be good
for a 3' amplification might not work for a 5' amplification).
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The computation of the RIN is part of data analysis for total RNA samples. The computed
RNA integrity number is shown on the Results sub-tab of the Gel or Electropherogram
tab of the Data context. It is also included in XML export files and in printed reports.

Assay Properties ] Chip Surmary ]Gel] Electropherogram l Result Flagging ] LogBook]

[FUT & Sample 2 Saml...

12+

10+

]
L.
|

T T I I I I T T I I
20 25 30 25 40 45 50 55 60 65 [5]

RMA Area B1.2
RMA Concentration: 1m ngjul

rRINA Ratio [28s [ 185]: 1.2

RMA Integrity Mumber (RIN): 7.9

E'R_esults | Peak Table Fragment Table Legend | Errors |
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NOTE

Until now, the computation of the RIN has only been validated for eukaryote total RNA
Nano samples. The 2100 expert software also calculates the RIN for prokaryote total
RNA samples and for the RNA 6000 Pico method. Be aware that for these samples, the
RIN has not been validated in extensive downstream experiments.

Although the lower quantitative limit of the RNA 6000 Nano method is specified as 25
ng/pl it is recommended to use at least 50 ng/pl for a meaningful RNA integrity number.
When using lower concentrations, higher sample to sample variances of the RIN may be
observed.

Examples for RNA Integrity Numbers

A database of about 1300 mammalian total RNA samples was created using the RNA
6000 Nano method. The samples came from different species (mainly human, rat and
mouse), tissues, preparation methods, concentrations and degradation states. All
samples were classified according to their degradation state. Numbers from 1" to "10°
were used as labels. 10" stands for a perfect RNA sample without any degradation
products, whereas "1 marks a completely degraded sample. The labels in-between are
used to indicate progressing degradation states of the RNA sample. The following figure
shows typical representatives for each of the 10 RNA integrity classes.
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Computation of the RNA Integrity Number and Signal Anomalies

For the computation or the RNA integrity number, the electropherogram is partitioned

into regions as shown in the figure below. The lower marker and the 18S and 28S

fragments divide the electropherogram into nine regions:
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Signal Anomalies

In addition to the computation of the RIN, the data analysis detects various unexpected
signals, disturbing the computation of the RIN. Such disturbances are called anomalies.
Region anomaly detectors recognize unexpected signals in each region. If detected, the

anomaly is displayed in the Error sub-tab of the Electropherogram and Gel tab.
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Anomaly Description Critical?

Unexpected baseline signal Yes
Unexpected signal in pre-region No
Unexpected signal in 5S-region Yes
Unexpected signal in fast-region Yes
Unexpected signal in inter-region Yes
Unexpected signal in precursor-region No
Unexpected signal in post-region No
Unexpected ribosomal ratio Yes
Unexpected sample type Yes
Unexpected lower marker (compared to previous well) No

Two categories of anomalies were introduced, critical and non-critical. Anomalies in
regions interfering with the customer sample RNA are considered critical. The
corresponding gel lane is flagged red.

The baseline anomaly, for example, is detected for signals with fluctuating or steep
baseline. The ribosomal ratio anomaly detects unexpected ratios of the 28S fragment
area and the 18S fragment area. The unexpected sample type anomaly is detected for
samples which do not fit the standard total RNA profile.
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If a non-critical anomaly is detected, the RIN can still be computed accurately. Therefore
non-critical anomalies are not flagged. Non-critical region anomalies are pre-region
anomaly, precursor-region anomaly and post-region anomaly. The electropherogram
below gives an example for a non-critical anomaly in the post-region.
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Troubleshooting the RIN

To obtain meaninful and reproducible results, the lower marker and ribosomal bands
must be identified correctly. Although the ribosomal fragment identification has been
improved, in rare cases (i.e. when analyzing degraded RNA samples) the fragment
baseline is not properly set. In this case the user should adjust the baseline settings
manually.

Example:

‘Incorrect’ software identification of the ribosomal fragments: RIN=7.2
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RNA integrity number after the manual adjustment: RIN=5.7
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On details on how to adjust the lower marker and ribosomal bands, please refer to
“Changing the Data Analysis” on page 139.
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Use Models for the RNA Integrity Number

To take full advantage of the RIN feature, a 2 step use-model is suggested:

1 Determine the threshold value for the RIN that results in meaningful downstream
experiments:

— Cells/ Culture

Isolation of total RNA
RNA QC via
' Agilent 2100 bioanalyzer

Correlate RIN with downstream experiment and determine threshold RIN
for meaningful results (iterative process)
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2 Run standard experiment and use RIN to determine if sample integrity is sufficient:

RIN
below
threshold

—

Cells/ Culture

Isolation of total RNA

RNA-QC via
' Agilent 2100 bioanalyzer

¢

RIN above threshold

Continue with downstream experiment (microarray, real-time PCR, etc.)
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RNA Integrity Number Setpoints

Various setpoints are available to customize the display of the RIN (RNA Integrity
Number). With these setpoints, you can modify the predefined thresholds for anomaly
detection. You can find them in the advanced user mode of the setpoint explorer.

To adjust the setpoints for a single sample, switch to the Local tab of the setpoint
explorer and open the RNA Integrity Number group.

To adjust the setpoints for the whole chip, switch to the Global tab of the setpoint
explorer and open the RNA Integrity Number group in the Sample Setpoints group. For

the chip, you can additionally switch between integer and decimal representation of the
RIN.

For more information on how to use the setpoint explorer, see “About the Setpoint
Explorer” on page 140.
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Data Analysis: Protein

The data analysis process for protein methods consists of the following steps:
1. Raw data is read and stored by the system for all of the individual samples.

2. The data is filtered and the resulting electropherograms of all samples are plotted. You
can change the settings of the data analysis after the run and reanalyze your data.

3. Peaks are identified for all samples and are tabulated by peak ID. You can change the
settings of the peak find algorithm and reanalyze the data after the run has finished.
(Note that peak find settings can be changed for all or only certain samples.)
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4. A sizing ladder (see the example electropherogram below), which is a mixture of
proteins of different known sizes, is run first from the ladder well. The sizes of the
individual proteins are preset as kDa in the method and cannot be changed. Please note
that the concentrations may vary slightly from ladder lot to ladder lot.

[FUla Ladder Ladder
a”
100+
80+
! -]
4 ‘o
Gl Pl A
o
o
o=
3
40t
™
201
41 t
—
15 20 25 a0 s 40 5]
L
Size [kDa] | Observations -~
b 4 6.0 Lower Marker
2 |k 9.0 Ladder Peak
3 |k 14,4 |Ladder Peak
4 |k 21,5 |Ladder Peak
5 |l 29,0|Ladder Peak -
& b 32,5 |Ladder Peak
7 |k 53.0|Ladder Peak
5 |k 66,7 |Ladder Peak -
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5. A standard curve of migration time versus size is plotted from the sizing ladder by
interpolation between the individual protein size/migration points. The standard curve
derived from the data of the ladder well should resemble the one shown below.

Point to Point Fit
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6. Two proteins are run with each of the samples, bracketing the sizing range. The “lower
marker” and “upper marker” proteins are internal standards used to align the ladder
data with data from the sample wells. The figure below shows an example of assigned
marker peaks in a sample well.

(P14

Igia reduced

I3 re...

a0

70T
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40+ -

Iot reduced

30
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T
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Lower marker

Upper marker

15 20 35 40 [s]
2
Size [kDa] | Rel Conc, [pgiml] | Calib, Conc, [pg/ml] | % Tokal | Observations | Area

1 |4 &.0 0.0 0.0 0.0 |Loveer Marker 19.9

2 8.5 0.0 0.0 0.0 |Syskem Peak 275

3 25.3 140.7 0.0 23.7 3.5

5 58.1 451.7 0.0 76.3 32.6

5 |p 210.0 100.0 0.0 0.0 |Upper Marker 10,3

NOTE

The software performs alignment by default. Turning automatic data analysis off
suspends analysis until you turn it on again.
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1. The standard curve, in conjunction with the markers, is used to calculate protein sizes
for each sample from the migration times measured.

8. To calculate the concentration of the individual proteins in all sample wells, the upper
marker is applied to the individual sample peaks in all sample wells.

NOTE

The software allows you to define upper and lower markers yourself. A change in the
selection of the markers will lead to quantitative changes in the calibration procedure,
however, and therefore in the entire data evaluation.
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Protein Absolute Quantitation

Absolute quantitation is calculated based on the relative concentration of a sample and
the user-defined standard and the known concentration of this user-defined standard.

For protein samples you can enable the use of calibration for each sample and enter the
concentration of the standard protein. This allows you to generate a calibration curve,
which can be used to analyze and quantitate this protein within different samples on the
same chip.

Using Calibration in Protein Assays

The calibration feature for protein assays allows absolute quantitation based on external
standard calibration.

On the Chip Summary tab, use the sample table on the Sample Information sub-tab to
define the samples that you want to use as calibration standards and enter a
concentration.

Sample Mame |Sample Comment |se For Calibration | Conc.[ugfml] | Status

beta LG I 0| &

2 |betals ¥ 70| a4
3 |betala v 140| o
¥ |beta LG ¥ 4007 o

5 |owalburnin MR |non-reduced r O g
& |ovalbumin R [reduced I O g
7 linsulin B chain |20 ugjml r O 4
§ |standard A r 0 o
9 |betala 500 ug/mil v 120| o
10 |standard B r 0 g
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The calibration standard should be run in different concentrations to generate a

calibration curve. The software will automatically produce this calibration curve based on
these inputs to determine the actual concentration of samples within the same chip. In
the peak tables of the samples, a remark is added to the observation column to identify
the calibration protein and the calibrated proteins:

Size [kDa] | Rel. Conc. [pgiml] | Calib. Conc. [pgfml] | %% Taotal Observations
K | 3,5 0,0 0,0 0,0 [Lawer Marker
2 4,2 0,0 0,0 0,0 [Swskem Peal:
3 4,7 0,0 0,0 0,0 [Swskem Peak
4 16,5 31,4 0,0 6,7
(3 18,5 392,56 131,2 83, 7 i_alibration Prokein
& 25,9 45,1 0,0 9,6 b
7 } 53,0 100,0 0,0 0,0 Upper Marker
Size [kDa] | Rel Conc, [pgiml] | Calib, Conc, [pafml] | %% Tokal Chseryations
4 3,5 0,0 0,0 0,0 |Lower Marker
2 4,1 0,0 0,0 0,0 |Swstem Peal,
3 4,5 0,0 0,0 0,0 [Swstem Peal,
B[ 13,4 22,1 74 43,2 iCalibrated Protein
5 29,1 29,1 0,0 56,3 L
& } 53,0 100,0 0,0 0,0 Upper Marker
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The calibration curve can be displayed by switching to the Calibration Curve sub-tab on
the Chip Summary tab.
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Smear Analysis

The 2100 expert software allows to perform a smear analysis for all electrophoresis
methods.

When the smear analysis is enabled, the software allows you to define regions of
interest. These regions are used to define the area of broad peaks and determine their
part of the total area. Smear analysis provide a means to analyze broad signals that can
be hardly evaluated with the normal peak assignment.

You therefore can define regions of interest that contain the peaks (base pair size) that
you are interested in. For these regions you can determine the covered area in relation to
the total area.

NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

Enabling Smear Analysis

To enable smear analysis:
1 Go to the Electropherogram tab in the Data context:

2 Go to the setpoint explorer and select the Local or Global tab, depending on which
samples should be analyzed.

3 Select the Advanced mode.
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=| : Integrator
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Peak filter width [s] 0,5
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=| : Ladder Setpoints
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j Collapse |

=]

o]

Defaults | Help |

The Region Table sub-tab is added to the Electropherogram tab.

Contents

4 Under Smear Analysis, select the check box Perform Smear Analysis.
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Performing Smear Analysis

After enabling the smear analysis in the setpoint explorer, you are able to insert regions
of interest in the electropherogram.

To do so:

1
2

Select the Region Table sub-tab in the Electropherogram tab.

Right-click the electropherogram and select Add region.

Aregion will be inserted into the electropherogram. The Region Table shows the values
for the inserted region.

Repeat the previous step until the number of required regions is inserted.
Adjust the regions by directly moving the dashed lines in the electropherogram.

To remove a region, right-click the dashed line in the electropherogram and select
Remove Region from the context menu.

NOTE
The smear analysis table can be directly edited by selecting the region table under
Smear Analysis in the setpoint explorer.
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Locall Global ]

IAdvanced j Collapse |
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Concentration of upper ma... 4,2
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Baseline start time [s] 26
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In the smear analysis table, you can edit the Region Start Size and Region End Size, for
example:

A

From [bp] # | Tao[bp] Color
1 28 405 [
2 392 515 [

Delete Add

Canicel |
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Changing the Data Analysis

NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

Different sets of parameters (data analysis setpoints) can be changed in the software in
order to modify the data evaluation for sample analysis:

* Filtering parameters

Peak find parameters for all samples/peak height for individual samples

Enabling smear analysis

Align to upper and/or lower marker

Adding/deleting ribosomal fragments (for RNA methods only)

Manual integration (for protein and DNA methods only)

Absolute quantitation (for protein methods only)

These settings can be made before a new run is started or when reanalyzing a previously
saved data file.
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About the Setpoint Explorer

The tool allowing you to modify the data analysis setpoints is the Setpoint Explorer. The
setpoint explorer is accessible from:

* Assay Properties Tab

* Electropherogram Tab (Single/Grid View)
e Gel Tab
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On the Method Properties tab, the setpoint explorer is always visible and lets you modify
setpoints globally (for all samples):

Local ] Global l

IAdvanced j Collapse |

'=| : Quantitation ;I
Concentration of upper... 4,2
Concentration of lower ... 8,3
=| : Sizing
Standard Curve Paint ta Poink
=| : Smear Analysis
Perform Smear Analysis [
=| : Baseline calculation

Baseline start time [s] 26

Baseline end time [s] 94

Zero Baseline [x]
_=| :Filter Settings

Filter width [s] 0,5

Polynomial order 4

=| : Baseline correction
Perform Baseline Carre.,. [
=| : Integrator
Integration skart time [s] 26
Integration end time [s] 94

Slope Threshold 0,5

Area threshold 0,5 —
Height: threshald [FL] g

Peak filter width [s] 0,5

Baseline plateau [s] 5

‘width threshold [s] 1

Peak filter polyniom 6

=| : Ladder Setpoints
=| : Baseline calculation

Baseline start time [s] 26
Baseline end time [s] 94
Zero Baseline [x] LI

Defaults | Help |
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To show the setpoint explorer, on the Electropherogram/Gel tab, click the vertical bar on
the right edge of the application window:

4

g

The setpoint explorer appears.

For electrophoretic methods, you can modify the setpoints
* globally, that is, for all samples (Global tab)

* locally, for the current sample (Local tab)

Click the + nodes to expand, and the — nodes to collapse branches. Setpoints that you
can change are white. To edit a setpoint, double-click the value, enter the new value, and
press enter. They are applied automatically.
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Local ] Global l

IAdvanced j Collapse |

'=| : Quantitation
Concentration of upper... 4,2
Concentration of lower ... 8,3
=| : Sizing
Standard Curve Paint ta Poink
=| : Smear Analysis
Perform Smear Analysis [
=| : Baseline calculation
Baseline start time [s] 26
Baseline end time [s] 94
Zero Baseline [x]
_=| :Filter Settings
Filter width [s] 0,5
5

=| : Baseline correction
Perform Baseline Carre.,. [
=| : Integrator

Trkameskinm chavk Firna Fe1 26

=]

When you try to change any global setpoints where local settings have been applied, the
software prompts you as to whether you want to overwrite the local (custom) settings.

If you decide to overwrite the custom sample settings, all local settings you made will be
discarded. If you decide not to overwrite the custom sample settings, the global settings
will not be applied where local settings have been changed.

Changing setpoints requires that you confirm the action with your electronic signature.
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Filtering Setpoints

The first step the software takes in analyzing the raw data is to apply data filtering. The
following filtering setpoints can be changed:

Filter Width Defines the data window, given in seconds, used for averaging. The
broader the filter width, the more raw data points are used for
averaging. As a result, the noise level will decrease, but peaks will
become lower and broader. Overall, changing the Filter Width has
more effect on the result of the filtering procedure applied then
does changing the Polynomial Order.

Polynomial Order  This setting is used to define the power series applied to fit the raw
data. The higher the number, the more the fit function will follow
the noisy raw data curve. As a result, the noise level of the filtered
curve will increase.

Integrator Setpoints

After data filtering, the peak find algorithm locates the peaks and calculates the local
peak baselines. The algorithm begins by finding all the peaks above the noise threshold
in order to determine the baseline, after which any peaks below the noise threshold are
rejected. A local baseline is calculated for each peak to allow for baseline drift.

Contents A144V Index



The four integrator setpoints that can be changed are:

Slope Threshold The Slope Threshold setpoint determines the difference in the
slope that must occur in order for a peak to begin. The inverse of
this value is used to determine the peak end.

Area Threshold The Area Threshold determines the minimum amount of peak area
that must be detected before a peak is recognized.

Height Threshold  The Height Threshold setpoint determines whether a peak is kept.
It represents the minimal peak height. For each peak, the difference
between the start point value and the center point value (local
baseline) must be greater than the Height Threshold value.

Peak Filter Width  The Peak Filter Width setpoint determines the minimum amount of
time that must elapse before a peak is recognized.

Baseline Plateau = The Baseline Plateau setpoint is a parameter that assists in finding
peaks. The signal is recognized to be at baseline whenever the
slope of the data is less than the Slope Threshold setpoint (either
positive or negative) for longer than the time set for the Baseline
Plateau. This setting rejects brief, low slope areas such as between
non-baseline-resolved peaks.
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Manually Moving Fragment Start and End Points (RNA and Cyb-Labeled Nucleic
Acids)

It is also possible to alter the start and end points manually for individual fragments in an
RNA or Cyb-labeled nucleic acids method. The integration borders of detected
RNA-fragments are displayed in the Fragment Table sub-tab. Zooming in on the base of a
particular fragment allows you to see the start and end points. Placing the cursor over
one of these points changes the cursor to a pointing hand, allowing you to click and drag
the point along the line of the fragment until it is positioned as desired.

[FUly Sarmple 7

01

G601

W 255

20 25 a0 S 40 45 50 55 &0 65 [5]

-9.535\

Move any other start or end points as desired.
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TIP

The fragment table can be directly edited in the setpoint explorer:

%]

Marne

From [5] ¢

165

38,5

To [s] Color
39,72 |

Z 235

43,56

46,19

Delete

&dd

Cancel

NOTE

Changing the start or end points of the fragment will change the calculated rRNA ratio.
It might be convenient to pause the automatic analysis (Electropherogram > Pause

Automatic Analysis) until all changes are done.

Setting the Baseline for Calculation of RNA Concentration

At low signal-to-noise ratios, the baseline that defines the area used for calculating the
concentration of RNA methods is highly dependent on the settings for the Start and End
Time. You can adjust the Start and End Times manually (thereby adjusting the baseline)
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to ensure a good result even at very low signal-to-noise ratios. Choose a single sample.
Two vertical green long-dashed lines indicating the setpoints for the Start and End Times
(with the baseline drawn between them) are displayed in the window.

[FU] ‘ Sample 7

F0+ ‘

|

B0+ ‘

S50+ ‘

|

40|
ui}

= |
E

&8 301

|

|

\

|

|

i

\

20

104 ILM- AM—N‘F/‘J

} L
20 23 30 35 40 45 =) ) 60 (=) [s]

o
I

Move the cursor over the long-dashed line on the left (Start Time setting) and drag the
line to the desired position. Do the same with the long-dashed line on the right (End Time
setting) until you have a flat baseline.

NOTE

Changing the start and end times will change the calculated RNA concentration. It
might be convenient to pause the automatic analysis (Electropherogram > Pause
Automatic Analysis) until all changes are done.
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Assigning Upper and Lower Marker Peaks

For each DNA or protein sample, the upper and lower marker peaks are assigned first and
then the data is aligned so that the sample markers match the ladder markers in time,
allowing the size and concentration of the sample peaks to be determined. RNA samples
are aligned to a lower marker exclusively.

The first peak is assigned to be the lower marker and is then offset to match the lower
marker in the ladder. The upper marker is then assigned to the last peak in the sample
well or to the peak nearest the ladder’s upper marker. See an example of assigned marker
peaks below.

If you get unexpected peaks in the ladder analysis or find that the markers have been set
incorrectly, you may exclude peaks manually from the ladder or set a peak to be used as a
marker. Right-clicking in the peak table causes a context menu to appear, allowing you to
do so:

'ﬂq‘:’- Export. ..

Configure Caolumns. ..

._;:1 Zopy To Clipboard ChrliC
@ Scale bo Selected Peak

‘Ej Manually Set Lower Marker
’Ej Manually Set Upper Marker

ﬁg Exclude Peak
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In case the 2100 expert software did not detect the lower marker in RNA samples
correctly, you are able to manually assign it in the same way.

% Export. ..
Configure Caolumns. ..

L|I:‘| Zopy To Clipboard ChrliC
@ Scale bo Selected Peak

‘@ Manually Set Lower Marker

ﬁ Exclude Peak

Excluding a peak or manually setting a peak to be an upper or lower marker may cause
errors during analysis.
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Aligning or Unaligning the Marker Peaks

The upper and lower are then aligned to the ladder markers by resampling the sample
data in a linear stretch or compression using a point-to-point fit.

Data before alignment:

La... |Pro... Ig... Pra... Pro... Ig... Pro... Pro... Ig... Pro... La...
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Markers aligned to the ladder:

[e=rvengl (e (e (B (Enewe ety (Erven Eiee Do B B

L 1 2 3 4 5 & 7 g 9 10

If the sample marker peaks are either more than twice as far apart or less than half as far
apart as the ladder markers, they are assumed to be the wrong peaks, and analysis of the
sample stops, producing the error “Marker peaks not detected”.
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NOTE

With DNA and protein methods, the height of marker peaks is method dependent.
Ladder peaks are analyzed to calculate a marker peak threshold that is used to locate
the marker peaks in the sample wells. If the marker peaks found using this calculated
method fail to align with those of a sample, the 2100 expert software will use the
minimum peak height threshold setting instead (if this value is lower than the value for
the marker peak). For example, the calculated threshold might be too high to find the
sample's markers if they happen to be very small for some reason. Either no markers
will be found or the wrong peaks will be assumed to be markers and these may not
align with the ladder markers. Consequently, the software attempts to use the
minimum peak height threshold that, if it is set low enough, will catch the real
markers, allowing the sample to align.

NOTE
After alignment, peaks are shown with relative migration times that are different from
the real times with data unaligned.
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Manual Integration

For DNA and Protein methods, the 2100 expert software allows to manually integrate
peaks. Manual integration allows you to move, add or delete peak baselines.

TIP

To move a peak baseline, point along the vertical line, press the CTRL key and left
mouse button. To move a peak baseline, point along the signal, press the left mouse
button only.

NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

Example: Adjusting peak baselines
To manually change peak baselines:

1 Switch to the Electropherogram tab in the Data context and zoom into the
electropherogram to enlarge the peak of interest.

2 Select Electropherogram > Manual Integration to switch off the automatic integration.
As an alternative you can click the Manual Integration button @ in the toolbar.
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The baseline points become visible as blue or green dots. Highlighted baseline points
are labelled green and can be moved either along the vertical line (press CTRL key and
left mouse button) or along the signal trace (left mouse button). The blue baseline
points are fixed and cannot be moved. To highlight a baseline point, click it.

[FUTs

Sample 3
300+ L
250+
2004
o
o
[
£ 150+
m
[y}
100+
sS04
,'i———\;
o —
24.5 25.0 5.5 26.0 8.5 27.0 27.5 28.0 [5]

If you want to change several baseline points, deactivate the automatic analysis by

clicking the Pause Analysis button @ in the toolbar. This way, the software will not
recalculate the data analysis with every change. Once you have changed all baseline
points, click the Pause Analysis button again to activate automatic analysis.
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3 Adjust the baseline points as appropriate.

[FUly Sample 3
00+ &
250

200+

Sample 2

100+

S04

24.5 25.0 5.5 26.0 8.5 27.0 27.5 28.0 [5]

TIP

To move a peak baseline point along the vertical line, press the CTRL key and the left

mouse button. To move a peak baseline point along the signal, press the left mouse
button only.

4 Click the Automatic Analysis button O to enable the integration again.

The integration results in the result and peak tables will change according to the
changes done.
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Example: Removing peaks

To remove peaks:

1 Highlight the Electropherogram tab in the Data context and zoom into the
electropherogram to enlarge the peak of interest.

2 Select Electropherogram > Manual Integration to switch off the automatic integration.
As an alternative you might click the Manual Integration button @ in the toolbar. The
baseline points become visible as blue or green dots.

[FUly Sarnple 3
00 o
2501
200+
o
i
=
= 1504
m
m
100+
S0+
0 *——/ :
i ,e' Undo Zoom
24.5 25.0 25.5 26.0 26.5 2 || Undo &l [s]
I!E Copy Electropheragrar
Sige [kDa] | Rel. Conc, [pgfml] | Calib. Conc, [pgiml] | %% Total Cibseryal L"J:l T A o e
1 |4 £.0 0.0 0.0 0.0 |Lower Marker|[f] Manual Integration
2 8.3 0.0 0.0 0,0|System Paak | 25 add Peak
3 95 0.0 0.0 0.0 |system Peak [T Remaove Peak N |
b 61.9 471.4 4534 100,0|Calibration Pr{ [,.\E
Approyal L
5 |k 2100 100.0 0.0 0.0 Upper Marker :
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3 Right-click a baseline-point and select Remove Peak from the context menu.

The two baseline points and the connecting line will disappear and the integration
results shown in the result and peak tables will be updated:

[FUT. Sample 3
300+
250+
200+
m
il
=
£ 150
m
i)
100+
S0+
0
24.5 25.0 255 26.0 26.5 27.0 27.5 28.0 5]
Size [kDa] | Rel. Conc, [pgfiml] | Calib. Conc, [pafml] | % Tatal | Observations
1 |4 6.0 0.0 0.0 0.0 Lower Marker
s 8.3 0.0 0.0 0.05vstem Peak
3 2.5 0.0 0.0 0.0 |System Peak
212 210.0 100.0 0.0 0.0 Upper Marker
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Example: Inserting peak baselines
To insert peaks manually:

1 Highlight the Electropherogram tab in the Data context and zoom into the
electropherogram to enlarge the peak of interest.

[FUT. Sample 3
300+
250+
200+
m
il
=
£ 150
m
i)
100+
S0+
0
24.5 25.0 25.5 26.0 26.5 27.0 275 28.0 [s]
Size [kDa] | Rel. Conc, [pafiml] | Calib, Conc. [pgfml] | % Tokal | Observations
1 |4 6.0 0.0 0.0 0.0 |Laowvwer Marker
s 8.3 0.0 0.0 0.0 |Swskem Peak
3 2.5 0.0 0.0 0.0 |Syskem Peak
212 210.0 100.0 0.0 0.0 |Upper Marker
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2 Right-click the electropherogram and select Add Peak from the context menu.

[FUTa Sample 3
300+
250+
200+
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(&) Unda A
!—E Copy Electropherogram
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U ;Fl Save Electropherogram
t t t t I+ | Int i t t
24.5 25.0 25.5 oen | Manual Intzgration b7 .5 28.0 [s]
Add Peak. [
Remove Peak
Size [kDa] | Rel. Conc, [pgiml] | Calib, Conc. [pa)fml]
r .0 0.0 0.0 Appraoval 3
s 8.3 0.0 0.0 0.0 |Swskem Peak
3 2.5 0.0 0.0 0.0 |Syskem Peak
4 | 210.0 100.0 0.0 0.0 |Upper Marker
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3 Two baseline points and the connecting line will appear and the integration results
shown in the result and peak tables will be updated.

[FUlg Sample 3
300+ B
250+
200+
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24.5 25.0 25,5 26.0 265 27.0 275 28.0 5]
Size [kDa] | Rel Conc, [pgiml] | Calib, Conc, [pgfml] | % Tokal Observations
1 |4 6.0 0.0 0.0 0.0 [Lower Marker
z 8.3 0.0 0.0 0.0 |Syskem Peak
3 2.5 0.0 0.0 0.0 |Swskem Peak
(38 3 61.9 231.3 224.9 100.0 | Calibration Protein
5 |p 210.0 100.0 0.0 0.0 |Upper Marker
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TIP
If you want to change several baseline points, deactivate the automatic analysis by
clicking the Pause Analysis button @ in the toolbar. This way, the software will not

recalculate the data analysis with every change. Once you have changed all baseline
points, click the Pause Analysis button again to activate automatic analysis.

4 Adjust the baseline points as appropriate.

TIP

To move a peak baseline point along the vertical line, press the CTRL key and the left
mouse button. To move a peak baseline point along the signal, press the left mouse
button only.
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5 Click the Automatic Analysis button O to enable the integration again.

The integration results in the result and peak tables will change according to the changes
done.
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Size [kDa] | Rel. Conc. [pafml] | Calib. Conc, [pafml] | % Tatal Ohservations
1 |4 6.0 0.0 0.0 0.0 Lower Marker
s 8.3 0.0 0.0 0.05vstem Peak
3 2.5 0.0 0.0 0.0 |System Peak
Al 2 61.9 4721 454.1 100,00 /Calibration Prokein
5 |k 210.0 100.0 0.0 0.0 |Upper Marker
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Reanalyzing a Chip Data File

NOTE

Occasionally you may wish to open and view or reanalyze a chip data file that was run
and saved previously. The raw data values are saved in the data file, along with the
analysis settings that were chosen for the run, so that the data can be reanalyzed with

different settings.

NOTE

The 2100 expert Security Pack restricts access to data and functionality to users who

are logged in with certain roles. See “User Role Model” on page 52 for details.

To do this:
1 Click File > Open to open a chip data file (.xad).

2. Choose the filename from the list of data files.

3. Click OK.

The items that can be changed for reanalysis are:
All Electrophoresis Methods:

* Global peak find settings

¢ Individual sample peak find settings

* Gel color

* Sample names and comments
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RNA Methods Only:
* Fragment names and colors associated with labels
* Fragment start/end times, additional fragments (or delete fragments found)

* Reassign lower marker
DNA and Protein Methods Only:

* Exclude peaks from analysis
 Reassign upper/lower markers
* Alignment or no alignment with marker peaks

¢ Manual integration
Protein Methods Only:

* Absolute quantitation

TIP

When applying modified data analysis setpoints, the software will (by default)
immediately recalculate the raw data, which takes some time. Select Don’t Analyze
from the Gel Menu or Electropherogram Menu to temporarily switch off automatic
data analysis while you modify setpoints.

If you save the data file after making changes, it will keep a record of the changes such
as gel color, sample names, and peak find settings that were in effect at the time the file
is resaved. If you do not want to change the original file, choose File > Save As... and give
the file a new name or save it to a different location.
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Comparing Samples from Different Electrophoretic Chip Runs

The 2100 expert software allows you to compare the measurement results of samples
from different electrophoretic chip runs. Samples to be compared must be from chip runs
of the same method type.

In the Comparison context, you can create comparison files, include samples from
different chip runs, and compare the samples by overlaying electropherograms, for
example.

NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

To compare samples from different electrophoretic chip runs:

1 Switch to the Comparison context.

2 From the File menu select Open, and open all chip data files (.xad) that contain the
samples you want to compare.
The .xad files appear in the Select Data Files list of the Tree View Panel.

NOTE
The Select Data Files list also contains all electrophoretic .xad files that are currently
open in the Data context.
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3 Select a .xad file from the Select Data Files list to display a list of its samples.

Select Data Files

2100 expert_Probein 200_0000
#2100 exxperk Prokein 2000 0000
B 2100 expert_Protein 2003000
B 2100 expert_DMNA 1000_00000)

TTOTT-TEUOLET
Prokein Ladder 3
Protein Ladder 2
IgG nonreduced
Prokein Ladder 3
Ladder conc,
Ladder

4 Right-click a sample name and select Add Sample to New Comparison File.

B z003-11-05_11-23-53.0ad 7]

Praotein Ladder 2
I0G reduced

Prokein Ladder 3
Protein Ladder 2

Pratein Ladder |_ Add Sample to Mew Compyarison File
Prokein Ladder # | o

You need to confirm this action with your electronic signature.
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A new comparison file appears in the upper part of the tree view containing the sample.
The sample is selected and its electropherogram is shown.

Electropherogram - IgG non-reduced

m Al Camparison Files J
Eﬁ ComparisonFile0 Protei

4| | »

b Select Data Files
B zo03-11-05_11-2355 xad 7|

Protein Ladder 2
195 reduced

Protein Ladder 3
(Protein Ladder 2

Protein Ladder 3
Protein Ladder 2
195 nonreduced
Protein Ladder 3
Ladder conc,
Ladder

COmparison Summary l el l Electropherogram
[FUl, 195 non-reduced IgGn...
B0 i
i
L J t
ot |
- :
i i
=) ]
BT :
5 i
= ]
T 20 s
: ~ : . . :
15 20 25 E E 40 [z] .
Size [kDa] | Rel. Conc. [pgiml] | Calib, Conc. [pgfml] | % Total | Observations | Area
(3 | 6.0 0.0 0.0 0.0 Lawer Marker 14.¢
2 8.5 0.0 0.0 0.0 |Swskem Peak 17,5
3 168.7 326.5 0.0 100.0 26,¢
4 | 210.0 100.0 0.0 0.0 |Upper Marker .k
4 | i

Results Peak Table | Legend | Errars |

Note that the Electropherogram Tab (Single/Grid View) has the same functionality as

in the Data context.
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5 You can now add further samples from any of the open .xad files to the comparison file.

v Select Data Files | U E
|ﬁ’ 2003-11-05_11-23-53.xad ¥ | DV - \/\-\-
Protein Ladder 2 I
it B

109G reduced -h
Praotein Ladder 3
Praokein Ladder 2

IgG non-reduced Size [kDa] | Re
Prokein Ladder 3 b4 5.0
|Protein Ladder 2 -

15 nonredun

Protein Ladd
Ladder canc, Add Sample to Meww Cn:-mlﬁ'gris-:nn File 0

Ladder

Add Sample ko Comparisan File i

=1

<

Resulks Peak Table |:

TIP

Double-clicking a sample name in the lower part of the tree view or dragging a sample
name into the tree view adds the sample to the comparison file that is currently
selected in the upper part of the tree view. Or, if no comparison file is selected, creates
a new comparison file and adds the sample to it.

You are notified if you try to add a sample of a .xad file that has the wrong method type.
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6 You can also remove samples from a comparison file. Right-click the sample name and
select Delete Sample from Comparison File.

m All Comparison Files J Comparisan SUmmarsy l Gel
Elﬁ ComparisonFiled Protei

-] IgG non-reduced [FU]$

| 1gG nonreduced B0

| Ladder E Delete Sample from Compaejson File

-] Taa reduced b,
foo| ] Sample 1

aduced

30

You need to confirm this action with your electronic signature.

Contents A10V Index



7 When you have added all your samples, you can select the Comparison Summary Tab
which displays information on the comparison file, and lets you enter a comment
regarding the comparison.

COmparison Summary Gell Electropherogram ]

105 non-reduced File: : CompatisonFiled Prakein 200, xac

193 nonreduced
1gia non-reduced

Location

Assay Class @ Prokein 200

Ladder

15 reduced Created : Mowember 05, 2003 11:44:45 AM
]| Sample 1
= Modified : Mowember 05, 2003 11:44:45 AM

Software Created by version B.01.01.51116, modified by E.01.(

Sample Name Sarmple Comment File:
» 19G non-reduced Y. .. Datal2003-11-0512100 expert_Protein 200_0000
4| | vl |2 [I9G nonreduced :Y...Datal2003-11-0542100 expert_Prokein 200_0000
= elect Data Files 3 IgG non-reduced Y. .. Datal2003-11-0512100 expert_Protein 200_0000
4 |Ladder :Y...Datal2003-11-0542100 expert_Prokein 200_0000
I z003-09-24_11-30-28.52d =] 5 [19G reduced i\, Datalz003-11-052100 expert_Pratein 200_0000
Sample 1 & |Sample 1 ... 100 expertidatal2100 expert_Prokein 200_0000C
Sample 2
Sample 3
Sample 4
Sample 5
Sample &
Sample 7
Sample &
Sample 3
Sample 10
Ladder
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8 To compare the electropherograms of samples, go to the Electropherogram tab,

Overlaid Samples in the toolbar, and select the samples to be compared.

Electropherogram - IgG non-reduced

m.ﬂ.ll Zomparison Files J Camparison Surnrmary l Gel l Electropheragram

= ﬁ ComparisonFiled Protei
. o= -
Mg 105 non-reduced [FUl 4 1aG non-reduced TaGn
----- ]| Ig5 nonreduced
-] Ladder oo
-] 193 reduced
- | Sample 1
20+
ki
-é B0
£
z
2
w4l
= 4
4| | 3 20+
w Select Data Files
[ 2003-09-24_11-3028.8d 7| o 4
Sample 1 ‘
Zample 2 i 20 B ah * a i
Sample 3 5
Sample 4
Sample 5 Yiewport 1
g:mg:g ? # IgG non-reduced
Sample 8 ® Ladder
Sample 9
Sample 10
Ladder
Legend | Errors
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9 Select the Gel tab to display a comparison of the gel-like images of the samples.

Gel - IgG non-reduced
w All Comparison Files J Canparisnn Sumnary Electropheragram ]
Elﬁ ComparisonFiled Protei
| 19G non-reduced I35 non-...|I9G nonr...  Ladder Ladder IgGredu... IgGredu... Sample 1
Iga nonreduced H £
| Ladder
I reduced
Sample 1 40 — 40
35 — 35
E S
————— R——————————— 4
25 - :
1| | »
v Select Data Files 20 I E— — 0
[ 2003-09-24_11-30-28.ad 7|
Sample 1 L =5 ‘
Sample 2 e 5 g L L 2 2 1 —_— |
Sample 3
4 3
Sample 4 I | —I
Samp:e = Size [kDa] | Rel. Comc, [ugiml] | Calib, Conc, [ugfml] | % Tokal | Observations | Area
gzmﬁlz? 1 |4 6.0 0.0 0.0 0.0 |Lowser Marker 14,2
sample 8 2 8.5 0.0 0.0 0.0 |Syskem Peak 17.c
Sample 9 3 1687 326.8 0.0 100.0 26.¢
Sample 10 4 ’ 210.0 100.0 0.0 0.0 |Upper Marker 8.
Ladder
| | i
Results | Peak Table | Errors |

Note that the Gel Tab has the same functionality as in the Data context.
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10From the File menu, select Save to save the comparison file (.xac) under the default
name, or select Save As to save it under a new name.

The default name is derived from the method class: “ComparisonFileX
[Method Class].xac” where “X" is an autoincremented number. Example:
“ComparisonFile0 Protein 200.xac”

You need to confirm this action with your electronic signature.

NOTE
You can re-open comparison files to review the comparison results, and to
add/remove samples.
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Result Flagging

NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

Result flagging can be used to assign a user-defined color code to a sample. This lets you
easily identify samples with certain properties immediately after a chip run.

The color assignment is carried out by applying a sequence of rules to the measurement
results obtained for the sample. The rules are defined on chip level and are applied to all
samples of the chip.

Two modes are available to define result flagging rules:

* Form Mode

In this mode, you can easily compose an expression by selecting functions and
operators from given lists. If necessary, additional attributes have to be provided.

By selecting a logical operator (AND/AND NOT/OR/OR NOT), further terms can be
combined to form a more complex expression. The last term of the expression ends
with the operator NONE.

e Editor Mode

This mode is more flexible and allows you to write arbitrary complex expressions by
using functions, variables and operators.
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TIP
You can export result flagging rules and import rules from other method or chip data
files. See “Exporting Result Flagging Rules” on page 323 and “Importing Result

Flagging Rules” on page 311.

Regardless of how you create the result flagging rules, there are two options available for
the order in which the rules are applied:

In Normal mode, the rules are applied in the given order, and the first matching rule will
determine the color of the sample. All rules are applied subsequently. The first rule
which applies to the sample defines its color. So you should start with the most specific
rule. If that one does not apply, a less specific one may apply. If none of the defined rules
apply, the final default rule defines the color code.

In Target mode, all rules are applied subsequently. If the next rule applies, the color code
changes to the color code defined by the rule, otherwise the previous color code is kept.
Therefore, the last matching rule defines the color code of the sample. This mode is
called target mode because later rules refine the result color code. The first default
color code is the most general and the last one the most specific.

You can define the flagging rules already in the method, or—after the chip run is
finished—modify these rules or define new rules in the chip data file, and apply the rules
to the measurement results. Defined rules can also be saved, loaded and applied to other
data files.

Contents A1/6'V Index



TIP

The examples shown in this chapter are taken from the demo method “Demo Protein
200 Plus.xsy”, that comes with the 2700 expert software. You can find this demo
method in the “..\methods\demo\electrophoresis” subdirectory of the 2100 expert
installation folder.

In the “.\data\samples\resultflagging” subdirectory of the 2700 expert installation
folder, you can find further examples for result flagging rules (.xml), which you can
import in the “Protein 200 Plus” demo method.
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Defining Result Flagging Rules

The rules can be defined on the Result Flagging tab. This tab is available in the Data
context if an electrophoretic chip data (.xad.) file is selected and in the Method context if

an electrophoretic method (.xsy) file is selected.

General Properties ] Assay Properties ] Chip Surmary ] Gel ] Electropheragram ] Result Flagging | Log Book]

Rule Indesx Rule Comment: Rule Condition Rule Label |rule Color
1 Ladder 2 found PeakFoundi 93, ABS, 1) ... |"Found Ladder 2"

2 Ladder 3 found PeakFoundi 31, ABS, 1) ...|"Found Ladder 3"

3 Default rule TRLUE "all Other Samples" |

Rule Label Edit | Functions

L

"Found Ladder 2* PeakFound |~ |
PeakConcentration
PeakFoundauto
Rule Condition | Edt  [numberofPeaks
PeakFound{ 93, ABS, 1) =0 Totalarea j
‘ariables Operators
Rule Comment Edit | el + N * /
adder 2 Fourd SampleMarne = E4 = <=
SampleCategory = <> { ]
AMD OR. AMD M., (OR NOT
Rule Calar Edit |
Syntax -
PeakFoundifloat size, enum Windowtype, float Window, [int ChannelID]) =
Description Used to check whether certain sized fragment: is Found or not
It Returns the PeakID of the peak if the fragment was found, otherwise returns 0,
Size s the expected fragment size in bp/nt/kDa
‘Windowtype: can be PER or ABS
PER: User will give the window size as percentage of —
fragment size e.g. +- 10%
ABS:  User will give the window size as absolute unit
of peak size e.g. +/- 10 base pairs {bp)
window defines the window around the "Size" considered
as fragment size
ChannelID : This is default parameter, if not provided default values -
i L E, Ehi, il i bick, b 1 b, L, =l Lo =k
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A result flagging rule consists of the following:
* Label Expression
An optional description for the rule used to label samples meeting this rule.
* If Expression
An expression built from predefined functions, variables, and logical operators.
e Comment
An optional comment for the rule.
e Color Expression

A solid color or a color gradient built from two colors, used for flagging samples that
meet the rule.

“How to Use the Form Mode"” on page 182 shows how to proceed when defining rules.

You can reuse result flagging rule definitions, see “Exporting Result Flagging Rules™ on
page 323 and “Importing Result Flagging Rules” on page 311.
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Color Indication
The results of the result flagging rules is displayed:

* On the Chip Summary Tab:

General Properties ] Assay Properties ] Chip Surmary l Gel ] Electropheragram ] Result Flagging ] Log Book]
Data File : 2100 expert_DMNA 7500_00000_2005-04-27_11-34-48,xad

£

L;' Location Cih L alyzeri2100 expertlSecuredarealDataldsDNAYDNA 7S00YDemo DA 7500

kil

& Created : April 27, 2005 11:34:55

B

E‘ Modified : April 27, 2005 12:54:40

onaA E,ﬂ'.ft"'p Software :  Created by version B.02.01,51209, modified by B.02.01.51209
- File Wersion : 8 {Latest version)
Sample Mame | Sample Comment Rest, Digest | Status Observation Result Label Result Color

1 |PCRMix1 25, 35, 50, 53, 70, ... ol e
2 |PCRMix2 150, 158, 200, Z10.., [l V Found Ladder 2
3 |PCRMix3  [500, S50, 600, 650... [l V Found Ladder 3
4 |PCRMix1 75, 35, 50, 53, 70, ... ol e
5 |PCRMix2 150, 158, 200, Z10.., [l V Found Ladder 2
& |PCRMix3  [500, S50, 600, 650.., [l V Found Ladder 3
7 |PCRMix1 75, 35, 50, 53, 70, ... ol e
& |PCRMix2 150, 158, 200, Z10.., [l V Found Ladder 2
9 |PCRMix3  [500, S50, 600, 650... [l V Found Ladder 3
10 |PCR Mix 1 75, 35, 50, 53, 70, ... ol e

»|PCR Mix 2 150, 158, 200, Z10.., [l V Found Ladder 2
12 [PCRMix3  [500, 550, 600, 650.., [l V Found Ladder 3
[ Chip Lot # | Reagentkitlot# |

223 ] |

Chip Comments :

prepared by laura

Sample Information | Instrument Information | Standard Curve

Irnpork. .. | Expork... |

The colors in the Result Flagging column show which sample matches which rule.
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* On the Gel Tab:

[bp]

10380 —
7000 —

3000 —
1500 —
1000 —

700 —

500 —

300 —

50 —

The spot on top of the lane is colored if the sample matches a result flagging rule.

Ladder PCR... PCR... |PCR...|PCR... PCR... PCR... PCR... PCR... PCR... PCR... PCR... PCR...
» » » »
L 1 z 3 4 5 3] 7 g 9 10 11 1z

e On the small gel image on the Lower Panel:

214 5 & F & 9 101112

Contents

A181V

[bp]

— 10330
— 7000

— 3000
— 1500
— 1000

— 700

— 500

— 300

—50




e 0On the Results tab:

MHumber of peaks found; 10
Fiezult Flagging Color:

Feszult Flagging Label: Found Ladder 3

Result Flagging Color: color of the result flagging rule that the current sample matches.

Result Flagging Label: 1abel of the result flagging rule that the current sample matches.

How to Use the Form Mode

NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

The Form Mode provides some pre-defined rules (forms) that you can use to define the
result flagging rules to color-code your samples. You can set up any number of rules for
evaluation. As a typical example of how these forms are used, you can use the form mode
to flag DNA samples that have a fragment purity of 10% for fragment sizes of 150 bp.
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To do this, proceed as follows:

1 Open the job that contains the results to be analyzed in the Data context and switch to
the Result Flagging tab.

2 Switch to the form mode by clicking the Switch to Form Mode icon ==

3 Choose the Search Fragment with Purity form from the Select Form selection list.

The Search Fragment with Purity form is displayed.

General Properties ] Assay Properties ] Chip Surmary ] Gel ] Electropheragram ] Result Flagging l Log Book]

1. Specify the fragments to search for 3. Specify results

E’ ﬂ The samples that contain the specified fragments

Index | Fragment Size [bp]
1 150 Shall be colored Change...

Fra g m e nt/ Shall be labelled |Sample contains the specified fragments
protein list
2. Specify options All other samples
Purit e TS ok Comtent o o ety erte 10 percent | Shalle coored | Change... |
u rl y For the fragment sizes search within a tolerance of £ |5 percent Shall be labelled |A|| Other Samples
TO I e ra n ce The specified fragment sizes should be treated such that

(+ Al of them must be present

LOgIC operatlon " Any of them can be present

Labels and color
definitions

Help
This Form can be used for searching fragment sizes along with some purity constraints
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4 Define the fragment size(s) to be searched for.
5 Define the required purity for the fragment size(s) and the tolerance.

6 If you defined several fragment sizes and want all of these to be present in the flagged
samples, select the option All of them must be present. If you only require that one of
the sizes is present, select the option Any of them can be present.

7 Select the color with which the samples that meet the criteria should be marked.

8 Optionally select the color with which samples that do not meet the criteria should be
marked.
9 Apply this rule to the samples by clicking the Apply Result Flagging icon ==

All samples are re-evaluated according to the result flagging rule and displayed with the
respective colors. See “Color Indication” on page 180 for more information on the color
codes.

Additional information is available in the Help panel at the bottom of the screen. This
panel provides context-specific help, including examples.

How to Use the Editor Mode

NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

The editor mode for result flagging is a powerful way of creating your own result flagging
rules.
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To define a result flagging rule for a selected job:
1 Open the job in question in the Data context and switch to the Result Flagging tab.

2 Switch to the editor mode by clicking the Switch to Editor Mode icon [l .
3 Edit a rule that was created within the form mode.
—0R—
Create a new rule by clicking the Add icon &3 or Duplicate Selected Rule icon |3.

4 Click the Edit button next to the Rule Label field and enter the result label for this rule.

The result label can be any arbitrary text or be a logic expression. Expressions are built
up of functions, variables, operators, and values. You can manually type in the
expressions. But you can also double-click the items in the Functions, Variables, and
Operators lists, to insert them in the respective fields.

For example, defining the result label as "Number of peaks is" + NumberOfPeaks ()
returns Number of peaks is 10, if the sample contains ten peaks.

Detailed descriptions of the available functions as well as the required syntax and
examples are shown in the Help field at the bottom of the screen.

NOTE
If the entered syntax is not correct, the invalid part is displayed in red color.

5 Click the Edit button next to the Rule Condition field and enter the logic expression for
this rule.
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As an example for a logic expression for the rule condition, enter NumberOfPeaks () >
9 AND PeakFoundAuto (150). With this rule, all samples can be found that have more
than nine peaks while one of them is located at 150 bp +/- 10%.

6 Click the Edit button next to the Rule Comment field and enter a comment for this rule.

7 Click the Edit button next to the Rule Color field and select a color for the rule. If you
check the Gradient check box, you can assign a color gradient to the rule. This allows
to imply further information in the displayed results.

For example, the rule condition NumberOfPeaks () > 0 marks all samples with peaks.
If you want to indicate the actual number of peaks with the color code, you need to
enter NumberOfPeaks () in the Rule Color field. Then you define light green for the
Minimum Value 1 and dark green for 10 peaks as the Maximum Value. As a result, a
darker green will be displayed for samples with more peaks.

8 If necessary, generate additional rules. Rearrange the order of the rules with the Move
Selected Rule Up and Move Selected Rule Down icons.

9 To apply the rules to your measurement results, click the Apply Result Flagging icon 3,
If there still are syntax errors in the rule definitions, an error message appears.

All samples are re-evaluated according to the result flagging rules and displayed with
the respective colors. See “Color Indication” on page 180 for more information on the
color codes.
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Example: Result Flagging

NOTE

The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

Sample 1 contains 100 pg/ml proteins. The electropherogram shows 2 peaks for 2
different proteins, which could be separated. One peak can be found at 32 kDa (LDH).

Sample 2 contains 60 pg/ml proteins and shows 3 peaks.

Sample 3 contains 80 pg/ml proteins and shows 5 peaks.

Now, the following rules are defined:

1. Is there a peak at 30 kDa +/- 7%?

Rule 1: PeakFound (30, PER, 7)

2. Is the total concentration of proteins higher than 90 pg/ml?

Rule 2: TotalConcentration() > 90
3. Were 5 to 10 peaks found?

Rule 3: NumberOfPeaks () >= 5 AND NumberOfPeaks <= 10

Alternative Rule 3: NumberOfPeaks () BETWEEN (5,10)

Rule Index | Rule Comment

Rule Condition

Rule Label

Rule Calar

PeakFoundi{30, PER, 7}

"Any peak at 30 kDa +)- 7 %"

TotalZoncentration() = 90

"Total concentration = 90"

MumberOfPeaks() == 5 AND MumberOfPeaks() <= 10

"Mumber of peaks between 5 and 10"

& e

Default rule

TRUE
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Applying these rules in the given order (in Normal mode) leads to the following results:

Sample Mame | Sample Comment

Use For Calibration

Conc.[pgfml] | Status

Observation Result Label

Result Color

1 |betalc

0

Any peak at 30 kDa +)- 7 %

2 |betala

=

3 |betala

=

@
0] &
0] &

Mumber of peaks between 5 and 10

For sample 1, rule 1 matches and defines the color. Rule 2 would also match, but is not
checked, because the procedure stops at the first match.

For sample 2, none of the rules match, if there is no peak at 30 kDa +/- 7%. Therefore,

this sample will get the default color.

For sample 3, only rule 3 matches and defines the color.
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Running and Evaluating Flow Cytometric Methods

For running and evaluating flow cytometric methods, you need to know the following:
e “Principles of Flow Cytometric Measurements” on page 190

e “Overview of Flow Cytometric Methods" on page 199

e “Preparing and Running a Flow Cytometric Method” on page 202

e “Analyzing and Evaluating the Results of a Flow Cytometric Method” on page 235
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Principles of Flow Cytometric Measurements

Besides electrophoretic methods (DNA, RNA, and proteins), the Agilent 2100 bioanalyzer
supports flow cytometric methods:

* First, cells are stained with two fluorescent dyes that correspond to biologically
relevant parameters, as described in the application notes available for each method.
“Staining Cells” on page 191 explains the principle.

* Next, the stained cells are analyzed on the chip. They pass the detector in single file and
are analyzed individually for their red and blue fluorescence intensities. The results are
displayed as histograms or dot plots. Refer to “Cell Detection with the Agilent 2100
Bioanalyzer” on page 193 for a detailed explanation.
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Staining Cells

With the 2100 expert software, you can differentiate several properties of a cell. The
characteristics that are examined depend on the dye, which binds specifically to a
cellular constituent or is metabolized by the cell to generate a fluorescent product. You
usually use two dyes with different colors. Typically, one of the two dyes is used as
reference dye to select the target cells (living/dead, cell line type, etc.). The second dye
can be used to detect another characteristic of the cell.

Recommended dyes

The tables below list dyes that match to the detection optics specification (Excitation
max: 470 & 630 nm; Emission max: 525 & 680 nm).

The following dyes are recommended for use as the blue stain:

Dye (blue fluorescence) Max. Excitation Max. Emission
wavelength wavelength

Calcein (living cell stain) 493 nm 514 nm

Cell Tracker green (cell tracing, 492 nm 517 nm

viability stain)

GFP (green fluorescent protein) 490 nm 510 nm

SYTO16 (DNA dye) 485 nm 530 nm
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The following dyes are recommended for use as the red stain:

Dye (red fluorescence) Max. Excitation Max. Emission
wavelength wavelength

CBNF (Carboxynaphthofluorescein, 595 nm 675 nm

living cell stain)

APC (Allophycocyanin, intra- and 650 nm 660 nm

extra cellular antibody staining)

Cyb (labeled Streptavidin and 647 nm 665 nm

labeled anti-IgG, Apoptosis,
intra- and extra-cellular antibody
staining)

Alexa 647 650 nm 668 nm
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Cell Detection with the Agilent 2100 Bioanalyzer

LabChip technology allows cell measurements by integrating cell flow, hydrodynamic
focusing, and fluorescence detection into a microfluidic chip. A cell suspension can be
confined or “pinched” to a portion of a microfluidic channel, causing cells to line up in
single file for individual cell detection. The following images illustrate the pinching

process.
Buffer well
Sample well
j Pinching area
Cells 4 II’I I I II ‘ Detector
Cell Buffer

Up to six cell samples can be analyzed on a chip. They are measured sequentially.

Contents A193 YV Index



Measuring Events

The bioanalyzer counts cells stained with fluorescent dyes and measures their
fluorescence intensities. Each cell or bead that passes the detector and emits
fluorescence above a threshold value is counted as an event. For each event, the
intensity of two different fluorescent signals (red and blue) is recorded. The intensity of
the fluorescent signal depends on the amount of stain bound to the cell (and therefore a
specific cell property) and the physical properties of the stain itself.

The Agilent 2100 bioanalyzer lets you determine the number of cells characterized by a
specific pattern of fluorescence.

For example, to differentiate between dead and living cells, you can use a
non-fluorescent dye that becomes fluorescent when metabolized by living cells. After
staining with such a dye, living cells have a higher fluorescence value than dead cells.
The second dye could bind to a specific surface marker on a subpopulation of the cells.
This allows you to determine the number of living cells that contain your marker of
interest.

For evaluation, 2100 expert displays the results as histograms and as dot plots.
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Generating Histograms

2100 expert counts the events, sorts them and displays them according to their
fluorescence intensity in histograms. For each color measured, a histogram displays the
number of events related to the fluorescence intensity. A large number of events with a

high fluorescence value means that a large number of cells containing the fluorescence
dye were detected.

In the following illustration, cells which fluoresce in both colors are highlighted.

As a cell passes through the detector, its blue and red fluorescence values
are measured and the count is increased for both channels at the
appropriate intensity.

Evsnt Count

‘ i llustrates a cell that
fluoresces in blue and

L) Il I. red. The height of the

Intansity Intensity bars is related to the

Histogram View number of cells with this
fluorescence value.
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In the histograms, the bar chart is replaced by a point-to-point line as shown in the

following image.

5:24h fix
Calcain Annexin-Cb
250 - I | 70 I
| | 60 +
200 ‘ ‘
| | 50
£ 150 | | &
5 | | | B 0 ..
o ‘ Fa cein o nnesxi
s “
- | | )
=) [=}
2 100 | | 2
\ \ 20
0 | |
I | | 10
0 i \HHIi ki i I HHHIi L1l |‘L I HHHIi L o 4 N\Iwi—\l muui I Hmni I wi Ll Ii TR
102 1071 100 101 102 10° 102 101 100 1o 10? 10°
Fluorescence Fluorescence

For detailed information, see “Using Histograms for Evaluation” on page 236.
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Generating Dot Plots

Single events can also be displayed related to both fluorescence values, generating a
map of dot plots. In dot plot view, the events (cells with a minimum fluorescence
intensity) are displayed in a coordinate system (logarithmic axis scaling). Each axis
represents a fluorescence color. A high number of events (cells) with similar
fluorescence values are displayed as a dense cluster of dots, as shown in the following
image.

As a cell passes through the detector, its blue
and red fluorescence values are measured.

Red Intensity

Blue Intensity
Dot Plot View

To determine the number of cells whose blue and red fluorescence lies within a defined
range, you can insert regions. Additionally, a gate can be set for either red or blue
fluorescence to obtain percentual values on a defined population.
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In predefined methods, the borders of the rectangular region represent the markers
defined in the corresponding blue and red histograms.

— Gate ——

5 24h fix

fReg\Dn 1

Red Fluorescence

=
|
T T T T T T T T T T T T T 1T

107 10° 10 10 10
Blue Fluorescence

=

The lower left region of a dot plot usually shows no events, due to the defined peak
detection threshold that the fluorescence values must exceed.

For detailed information, see “Using Dot Plots for Evaluation” on page 261.
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Overview of Flow Cytometric Methods

The cell characteristic to be measured requires not only specific dyes. Several
measurement parameters to control the measurement and the data acquisition
parameters also have to be specified. These so-called “setpoints” are stored in method
files (.xsy) and are read by the 2100 expert software before it starts the measurement.

2100 expert supports the following methods based on flow cytometry:

Predefined methods
* Apoptosis
* Apoptosis — fast protocol

For reduced background, this method has an increased threshold and uses blue events
only for peak detection.

 Antibody Staining
e On-chip Antibody Staining
For reduced background, this method has an increased threshold in the blue signal.
* GFP
e On-chip GFP

This method allows a rapid and accurate detection of green fluorescent protein
expression.

e Blue to red

This method is for applications that apply a blue reference dye and analyze red
fluorescent cells within a blue population.
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* Red to blue

This method is for applications that apply a red reference dye and analyze blue
fluorescent cells within a red population.

* Checkout Beads

Red checkout beads are loaded into the wells 1, 3 and 5 and blue checkout beads into
the wells 2, 4 and 6. Markers are set according to expected fluorescence levels of the
red and blue beads. The Checkout Beads method has the properties of a generic
method (see below).

* siRNA Transfection Viability

Transfection Viability analysis as described in the Application Note: siRNA transfection
optimization with the Agilent 2100 bioanalyzer (Agilent publication number:
5988-9782EN). This method enables the automatic calculation of transfection
efficiency (TE) in histogram view and viability in transfected cells (ViT) in dot plot view.
Required gating directions and regions are provided as example, but can be adjusted.
Final Transfection Viability (TV) can be calculated by multiplication TE and ViT values
derived from histograms and dot plots.

The settings of predefined methods are optimized to measure the appropriate cell
characteristics. For evaluation, it is only necessary to adjust the markers in histograms or
regions in dot plots.

Predefined methods contain all necessary markers and regions for evaluation. The gating
direction for histograms is given (for details on the gating direction, refer to “Gating” on
page 238). The markers in all samples are connected (changing a marker changes the
corresponding markers in all samples).
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The regions of the dot plots are related to the markers of the histograms. Thus, the
results of the dot plots are identical to the results of the histograms.

Generic method

This method has no specific settings and can be used to define individual methods. You
can freely add markers or regions, and define the gating direction.

The generic method is recommended for chips with different samples and stainings,
where regions would need to be defined individually. Dot plot and histogram regions are
not linked, making it possible to evaluate an individual sample with different settings.

Flow cytometry method icons

On the Method Properties tab, the following icons are used to visualize the method type:

)
Antibody Staining Apoptosis GFP Generic
Blue to Red Red to Blue Checkout Beads
siRNA Transfection
Viability
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Preparing and Running a Flow Cytometric Method

NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

A flow cytometric chip run requires the following steps:

1.

Switch on the Agilent 2100 bioanalyzer and start the 2100 expert software.
Details are given in “Starting 2100 Expert” on page 35.

. Select a flow cytometric method.

See “Selecting a Flow Cytometric Method for a Chip Run” on page 204.

. Prepare chip and samples.

Refer to “Preparing Samples and Chips for Flow Cytometric Methods” on page 208 and
to the appropriate Application Note and Reagent Kit Guide.

. Load the chip into the bioanalyzer.

For details refer to “Loading the Cell Chip into the Bioanalyzer” on page 212.

. Start the chip run.

This is described in “Running a Flow Cytometric Method” on page 219.
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When the chip run has finished, you can:

* Have a first look at the results (see “Displaying the Measurement Results (Flow
Cytometry)” on page 229).

* Document the chip run (see “Entering Chip and Sample Information” on page 226).
* Analyze and evaluate the results:

— “Using Histograms for Evaluation” on page 236

— “Using Dot Plots for Evaluation” on page 261

— “Evaluating Antibody Staining, Apoptosis, and GFP Methods” on page 272
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Selecting a Flow Cytometric Method for a Chip Run

NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

To select a method:
1 Switch to the Instrument context.

2 Inthe Tree View Panel, select the bioanalyzer you want to use.

& All Instruments
.............. g}l Instrument 1

______________ * miEm

In the upper left of the Instrument tab, an icon shows the status of the bioanalyzer. You
should see one of the following icons (lid open/closed), indicating that the bioanalyzer
is detected by the system:
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3 If you do not see one of these icons, check that the bioanalyzer is switched on and
properly connected:

— Check the COM port setting.

— Make sure the bioanalyzer is physically connected to the PC (over the serial
interface).

— Check the power connection.

— Check the power switch.

If you need additional help, please refer to the Agilent 2100 Bioanalyzer Maintenance
and Troubleshooting Guide.

4 Select a method for the chip run.
On the Instrument tab, click the Method button.

—0OR=-
Click the Methods menu.
Both will open the Methods menu, allowing you to select a method from the submenus.

Note that you can also select File > Open File to Run. This opens a dialog box, allowing
you to load either a method (.xsy) or a chip data file (.xad).

The type of method you have to select depends on the experiment and the staining
protocol you use to prepare your cell samples. Details on these methods are described
in the Application Notes available for each method.
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5 Select the desired method, for example, Apoptosis.
The method is loaded and its name appears on the Information Bar:

DE11/700058 - APOPTOSIS

NOTE
After a chip run, the results can be evaluated using a different flow cytometric chip
data or method file. Refer to “Importing Data Analysis Setpoints” on page 308.

NOTE

The chip data file (.xad) that will be generated as the result of the chip run will be stored
to the indicated Destination folder. This Destination folder can be configured by an 2100
adminstrator in the System context.
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6 Specify an appropriate File Prefix for this file.

[+

() Custanm

2100 expert

L1atE AEQUISILIOn Harareters

[Fite ] 6 =

() Default
. Fived time
) Wumber of Cells
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Preparing Samples and Chips for Flow Cytometric Methods

WARNING

Several substances such as dyes can have toxic, carcinogenic, or mutagenic
potential. Therefore, carefully follow the safety instructions from the dye safety data
sheet and the Reagent Kit Guides. Also read the “Essential Measurement Practices
(Flow Cytometric Methods)” on page 210.

Before you can fill a chip, you have to prepare the samples. To find out which protocols
you should use to prepare the samples, refer to the various Application Notes available
for each method.

Sample and chip preparation is described in detail in the Reagent Kit Guide available for
each LabChip kit.
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Chip Reagents

Several reagents have to be added to the chip to prepare it for measurement. The
following image shows which reagents have to be filled in which wells.

Priming solution

Cell buffer SN s
Sample 1-6 : ’:‘
Cell buffer A i

Focusing dye
solution

Make sure you follow these directions when preparing the sample:

The priming solution has to be added first. It fills all channels (removes all air from the
micro channels).

The focusing dye is used to adjust the optic. The optics are focused horizontally and
vertically before each chip is measured.

If you do not use all six wells, always load the first sample in well 1, the second sample
in well 2 etc. Unused wells have to be filled with cell buffer solution, otherwise they may
run dry during the chip run. Because all channels are connected to the priming well, this
may led to bubbles and to a clogging of the pressure adapter filter.

The cell buffer is used to focus the cells before they pass the detection point. You have
to fill both buffer wells with cell buffer.
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Essential Measurement Practices (Flow Cytometric Methods)

Handle and store all reagents according to the instructions given in the Reagent Kit
Guides.

Avoid sources of dust or other contaminants. Foreign matter in reagents and samples
or in the wells of the chip will interfere with method results.

Store all reagent and reagent mixes in the dark and refrigerated at 4 °C when not in use.
Allow all reagents to equilibrate to room temperature for 30 minutes before use.
Protect focusing dye from light. The dye decomposes when exposed to light.

Use appropriate pipette tips. For each pipetting step use a fresh, new pipette tip.

Always insert the pipette tip to the bottom of the well when dispensing the liquid.
Placing the pipette at the edge of the well may lead to poor results due to the formation
of a bubble on the bottom of the well.

X

For chip preparation, use inverse pipetting.

When filling the pipette tip, push slightly over the first resistance. Empty the pipette tip
only to the first resistance. This procedure avoids the introduction of bubbles and
ensures pipetting the right volume.

Never leave any wells empty, or the pressure adapter may become clogged. Pipette
10 pl of cell buffer or sample replicate in any empty sample well.
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Before bead preparation, vortex bead vials for 15 seconds.

Prepared chips must be used within 5 minutes. If a chip is not run within 5 minutes,
beads may settle or reagents may evaporate, leading to poor results.

Never touch the instrument lens.

Never touch the Agilent 2100 bioanalyzer during a chip run and never place it on a
vibrating ground.
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Loading the Cell Chip into the Bioanalyzer

The Agilent 2100 bioanalyzer uses different cartridges for electrophoretic and flow
cytometric methods. For flow cytometric measurements, the pressure cartridge is
required.

The pressure cartridge contains a tubing and filter assembly that connect to the vacuum
pump. The seal has to match the priming well on the chip so that the required low
pressure can be built up. The pressure cartridge can be identified by the engraved
number “2” on the front.

NOTE
Any cartridges without engraved numbers are electrode cartridges.
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If the bioanalyzer is set up for electrophoretic methods, but you want to run flow
cytometric methods, proceed as follows:

1 Open the lid and pull down the metal locking lever in the open position as shown in the
following figure.

Do not touch the electrodes while the cartridge is in the Agilent 2100 bioanalyzer. The
electrodes and the high voltage power supplies can be damaged.

Metal lever
in open = \-\(!-\
position

(Al

The cartridge is pushed out.
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2 Gently pull the cartridge out of the lid.

Improper handling of the electrode cartridge will damage it.

Always store the electrode cartridge in the provided box. If the pins of the electrode
cartridge are bent or misaligned, poor quality results or pre-terminated chip runs will
result.

3 Slide the pressure cartridge in the lid as shown in the following figure.

Push here to ensure
tight connection

Metal lever

4 Push the metal front of the cartridge until it is securely in place.

5 Push the metal locking lever in the flat (closed) position.
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To load the prepared chip into the Agilent 2100 bioanalyzer:
1 Open the lid and remove any chip.

2 Adjust the chip selector to position “2” as shown in the following figure.

To avoid using
incompatible chips and
cartridges, a chip selector
Is installed in the
bioanalyzer. This ensures
that the chip matches to
the installed cartridge.

Move chip
selector in
position “2”

This will allow you to insert cell chips in the bioanalyzer.
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Do not force the chip selector handle when a chip is inserted in the bioanalyzer.

3 Place the prepared chip into the receptacle.
The chip fits only one way. Do not use force.

Cell chip

Chip selector
in position “2"
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4 Carefully close the lid.

Do not force the lid closed. This can damage the pressure cartridge. If the lid does not
close without force, check that chip is inserted correctly and that the chip selector is
at the correct position for this chip type.

When the software recognizes an inserted chip, the chip is shown on the Instrument
tab. If you have closed the lid, and the software has not recognized the chip, verify that
the cartridge and chip are inserted properly and the chip selector is in the correct
position. Close the lid.

The adapter with the gasket in the cartridge fits onto the priming well of the chip. A
small gap between the lid and the instrument mainframe is normal and no cause for
malfunction. The icon on the Instrument tab changes to a cell chip icon:

-~
=

0080
‘0000

OH
[]
O

o

If the chip is not detected, open and close the lid again.
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NOTE
If the AutoRun option is active, the chip run starts automatically once a chip has been
inserted and the lid has been closed.
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Running a Flow Cytometric Method

Running a flow cytometric method in 2100 expert just means pressing a button.

NOTE
You can stop a chip run at any time, for example, if errors occurred, or if you are not

satisfied with the quality of the measurement results, which you can observe during
the chip run. See “Stopping a Chip Run” on page 224.

NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who

are logged in with certain roles. See “User Role Model” on page 52 for details.

Starting the Chip Run

When you have loaded the chip, you can start the chip run:
1 On the Instrument tab, click the Start button.

() start
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2 To start the chip run you need to confirm this action with your electronic signature
which will be recorded in the audit trail and the signature log.

Electronic Signature

List of changes:

Description

nm Starting run in the instrument contexd

Meaning: Started Chip Run j
Comment:
Apopkosis
—Signature
LUser: M. Advanced as Advanced Operator
User v Jadvaoper
Password: |********|
Domairn: IPC_MM_SK j

OF I Cancel Help
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The chip run starts. The Dot Plot sub-tab shows single events (cells) as they are
detected, displayed as dots. In the coordinate system, the red and blue fluorescence
intensity of each event can be read. The name of the currently measured sample is
displayed above the graph.

mixture
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Fed Fluorescence
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iy

)
]
1

1|:|-I_

102 1 T I I 1 TR R ] 1 |||||:||| L 1 I.Illlli 1 T AN 1 1 |||:|||

I
102 10! 100 10! 102 103 10+
Blue Fluorescence
Total Events : 1036 % of gated : 52.2

Chip Setup | Dok Plok
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The number of the sample that is currently being measured is indicated on the
information bar:

£ Funning

The status bar at the bottom of the screen shows the measurement progress for the chip
run and the COM port number used for data acquisition.

During the chip run, you can do the following:
 View the chip data file in the Data context by clicking on the name of the Data File:

Method Selection: E Methiods

Start/Stop Run: @ Stop

Method: i ls\Apoptosis (Demo), sy

Data File: Cih.,, 2005-04-27 13-40-03,xad

 Evaluate any chip data file in the Data context.
* Compare samples in the Comparison context.

* If necessary, abort the chip run by clicking on the Stop button (see also “Stopping a Chip
Run” on page 224). You need to confirm this action with your electronic signature.

All data that was collected up to the stop point will be saved.
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After the chip run is completed, you can:

« Switch to the Data context, where you can view, analyze, and evaluate the results of
your chip run (see “Displaying the Measurement Results (Flow Cytometry)” on
page 229 and “Analyzing and Evaluating the Results of a Flow Cytometric Method” on
page 235).

« Stay in the Instrument context, where you can start a new chip run, for example.
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Stopping a Chip Run
You can stop a chip run at any time, for example,
« if the quality of the measurement results does not meet your expectations,

« if, for example, after three samples you already have the information you desired and
you want to start another chip run.

NOTE
You cannot resume a stopped chip run.

NOTE
If you stop a chip run, automatic export (see “Exporting Chip Run Data Automatically”
on page 317) does not take place.

To stop the method:
1 Click the Stop button.

@ Stop

—0R-

Select Stop from the Instrument menu.

NOTE
Data acquisition of the current sample will be aborted.
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You need to confirm this action with your electronic signature.
When the chip run is aborted, you can:

« Switch to the Data context, where you can view, analyze, and evaluate the results (if
any) of your chip run (see “Displaying the Measurement Results (Flow Cytometry)” on

page 229 and “Analyzing and Evaluating the Results of a Flow Cytometric Method” on
page 235).

« Stay in the Instrument context, where you can start the next chip run, for example.
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Entering Chip and Sample Information

NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

During or after a chip run, you can document the run by entering information on chip and
samples.

1 In the Data context, select the Chip Summary tab.

2 0n the Sample Information sub-tab, you can enter additional information for samples,
such as names for blue and red stain.
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& Chip Summary
" FileMame : 2100 expert_APOPTOSIS_00000_2003-08-01_15-27-23.xad

[ e 6 B
-4 O Location :  C:\Program Fileshagilent',2 100 Bioanalyzer2 100xpertidatal2003-05-01
23
= 0@ ] Created !  Friday, August 01, 2003 6:27:27 PM
«O@® O,  Modfied: ‘Wednesday, August 08, 2003 10:44:05 AM
6
Software © Created by wersion B.01.00,.31052, modified by A,00.00,31000
Sample Marne Sample Comment EBlue Staining | Red Skaining | Skatus | Taotal Events | 94 of Gated Ohservation
1 |contraol Fisc Calcein Annexin-CYS ¥ 1211 1.3
2 |1:24hfix Calcein Annexin-CYs | 1714 41,1
3 |[2:24hfix 12-2088-0 Calcein Annexin-CYS ¥ 1702 46
i [324h fix 3 Calcein Annexin-CYS | X 1614 44,9
g |4:24hfix Zalcein Annexin-CYS
6 |5:24h fix Calcein Annexin-CYS
Chip Lat # Reagent Kit Lok #
12 2556
Chip Comments
prepared by Ellen
Sample Information | Skudy Information Instrument Information

NOTE
You may find some input fields already filled in, because chip, sample, and study
information are taken over from the base method or chip data file.
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3 From the File menu, select Save.

TIP

You can import chip, sample, and study information from .txt or .csv files. This is
especially helpful and time-saving, if you already have documented a similar chip run
in another chip data file. Refer to “Importing Chip and Sample Information” on

page 310 for details.
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Displaying the Measurement Results (Flow Cytometry)

NOTE

The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

You can view the measurement results of a flow cytometric chip run as histograms or dot
plots.

* You can display the histograms/dot plots either one sample at a time, or all samples at
the same time to get an overview of the chip run, for example, to see the progress of a
reaction. See “How to Switch Between Single View and Grid View” on page 230.

* You can navigate through the samples. See “How to Navigate Through the Samples” on
page 231.

* You can change the display of histograms and dot plots to make details better visible.
See “How to Change the Display of Histograms and Dot Plots” on page 232.
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How to Switch Between Single View and Grid View

To switch between single view and grid view:
1 From the Histogram or Dot Plot menu, select Single View or Grid View.

—0OR=-
Click the Single View = or Grid View & button on the histogram/dot plot toolbar.
—0OR-

Click the All Samples entry in the Tree View Panel to switch to the grid view, or any
sample to switch to the single view.

—0OR=-
Double-click any histogram or dot plot in the grid view to switch to single view.

The following example shows switching between grid view and single view for
histograms.

| Hstogram | Histogram
control fix 1:24h fix Z:24h fi
Calcein Amnexin-CYS Caleein AnnexinCY5 Calcein Annexin-CY5
@ o —_— —
BIOE E;z E 2:24h fix Calcein
@ i A 120-F
5 50 5 554 60
B Te feum g B T o 100
A 10910 10+ 2 E a0t
Fluoresc ence Fluorescence S mf . 2
Total events : 1211 of gate: < of gated : 41.1 i alcain [
2:24h fix 3:24h fix 5 B0-£ D f
Calei Amnexin-CYS Cal AnnexinCY5 = E =]
= nf s L
|2 75 0L
R i 0L
5 o5t £
ls S in o g e e
e e 10% 102 0= 4o @ 10 110
Fluorescence Fluorescence
of gate: nts : | Marker [ tin [ Max | #Events | Marker Min Max #Events
4:24h fix 5:24h fix b & |alEvents | 00t 738 1702| | »! 006 74266 1702
Caloein Annexin-CYs Calcein Annexin-CYs | @ |calcein on all everts| 688 298,01 930 0ps| 74266 930/
2199 3438.99 27,
2199 3438.93 428
%o of gated : 44.5 < QKN |
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How to Navigate Through the Samples

At any time—even during a chip run—you can scroll though all samples—either in
histogram or dot plot view.
To navigate through samples using the Tree View Panel.
1 If the tree view is not visible, select View > Tree View.
The Tree View Panel appears to the left of the tabs, and shows all chip data and method
files as nodes.
2 Click any sample name.
The histogram or dot plot of the sample is shown in single view.

To navigate through samples using the Lower Panel:
1 If the lower panel is not visible, select View > Lower panel.
The lower panel appears in the lower left corner, showing a chip icon.

2 Click any well on the chip icon.

To browse through samples:

1 From the Histogram or Dot Plot menu, select Next Sample or Previous Sample.
—0OR=-
Click the Next Sample & or Previous Sample & button in the histogram/dot plot
toolbar.

To switch between histogram and dot plot view:

1 Click the Histogram or Dot Plot tab to display the results of the selected sample as a
histogram or dot plot.
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How to Change the Display of Histograms and Dot Plots

In single view, it is possible to change the display of histograms and dot plots.

In histograms and dot plots you can:
« zoom (enlarge or reduce using the mouse) the graphs to display details, for example.

 put a color gradient on the background of the graphs.
In histograms, you can additionally:

* show data points.
To zoom into a histogram or dot plot:
1 Position the mouse pointer in the histogram/dot plot.

2 Click and hold down the left mouse button.
The mouse pointer changes its shape to a magnifying glass = :

3 Drag the mouse.
A rectangle shows the part of the histogram/dot plot to be enlarged.

4 Release the mouse button.
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You can perform several zoom steps in a row. When you have zoomed a histogram or dot
plot, the Undo Zoom and Undo All buttons are enabled.

To undo one zoom step:

1 Click the Undo Zoom #~ button or double-click in the histogram or dot plot.

To undo all zoom steps:

1 Click the Undo Zoom All "= button.
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To display data points in histograms:
1 From the Histogram menu, select Show Data Points.
All events are shown as bullets.

To put a color gradient on the background of a histogram or dot plot:
1 From the Histogram or Dot Plot menu, select Gradient.

—0OR=-

Click the Gradient %~ button the histogram or dot plot toolbar.

A color gradient (gray to white) appears on the background of the graph.

Annexin-C¥s

1:24h fix Calcein

Annexin

Mo, of Events
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Analyzing and Evaluating the Results of a Flow Cytometric Method

You can analyze and evaluate result data of flow cytometric methods using either the dot
plot or the histogram view. In both views, you can evaluate the detected cells by defining
areas of interest.

 Histograms show the distribution of events related to the red and blue fluorescence
intensity. Gating is used to generate subsets based on markers in one histogram. See
“Using Histograms for Evaluation” on page 236 for detailed information.

* Dot plots show events as dots in a coordinate system where the blue fluorescence
value is related to the red. Regions and gates are used to determine the number of cells
with a fluorescence intensity lying in a defined range. See “Using Dot Plots for
Evaluation” on page 261 for detailed information.

If you use predefined methods, the markers and regions are set at the approximate
position where the events are expected. Refer to “Evaluating Antibody Staining,
Apoptosis, and GFP Methods” on page 272 for information on how to evaluate the
predefined methods.

TIP
You can analyze and evaluate results while a chip run is still in progress.

NOTE

The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.
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Using Histograms for Evaluation

Histograms are graphical representations of the measurement results, where the number
of events (cells) is mapped to the Y axis and their fluorescence values to the X axis. The
resulting curves show the frequency distribution of the events in relation to their
fluorescence intensity values, as shown in the following image. In real histograms, the
bin is reduced to a dot (data point).

100 |

2

Evant Count
B8 i

50 cells were detected with a

fluorescence intensity between
30 and 40

[ | I |11 AR
10 3040 100 1000

Fluorescence Intensity

The histograms can be evaluated statistically with markers that allow you to define
ranges of fluorescence intensity values. One histogram can be used to represent a range
of fluorescence values to define a subset of events. Only cells with a fluorescence value
within this range are displayed in the second histogram. This method is called gating.
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Markers

Markers are used to define a range of fluorescence intensity values in a histogram. The

upper and lower limits of the range are displayed as vertical lines, as shown in the
following image.

| Lower limit of the marker

Upper limit of the marker

Event Count

Events (cells) of interest

Low intensity

Intensity

The numerical values for each defined marker are displayed in a separate row in the

result table. One marker is used as a gate for the second histogram, to define a subset of
events.

In predefined methods, the markers are set by default and you only need to adjust their
position. If you want to define your own methods, select the Generic method for
acquisition, where you can define your own markers and/or regions together with gates.

If you use several markers within one histogram, only one of them can be used for gating.
The other markers can only be used to evaluate regions in the histogram they cover. The
values belonging to these markers are also displayed in the result table.
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Gating

Gating is used to restrict the number of events that are evaluated by gating out (filtering)
events that do not have the fluorescence values set by a marker. For example, by gating
on a blue marker, you can exclude all events with low blue fluorescence (allowing you, for
example, to gate out dead cells, unbound dye and debris). Only events with blue
fluorescence values within the marker range are evaluated. Thereby, you can exclude any
dead cells, and evaluate only the living cells for another property.

The gating direction defines the reference histogram:

 Gating from blue to red uses the blue histogram to define the subset by a marker
(Apoptosis and Antibody Staining methods).

2:24h fix
Calcein Annexin-CY5

=
T 7+
C B+
151 o
£ r —
o o F
o B Calcein o 4_5
5 104 5 F
s [ g3t
s 2
1£
= J.I.lllI'_LLLLIHli nF

0= 10 10 100 10* 10 10t LW L VW | WA [ S | RN i

Fluarescence Fluarescence
IMarker 14in Tax #E IMarker 14in Tax #Ev
® |all Events 001 55.43 p| ® |Gated by Calcein 0.2z 433,09
b | @ Calcein on all events 6,88 233,01 @ |Annexin on subset 21.99 3438.99
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 Gating from red to blue uses the red histogram to define the subset by a marker
(GFP method).

cample 6
GFP CBNF
18-F -
c B
161 r
14F 0t
g2 EF
1k} - 1k} L
i 10F il on-F CENF
5 _F 5 F
2 51 25T
B+ C
- 10+
4 -
2 =
o+ 0+ Ly
102 0t 10* ot o1t 10 1ot 102 0t 10* ot o1t 10 1ot
Fluorescence Fluorescence
Marker Min M #Event Marker Min M #Ew
p| ® |Gated by CEMF 0.01 272,99 = @ Al Events 0.02 409,07
@ |GFP on subset 1.26 851.03 Z| »| ® (CBNF on all events 1.70 2369,50
NOTE

Predefined methods have a fixed gating direction, while methods of type Generic have
a variable gating direction.
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The following figures illustrate gating from blue to red.

The two histograms display all measured events in the blue histogram and in the red
histogram without gating. In this case, you cannot see which cells fluoresce only in the
blue and which fluoresce only in the red.

A A
t IS
= =
o o .
o ot Y All events that show
= L
¢ , @ red fluorescence
(L - D
All events that show
blue fluorescence

Intensity Intensity
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By setting a marker on the blue histogram, you can define the blue fluorescence range
that must be met for a cell to be considered for the red histogram. You use the gating on
the blue histogram to define a subset for the red histogram.

A A

Subset of the events,
defined by the marker

Event Count
Event Count

l

Events of the subset that
show also red fluorescence

Intensity
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The red histogram displays now only cells with blue and red fluorescence within the
marker. To evaluate this subset, you can set a marker in the red histogram. This second
marker filters out all cells that do not have fluorescence in this range.

A |
= ! R
3 3 Events with high blue
o o
= = fluorescence
g g
| |
Events that show both high
blue and high red
| fluorescence
Intensity " Intensity -

The result table (see also “Displaying the Results of Histogram Evaluations” on page 257)
of the gated histogram (here the red one) shows the values numerically:

* The % total value shows the number of events that have both high blue and high red
fluorescence, in relation to all measured events.

* The % of gated value shows the number of events that have high blue and high red
fluorescence in relation to the blue (or red) events.
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The following image shows two histograms with a gating direction from blue to red (left
to right) of an apoptosis method. The blue histogram shows calcein fluorescence, which
indicates living or dead cells (high fluorescence value means living cells). The red
histogram shows the subpopulation of living cells with annexin V fluorescence indicating
apoptosis (high fluorescence value means the cell is apoptotic). As a result you can see a
subset of living, apoptotic cells.
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Number of e | - | |
events . f I I
100 a0 f | |
Marker o f ; o k I I
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Histogram |. T - I I
= 50 + = 45 L
[ F | |
0t | |
25 r | |
5 L |
Fluorescence 1 J : |
o LI.I.I'_I_I_LLLI.IJi J-LU-U'_LLLUJJ-U o
value 107 1ot 108 10t 102 109 102 10t 400 100 102 108
Fluorescence Fluorescence
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How to Insert a Marker in a Histogram

A marker is shown as two vertical lines that define a region of fluorescence values. It is
used to select a subset of events according to this fluorescence region.

NOTE
You can insert markers only in generic methods.

NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

To add a new marker:
1 In the toolbar of the Histogram tab, click the Insert Marker button N
A marker is added to the selected histogram window.
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To insert an existing marker:

1 Click the Insert Existing Marker button lil to open the Insert Existing Markers window.

Insert Existing Markers x|

Exisking Markers

Properties
Marker 2 Lawwer: 0.1
Upper: 1000

2 Select a marker in the list and click /Insert Marker.
The marker lines are added at the defined positions. The label identifies the marker.
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You can remove markers that you do not need any more:
1 Click one of the vertical lines in the histogram to select the marker.
The lines of the selected marker are displayed bold.
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Fluorescence

TIP
You can also click the corresponding row in the result table to select the marker.

2 Click the Delete Marker button H to remove the marker.
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How to Configure Markers

NOTE

The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

You can change the color, name, and the upper and lower limits of the marker:

1 Double-click the desired marker.

—0OR-

Right-click the corresponding row in the result table and select Configure Marker from

the context menu.

—0R-

Select the marker and click the Configure Marker button

“ in the toolbar.

The Configure Marker dialog box appears.

Configure Marker

Name I.ﬂ.nnexin

Lower Walue @ 20,34 L »=001)
Upper Value : 343,99 (<= 10000}

Calor - _I
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2 Entera name for the marker, for example, the used dye (it is advisable to use names that
identify the marker).

3 Enter a Lower Value (left vertical line).

4 Enter an Upper Value (right vertical line).

NOTE
The lower and upper values must be within the range of 0.01 — 10000 relative
fluorescence units.

5 Click the Color button o to open the Color dialog box and select a color.
6 Click OK.
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How to Move the Upper and Lower Limits of Markers

NOTE

The 2100 expert Security Pack restricts access to data and functionality to users who

are logged in with certain roles. See “User Role Model” on page 52 for details.

You can change the position of both marker lines by dragging them with the mouse:

1 Position the mouse pointer on a marker line.
The mouse pointer changes its shape to a hand.

2 Drag the line to the desired position.

Annexin-Cv'h

Annexing
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Fluorescence

3 Release the mouse button.

4 Repeat these steps for the other marker line, if necessary.
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NOTE
You can change the marker limits also by entering fluorescence values in the Configure
Marker dialog box (see “How to Configure Markers” on page 247).

How to Copy Markers to All Histograms

NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

Once a marker is defined, you can copy it in the histograms of all samples (generic
methods only):

1 Select the marker in the histogram or in the result table.
The Insert the selected marker into all histograms button = is now enabled.

2 Click this button.
The Copy Marker dialog box appears. This dialog box asks you whether or not you want
to use the marker as reference.

3 Click Yes to use this marker as reference. The marker will be inserted in all other
histograms of the blue or red channel. When the properties of this marker are changed,
the changes will be applied to all samples.

—0OR-
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Click No. The marker will be inserted in all other histograms of the blue or red channel.
When the properties of this marker are changed, the changes are only applied to the
current sample.

How to Set the Gating Direction (Generic method only)

You can use one marker to define the gating direction. In other words, you define whether
red or blue fluorescence is used as a gate to define a subset in the other histogram. This
also depends on the dyes that you have used for staining.

You can set both gating directions: either from the blue histogram to the red histogram or
from red to blue.

NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

To set the gating direction:

1 Select the marker in the red or blue histogram you want to use as a gate for the other
histogram.

The corresponding gating button in the toolbar is now enabled.

2 Click & or % to set the gating direction.

—0R-

Right-click the marker in the histogram or in the result table, and select Gate in
Red/Blue histogram from the context menu.
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The gating direction is displayed in the Information Bar.
If the gating direction is already set, you first have to remove the existing gating.

To remove gating:
1 Click the Remove Gate button #= .
The gating is removed and the corresponding gating button is enabled.

NOTE

To change the gating direction in non-generic methods, you first have to change the
method to generic. To achieve this, use the Import Setpoints button on the Method
Properties tab (refer to “Importing Data” on page 305).

How to Overlay Histograms

You can compare samples by overlaying their gated histograms. This is useful, for
example, if you want to see the progress of a reaction or if one sample is used as
reference.

Overlaying histograms might also be helpful for adjusting the marker position. You can
overlay all measured samples. Both red and blue histograms are overlaid.

NOTE

You can configure the colors of the overlaid histograms and adjust the scale
graduation as described in “How to Set Signal Colors for Overlaid Histograms™ on
page 255.
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NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

To overlay histograms:
1 Select the main sample and display the Histogram tab.

2 Click the Overlaid Samples ©*"&93ameles. b tton to open a drop-down list.

3 Click the sample that you want to use as overlay.

The histogram curve of the selected sample appears in the histogram view, the
corresponding entry in the drop-down list is marked with a check, and a color legend
appears above the graph.

4 Repeat steps 2 and 3 to overlay further histograms.
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To overlay all samples:
1 Click the Overlaid Samples ©'&"@93ameks. tton to open a drop-down list.

2 Select All Samples to overlay the histogram curves of all samples.

To remove histograms from the overlay:
1 Select the sample that contains the overlaid histograms.

2 Click the Overlaid Sample button ©*®'@433meks +5 open the drop-down list.

3 Click the sample that you want to be removed.
—0OR-

Click No Overlay to remove all overlaid curves from the histogram.
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How to Set Signal Colors for Overlaid Histograms

NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

You can use the Graph Settings tab in the Options dialog box to configure the signal
colors (colors of curves in histograms):

1 Select Tools > Options.
2 Click the Graph Settings tab to bring it to the front.

Data Files I Chip Alert ]g ] Adwanced ]

Signal Color

Signal 1 - Signal 5 I— Signal 9 I—
signal 2 [ Signale | Signal 10 [
signalz [T Signal 7 [ signal 11 |
Signal + [ signals | Signal12 [

QF I Cancel Help
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To configure the signal color:
1 Click the colored square corresponding to the signal.
The Color dialog box appears.

2 Select a color for the signal and assign it by clicking OK.
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Displaying the Results of Histogram Evaluations

The calculated results are displayed in result tables, one table below each histogram.
Markers, gates, several statistical values, and the %-values of events are shown in the
result tables.

Marker rin Max | #Evenks | %%:Total |3 of gated |Mean |StdDew | CW9% |GMean

b| ® Al Events 0.0z 51.42 1606 100 - 8.07 F.13183.37 4.51
® |Gaked by Calcein 0.04 51.42 1415 88.30 -l 8.46| 7328647 4.72

® |CD3-APC on all events| 1,18 4035.38 1356 g4.40 -l 948 6.89 7275 .27

@ |CD3-APC on subset 1.15 | 40585.55 1195 74,40 94,30 9,96 7027044 F.73

Each marker you insert in the histogram gets its own row. Note that you can only use one
marker for gating. The additional markers can be used to evaluate different parts of the
histogram statistically.

If the option Hide superset curve is disabled in the setpoint explorer, two additional rows
are displayed in the gated histogram'’s result table. The superset curve shows a
histogram of all measured events; the gate is not considered.

You can export the table data for further evaluation in other applications. See “Exporting
Data” on page 312.

NOTE
The layout of the result table can be configured (see “Configuring Tables” on
page 329). Not all of the values listed below may therefore be visible.
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NOTE

The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

The content of the result tables depends on the gating direction. The histogram that is
used for gating can display the following results:

Marker

Min
Max
Events
% total

% of gated

Mean
StdDev

Contents

All events — this row shows the data for all measured events, for
example, for all living and dead cells.

The following rows show the data for the subset of cells defined by
the inserted marker. If you use a predefined method, the entry can be
“Calcein on all events”, for example.

Minimum fluorescence value of the corresponding marker.
Maximum fluorescence value of the corresponding marker.

Number of events covered by the marker. For the histogram you use
for gating, the number of all detected events is displayed in the row
“All Events”.

% of selected events in relation to the total number of events. The
row “All Events” shows 100%.

% of events covered by the marker in the gated histogram. Shows no
value for the gating histogram.

Mean fluorescence value of the events inside the marker.

Standard deviation to the mean value.
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%CV
GMean

Coefficient of variation.

Geometric mean.

The histogram that displays the gated data can show the following data:

Marker

Min
Max

Events

% total

% of gated

Mean
StdDev

Contents

All events — this row shows the data for all events that pass the gate.

The following rows show the data for all events covered by the
inserted marker. If you use a predefined method, the entry can be
“Annexin V on subset”, for example.

Minimum fluorescence value of the corresponding marker.
Maximum fluorescence value of the corresponding marker.

Number of events covered by the marker. For the histogram you use
for gating, the number of all detected events is displayed in the row
“All events”.

% of selected events in relation to the total number of events. The
marker used for gating is 100%, the table of the gated histogram
shows the value of the subset.

% of the gated events in relation to the total number of events. These
are the events that have passed the gate and are covered by the
marker of the histogram, for example, by annexin V.

Mean fluorescence value of the events inside the marker

Standard deviation to the mean value.
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%»CV Coefficient of variation.

GMean Geometric mean.
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Using Dot Plots for Evaluation

On the Dot Plot tab, cells are displayed as dots, where their red fluorescence intensity is
mapped on the Y axis and their blue fluorescence intensity is mapped on the X axis.

NOTE

The lower left region of the dot plot area may show no events, because of the
threshold for event detection. Dots are only displayed if their fluorescence intensity
exceeds a minimum limit. The limits are specified in the method—separately for red
and blue fluorescence.

To evaluate the dot plots, you can add regions. Regions are rectangles that can be
changed in size and position until they include a specific event subset. As a result you get
the number of cells included in the region related to the total number of cells.

NOTE
You can add/remove regions and gates only in Generic methods.

Additionally, you can insert a horizontal or a vertical gate for one region. This is useful for
counting all cells that have fluorescence intensities within the horizontal or vertical
borders of the region. In predefined methods, the vertical side of a region corresponds to
the marker of the blue histogram, the horizontal side to the red one (see “Using
Histograms for Evaluation” on page 236). The gate is always displayed and corresponds
to the range of the marker that is used for gating. If you move a marker in a histogram, the
region and gate are automatically updated. If you change a region or gate, the marker is
also updated. Statistics are displayed in the result table below the dot plot.
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How to Add Regions to Dot Plots (Generic Method only)

You can draw regions in dot plots of generic methods. If there are regions already defined
in other samples, you can copy these regions in the dot plot of the current sample.

NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

To draw a new region:
1 Click the Insert Region button & in the toolbar.
The mouse pointer changes its shape to a crosshair.

2 Draw a rectangle into the dot plot.

New regions are automatically named “Region x”, where x is an auto-incremented
number. By default, the border color of new regions is black. To make it easier to
differentiate between regions, you can change their border color (see “How to Configure
Regions™ on page 265).
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To insert an existing region:

1 Selectthe sample where you want to insert an existing region from another sample and
click Insert existing region

The Insert Region dialog box appears.
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Insert Existing Region x|

Existing Regions

|R8Eion 2 Properties
Height: 44,92873
wyidth: 1,293795
pperLeftPoint:
Hr 0,797 263400030995
¥ 45.01599355161351
Cancel | Help |

2 Select the region that you want to insert and click /nsert Region.
The region is inserted at its predefined position.

To remove a region:
1 Click the region border to select the region that you want to remove.
The selected region is highlighted. and the Delete Regions button & is enabled.

2 Click this button.
The region disappears from the dot plot.
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How to Configure Regions

You can change the color of the region border, edit the region’s name, and define the
position and size of the region.

NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

To configure a region:
1 Double-click the border of the region that you want to configure.
—0OR=-

Right-click the corresponding row in the result table and select Configure Region from
the context menu.

_0OR-

Click the region border to select the region, and click the Configure Region button
in the toolbar.
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The Configure Region dialog box appears.

Configure Region : x|

Mame : IREgiT

Top: Im Left : I—E,gg
EBoktam : |—214 Right : Im
Region Colar -

""""""""" Cancel | Help |

Bl

2 Enter a Name for the region.
It is advisable to use an easy-to-understand name.

3 Enter fluorescence values for the left, right, bottom, and top side of the rectangle to
define position and size of the region.
These values correspond to the upper and lower marker limits of the blue and red
histograms.

4 Click the ... button next to the color square to open the Color dialog box, and select a
color for the region border.

5 Click OK.

To color dots inside regions:
1 Click the Color Dots button in the toolbar.

All dots inside the regions now have the same color as the region border. In case of
overlapping regions, dots are colored with the color of the last added, re-positioned or
resized region.
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How to Change Position and Size of a Region

You can change the size and position of regions to restrict the number of included events.
You can work graphically with the mouse or enter the values in the Configure Region
dialog box.

NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

To move a region:

1 While pressing the Shift key, click the region border, and drag the region to the new
position.

2 Release the mouse button.

To change size and position with the mouse:
1 Click the region border to select the region.

2 Position the mouse pointer on any corner of the selected region.
The mouse pointer changes its shape to a double arrow.

3 Click and drag the border to the new size.

Upon moving, the mouse pointer changes its shape to a crosshair and the borders of
the region appear as dashed lines.
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4 Release the mouse button.

To change size and position numerically:

1 Double-click the region to open the Configure Region dialog box.

2 Enter fluorescence values for the left, right, bottom, and top side of the rectangle to
define position and size of the region.

These values correspond to the upper and lower marker limits of the blue and red
histograms.

3 Click OK.

How to Insert a Region in All Dot Plots

If you have defined a region for one sample, you can copy it to the other samples of the
method.

NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.
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To insert a region in all dot plots:

1

Left-click the region border to select the region that you want to use as source.
The Insert region into all dot plots button = s enabled.

Click this button

The Copy Region dialog box appears, which asks whether or not the source region
should be used as reference. The region will be inserted in the dot plots of all other
samples. When you change the properties of the region, all copies of the region will also
be changed.

Click Yes to define the source region as reference.
—0OR=-

Click No to create new regions that are not “connected”. The region will be inserted in
the dot plots of all other samples. When the properties of the region are changed, the
changes affect only the selected sample.

The region is copied to all samples of the method.
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How to Work with Gates in Dot Plots

You can insert gates only in generic methods. For predefined methods, the gate is already
defined.

Before you can insert a gate, you have to draw a region (see “How to Add Regions to Dot
Plots (Generic Method only)” on page 262). If a gate is already set, you first have to
remove the existing gate.

NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

To add a gate to a region:

1 Left-click the region border to select the region to which you want to add the gate.
The gating buttons in the toolbar are enabled.

2 Click the Horizontal Gate button *™ or the Vertical Gate button %" to set a gate along
the horizontal or the vertical borders of the selected region.
In the result table, a value appears in the % of gated column.

If the gating direction is already set, you first have to remove the existing gate:
1 Left-click the region border to select the region.
If a gate already exists, the Remove Gate button A is enabled.

2 Click this button.
The gate is removed and the gating buttons are enabled.
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Displaying the Results of Regions

The measurement results and calculations for regions are displayed in the result table
below the dot plot. In predefined methods, only one region is available, while for generic
methods, dot plots can have as many regions as you like.

The following values are displayed:

Region The default region All Events is always displayed in the first row and
shows the values for all detected events. For each further region (see

“How to Add Regions to Dot Plots (Generic Method only)” on
page 262), a row is added to the table.

XMean Mean fluorescence values in x direction.

YMean Mean fluorescence values in y direction.

#Events Number of events for each region added to the dot plot.

% Total Percentage of events for each region added to the dot plot.

% of gated Percentage of the gated events in the region.

StdDevX Standard deviation to the mean fluorescence value in x direction.
StdDevY Standard deviation to the mean fluorescence value in y direction.
CV%X Coefficient of variation of the x values.

CV%Y Coefficient of variation of the y values.

X GMean Geometric mean of the x values.

Y GMean Geometric mean of the y values.
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Evaluating Antibody Staining, Apoptosis, and GFP Methods

With the 2100 expert software, several predefined methods are supplied. You should only
use each method for the specific experiment for which it was developed. For example, you
have to use the read dye for detection of apoptosis (calcein and Cy5, for example):

e “Evaluating Antibody Staining Methods” on page 273.
e “Evaluating Apoptosis Methods” on page 277.
e “Evaluating GFP Methods” on page 283.
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Evaluating Antibody Staining Methods

Antibody staining lets you measure protein expression on the surface or inside a cell by
means of specific antibodies. Either the primary antibody itself is conjugated with a dye
or you must use a labeled secondary antibody that recognizes the primary antibody.
When you measure the fluorescence of the cells, you can compare the relative
expression of protein in individual cells and use this information for population analysis.
Typically, you can use a red dye such as APC (Allophycocyanin) or Cyb to measure
antibody presence.

You can use a blue dye like calcein to detect whether or not the cells are living, or like
SYTO 16 to stain the nucleic acids of all cells. For detailed information, refer to the
application note Detecting Cell Surface and Intracellular Proteins with the Agilent 2100
Bioanalyzer by Antibody Staining.

For a detailed description on how to evaluate the results using markers and regions, refer
to “Using Histograms for Evaluation” on page 236, and to “Using Dot Plots for
Evaluation” on page 261.

Gating direction

The gating direction is from blue fluorescence to red fluorescence. Depending on the dye
you use, you should use all cells (nucleic acid dye) or only living cells (calcein living dyes)
for gating.
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Histogram Evaluation

The blue histogram is used for gating. High fluorescence in the blue histogram means
that the cells are living (if a life-indicating dye is used). Low fluorescence means the cells
are dead. If you use a nucleic acid dye, you cannot distinguish between living and dead
cells, you can only count all measured cells. See the following image as an example:

Calcein
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High fluorescence
value indicates living
cells
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T3
Calcein
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M. of Events

Low fluorescence
value indicates dead 25 4
or non-healthy cells
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The values are displayed in the result table below the blue histogram:

All measured events

All events in relation to

the blue marker (here M arker # Events # total % of gated
Icei p i@ Al Events 1565 100 -
ca Cem) ® :Calcein on all events 1436 ﬁ'I.B
J

Living cells related to all measured cells (high calcein fluorescence)
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When using the calcein marker in the blue histogram for gating, only living cells are
considered for building the histogram of the red dye. High red fluorescence values
indicate living cells with bound antibodies, low red fluorescence values living cells
without bound antibodies. See the following example.

APC

High fluorescence oL
values indicate binding 50 £
of labeled antibodies I

a0 —é
20 -
Low fluorescence values -

indicate low binding of LR
Iabeled antibodies o E IIIIII.i’\/h IIILLL| IIIIII_H IIIIIIIII I 11 (ERE

102 1D1 100 101 102 107
Fluorescence

Mo. of Events

The values are displayed in the result table below the red histogram:

Percentage of the living cells

Percentage of all cells with Marker # Events % total *# of gated
h|gh red fluorescence b i ® iGated by Calcein 1436 91!8 -
® (CD3-APC on subset 25 1.6 1.7

selected by the red marker

|
Amount of living cells with high red fluorescence in relation to the amount of living cells
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Dot plot evaluation

If you switch to the Dot Plot tab, one region is displayed in the dot plot. The red

fluorescence values of the region are related to the marker in the red histogram, the blue
fluorescence values to the marker in the blue histogram. As in the histogram evaluation,

high blue fluorescence and high red fluorescence mean living cells with bound

antibodies. See the following example.

Cumulation of high blue and high red fluorescence
indicates strong binding of labeled antibodies in living cells
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The results of the dot plot evaluation are numerically displayed in the result table:

Events covered by the region

All measured events

Hegion # Events * total #* of gated
Al Events 1606 100 -
p: @ :Regionl 11493 4.3 4.1
]

Amount of living cells in relation to all measured cells

Amount of living cells with high antibody binding in relation to all living cells

Evaluating Apoptosis Methods

The apoptosis method can be used to examine how many apoptotic cells are within a
living cell population. Dead (or necrotic) cells can be excluded from the evaluation.

For a detailed description on how to evaluate the results using histograms and regions,
refer to “Using Histograms for Evaluation” on page 236 and “Using Dot Plots for
Evaluation” on page 261.

Living or dead cells

In most cases, you want to know whether cells are dead or alive at a specific time. For
this, you can use calcein-AM as living cell dye, for example. This dye accumulates in
intact cells, whereas it will leak out of damaged cells. Once inside the cells, the colorless
AM ester is cleaved by esterases, resulting in the formation of the highly fluorescent
calcein. The number of events resulting from a calcein-related staining thus gives you the
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number of living cells in a sample. For detailed information, refer to the application note
Apoptosis Detection by Annexin V and Active Caspase 3 with the Agilent 2100
Bioanalyzer.

Apoptotic cells

In apoptotic cells, phosphatidylserine is no longer confined to the inner leaflet of the
plasma membrane bilayer. Phosphatidylserine becomes accessible on the outer surface
of the cell membrane and can be bound with high affinity by the protein annexin V, which
can be labeled with biotin or dyes such as Cyb.

Gating direction

The gating direction is from blue fluorescence (living cells) to red fluorescence (annexin).

Histogram evaluation

The two histograms displaying the results of the method are related to calcein (blue
fluorescence) and annexin V (red fluorescence). High fluorescence values in the blue
histogram indicate living cells, low values correspond to dead cells. See the following
image as an example.
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The values are displayed in the result table, each histogram has its own table:

All measured events

All events in relation to the
blue marker (here calcein) Marker # Events: # total % of gated
b i w4l Events 1F36 100
® :Calcein on all events 998 5?.5
I

Living cells in relation to all measured cells (high calcein fluorescence)
When using the calcein marker in the blue histogram for gating, only the living cells are

considered for building the red histogram. High red fluorescence values indicate living,
apoptotic cells, low red fluorescence values indicate living, non-apoptotic cells. See the
following example.
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Dot plot evaluation

If you switch to the Dot Plot tab, one region is displayed in the dot plot. The red

fluorescence values of the region are related to the marker in the red histogram, the blue
fluorescence values to the marker in the blue histogram. As in the histogram evaluation,
high blue fluorescence and high red fluorescence represent living cells with annexin V

binding. See the following example.

Cumulation of high blue and high red

fluorescence indicate living apoptotic cells
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The results of the dot plot evaluation are displayed in the result table.

All measured events

Events covered by the
region

Region # Events # total % of gated
Al Events 1736 100
b i ® iRegion 1 444 286 a4

Amount of living cells with high red fluorescence in relation to the

amount of all cells

Amount of living cells with high red fluorescence in relation to the amount of

living cells
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Evaluating GFP Methods

With GFP (Green Fluorescent Protein) methods, the fluorescent substance is not a dye,
but a protein. Cells can be transfected with a target gene together with the
GFP-producing gene. Transfected cells produce the fluorescent protein, which can be
detected. The fluorescence shows you the success of the transfection experiment. For
detailed information on GFP methods, refer to the application note Monitoring
transfection efficiency by green fluorescent protein (GFP) detection with the Agilent 2100
Bioanalyzer.

For a detailed description on how to evaluate the results using histograms and regions,
refer to “Using Histograms for Evaluation” on page 236 and “Using Dot Plots for
Evaluation” on page 261.

Gating direction

The GFP has a green fluorescence (absorption in the blue). Because the reference dye
(CBNF) fluoresces in the red, the gating direction is from red to blue. CBNF stains living
cells, so you can detect living, GFP-positive cells.

Histogram evaluation

The two histograms displaying the results of the method are related to CBNF (red
fluorescence) and GFP (blue fluorescence). High fluorescence values in the red
histogram indicate a staining with CBNF, which is associated with living cells. See the
following image as example.
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The values are displayed in the result table, each histogram has its own table.

All events related to the red marker (here CBNF)

All measured events

Marker % of gated % total |lt Events
b @ Al Events - 100; | E58
® iCEMF on all events - 4.7 REY

After gating by using the red histogram, in the blue histogram only CBNF-stained cells
are displayed. High blue fluorescence values indicate GFP-producing cells. See the
following example.
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Dot plot evaluation

If you switch to the Dot Plot tab, one region is displayed in the dot plot. The red
fluorescence values of the region are related to the marker in the red histogram, the blue
fluorescence values to the marker in the blue histogram. Corresponding to the histogram
evaluation, high blue fluorescence and high red fluorescence indicate living
GFP-producing cells. See the following example.

Cumulation of high blue and high red fluorescence
indicates living GFP expressing cells
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The results of the dot plot evaluation are displayed in the result table.

Events covered by the region

All measured events

Region # Events # total # of gated
® Al Events 1736 100 -
b ® iReqgon 1 321 .3 g2

Amount of cells with high CBNF fluorescence and high GFP
fluorescence in relation to all measured events

Amount of cells with high GFP fluorescence in relation to the amount of
CBNF-stained cells.
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Working with Chip Data and Methods

You can make efficient use of the chip and method data generated by the 2100 expert
software, if you know the following fundamentals and operating techniques:

e “2100 Expert Data Overview” on page 289

e “Handling Methods” on page 293

e “Handling Chip Data” on page 301

* “Organizing, Backing up, and Archiving 2100 Expert Data” on page 303
e “Importing Data” on page 305

* “Exporting Data” on page 312

e “Printing Reports” on page 324

e “Configuring Tables” on page 329

NOTE

The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.
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2100 Expert Data Overview

The 2100 expert software manages data in the following different formats:

Method files (.xsy)
Chip data files (.xad)

Comparison files (.xac)

Verification result files (.xvd)

Diagnostics result files (. xdy)

Result flagging rule files (.xml)

Method files
Method files (.xsy) contain the following information:

» Data acquisition and analysis setpoints

Acquisition setpoints are instrument commands and acquisition parameters. Analysis
setpoints are evaluation parameters, some of which you can modify.

e Method information
This information includes:
— Assay type, title, version, and all other parameters defined by the assay.
— Study configuration
— Instrument configuration

— Reporting configuration
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— Workflow configuration

Chip and sample information

These are chip comments, sample names and comments.

Marker and region definitions (flow cytometric methods only)
Included are associated parameters, such as the gating direction.

Ladder table and peak table (electrophoretic methods only)
Result flagging rules (electrophoretic methods only)

The audit trail and the signature log with all signatures of the involved users.

Chip data files

Chip data files (.xad) contain the following information:

Measurement results

After each chip run, the measurement results—also called “raw data”—are
automatically saved in a new chip data file. Electrophoretic measurement results are
pairs of migration time and fluorescence intensity values, flow cytometric
measurements are triplets of migration time, red fluorescence, and blue fluorescence.

Base method information

Because a chip run is always based on a method file, all information from the method
file becomes part of the chip data file.

Run log

Events occurring during the chip run, such as the start and end time, or any errors or
problems are entered in a “run log”, which is also saved in the chip data file.
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e Evaluation information

These are modifications you made during data evaluation, such as modified gel
coloring, manually set markers, manual integration, modified setpoints, modified result
flagging rules, or definitions of new markers and regions.

* The audit trail and the signature log with all signatures of the involved users

Comparison files

You can compare the measurement results from different chip runs (electrophoretic chip
data files of same method class only) by collecting samples from different chip data files
(.xad) and storing them in a comparison files (.xac). It is then possible to overlay
electropherograms of these samples, for example, but also to compare gel-like images or
data tables.

Comparison files also contain an audit trail and a signature log with all signatures of the
involved users.

Verification result files

Verification result files (.xvd) contain results of qualification tests regarding the
bioanalyzer hardware and software. The files are stored in the “..\validation” subfolder of
the 2100 expert installation directory. For each verification run, an .xvd file is generated.

Date and time of the verification run are included in the file name. Example:
“Verification_23-05-2005 10-28-40.xvd".

Verification files also contain an audit trail and a signature log with all signatures of the
involved users.
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Diagnostics result files

To ensure proper functioning of the bioanalyzer hardware you should run hardware
diagnostics tests on a regular basis. The results of these hardware tests are stored in
diagnostics results files (.xdy) in the “..\diagnosis” subfolder of the 2100 expert
installation directory.

Result flagging rule files

You can export and import result flagging rules from other method or chip data files.
Result flagging rules are stored in .xml files.
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Handling Methods

Method Templates

The 2100 expert provides method templates. They are designed for measurements using
the available LabChip kits. They are not suited to be run directly, but must be adapted into
custom methods. For example, a necessary adaption for these methods might be to add

an instrument.

Methods

You can derive your own methods from the predefined methods as described in “How to
Create a Method” on page 295.

The main benefit of custom methods is that you have to do the following only once in the
method file, instead of doing it again and again in the chip data files:

 Enter the general properties of the method such as the configuration of study,
instrument, reporting, and workflow.

* Modify method setpoints (data analysis setpoints).

* Enter information on chip and samples.
For example, if your sample names are to be the same for a series of chip runs.

 Define rules for result flagging (electrophoretic methods only).

* Define markers and regions for evaluation (flow cytometric method Generic only).
For example, if you want to adjust marker positions and use these for future chip runs.
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NOTE
When creating a method from a template or from a pre-existing method, it initially has

the state method development. The user who saved it as a new method, will
automatically be set up as an analyst in the workflow. In this state only he/she can run
the method after adding an instrument.

This way the method can be tested without the need to change the state to ready to

use.

You can modify methods at any time. See “How to Modify a Method” on page 299.

TIP
If you just want to view the properties of a method, you can open the method file in

read-only mode, ensuring you do not make accidental changes.
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How to Create a Method

NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

To create a method:
1 Switch to the Method context.

2 From the Methods menu, select a method.
—0OR=-
Select File > Open and open a method (.xsy) file.

The file appears in the Tree View Panel.

NOTE
If you want to create a new flow cytometric method with free gating direction or with
more than one marker or region, open and modify the method “Generic.xsy".

3 Switch to the General Properties tab to specify the Study Configuration settings.

— To add a new study to the list of studies, click the Add button. Then fill the remaining
fields.

— To modify the settings of an existing study, select it from the list, click the Modify
button and edit the fields in question.
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4 On the Instrument Configuration sub-tab, you see a list of all validated instruments.

— Select the instruments allowed for this method and click the Add button to move
them to the list of Allowed Instrument Configurations.

— To remove an instrument from this list, select it and click the Remove button.

Note that you can also import the instrument settings from another method file (for
example, a similar method). Click the /mport button and select the method file to be
used.

On the Reporting Configuration sub-tab, define the items that are to be included in the
report.

Note that you can also import the report settings from another method file (for example,
a similar method). Click the Import button and select the method file to be used.

On the Workflow Configuration sub-tab, you need to define the number of required peer
review cycles and the staff members who are allowed to perform the various tasks of
the workflow.

a Specify the Number of Peer Review Cycles.
This number of review cycles is added to the list of workflow steps.

b Select the workflow step Analysts from the selection list.

c Select all users that are supposed to perform the measurement from the list of
Available Users and click the Add button to move them to the list of analysts.

d Select the next workflow step and assign the appropriate users to it.

e Repeat this assignment procedure for all remaining workflow steps.
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TIP
It is recommended to assign several users to every workflow step. In case a user is

unavailable, the measurements can still be performed without changes in the
methods.

NOTE

You can define the same user for subsequent workflow levels. However, if he/she
signed a certain workflow level, he/she cannot perform the subsequent review level
signature. You need to be aware of this restriction when assigning users to the
workflow levels.

7 Switch to the Assay Properties Tab to modify the method setpoints if required.
8 Switch to the Chip Summary Tab to enter chip and sample information.

9 For flow cytometric methods, define markers and regions on the Histogram Tab
(Single/Grid View) and Dot Plot Tab (Single/Grid View).

10For electrophoretic methods, define flagging rules on the Result Flagging Tab.
11Select File > Save As to open the Save As dialog box.
12Under Save as type, select (.xsy), and enter a name and location for the new method.

13 Click Save to create the new method.
You need to confirm this action with your electronic signature.
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NOTE
When creating a method from a template or from a pre-existing method, it initially has

the state method development. The user who saved it as a new method, will
automatically be set up as an analyst in the workflow. In this state only he/she can run
the method after adding an instrument.

This way the method can be tested without the need to change the state to ready to
use. In this state the method can also be run on instruments that are not validated.
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How to Modify a Method

NOTE
You cannot save modifications to method templates such as Apoptosis or DNA 1000.

NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who

are logged in with certain roles. See “User Role Model” on page 52 for details.

To modify a method:
1 From the File menu select Open.
The Open dialog box appears.
2 Select a method (.xsy) file and click Open.
The method appears in the Tree View Panel and the Assay Properties Tab is displayed.
3 Modify the method by making changes on the following tabs:

— Modify study, instrument, reporting, and workflow settings on the General Properties
Tab.
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NOTE

The study description is stored in the 2100 expert system file. Altering the study
description of a method will not affect the entries in the data files that were previously
generated from this method. To update this information in the data files, too, they must
be opened, and the study must be assigned again.

Modify method setpoints on the Assay Properties Tab.

— Modify or enter additional chip and sample information on the Chip Summary Tab.

For flow cytometric methods, define or modify markers and regions on the Histogram
Tab (Single/Grid View) and Dot Plot Tab (Single/Grid View).

For electrophoretic methods, define or modify flagging rules on the Result Flagging
Tab.

4 If the method is now completely set up, switch back to the General Properties tab and
click the Release for use button.

b From the File menu select Save to save the method with the current name or Save as to
save it with a new name.

You need to confirm this action with your electronic signature.
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Handling Chip Data

Chip data (.xad) files are automatically generated at the end of a chip run. The .xad files
are given names that correspond to the choices you have made in the Options dialog box
(see “How to Specify Data File Names and Directories” on page 344).

Modifying and saving chip data files

2100 expert allows to re-open chip data files, reanalyze them using different evaluation
parameters and store the new results. You can save modifications either to the original
file (File > Save) or under a new file (File > Save As).

NOTE
Raw data acquired from the bioanalyzer is not changed—only evaluation and display
of the results can be changed and saved.

If you alter the data shown in any way after it has been saved and try to exit the program
or switch to a different context (to acquire new data, for example), a dialog box will
appear asking whether or not you wish to save the changes.

Opening chip data files as read-only

A chip data file can be opened as read-only; the Title Bar will show “(Read-Only)” at the
end of the filename. The read-only file can be edited but may not be saved under the
same name. If you attempt to save an edited read-only file, and error message will be
displayed explaining that the file is a read-only file.
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The benefit of opening chip data files as read-only is to prohibit you or other users from
making changes that would alter the file in any way. Because the 2100 expert software
allows you to open chip data files, modify data, and save them, you may prefer to ensure
that the original parameters that were used to create the file are not altered.
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Organizing, Backing up, and Archiving 2100 Expert Data

As you begin to work with the 2100 expert software, it is good practice to organize your
files. In secured environment 2100 expert takes this task over from you and saves all the
created data files in the secured area. In the data folder you will find folders for each
assay class and each assay subclass. Underneath each assay subclass you can find a
folder for each method and finally in this method folder you will find a folder for each data
file created on your system.

Organizing 2100 Expert Data

Each user in your laboratory may want to specify a particular prefix that will easily
differentiate their data files from any others.

You can specify the file prefix every time before you start a chip run in the Instrument
context.

Backing up 2100 Expert Data

It is strongly recommended to save your files to a backup disk or on CD/DVD on a regular
basis. This allows to retrieve the data in case of a system crash or other cases of data
loss. Data backup is in the responsibility of the backup operators or the 2100
administrators. 2100 expert provides these users with the rights to access the secured
area of the file system with the Windows explorer and backup tools for this purpose.
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Archiving 2100 Expert Data

The difference between archiving and backing up is that in the archiving process the data
will be removed from its original place and moved while during the backup process only a
copy is taken (depending on the tools you use).

It is a good idea to periodically archive your files to a CD/DVD to remove them from your
hard disk. Depending on the amount of hard disk space available to the 2100 expert
software, you may need to clear space on your hard drive to ensure that you will have
enough room to save upcoming chip run data.

Archiving is done by the backup operators or the 2100 administrators. 2100 expert
provides archiving functionality to users with either of these roles. See “Archiving Data”
on page 356 for details. Additionally, these users have the rights to access the secured
area of the file system with the Windows explorer and tools for this purpose.
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Importing Data

When working with method (.xsy) or chip data (.xad) files, you enter specific information
that you may want to reuse. To support the reuse of data, 2100 expert has the following

import capabilities:

e “Importing Bioanalyzer Files” on page 306

e “Importing Data Analysis Setpoints” on page 308

e “Importing Chip and Sample Information” on page 310

e Batchwise importing files into a secured state (“How to Import Multiple Data Files” on
page 354)

You can import result flagging rules definitions for result flagging into electrophoretic

method or chip data files:

e “Importing Result Flagging Rules” on page 311
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Importing Bioanalyzer Files

You can import data, assay and method files that were generated with other Agilent 2100
bioanalyzer systems. You can even import data and assay files from the older Bio Sizing
and Cell Fluorescence software applications.

NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

To import assay or method files:

1
2
3

Switch to the Method context.

From the File menu, select Import to display the Open dialog box.
Select a file of any of the following types:

— .xsy (2100 expert method file)

— .asy (Bio Sizing assay file)

— .csy (Cell Fluorescence assay file)

Click Open.
You need to confirm this action with your electronic signature.

The imported file appears in the Tree View Panel, and the Method Properties tab shows
information about the method.

Upon importing, the file gets converted to a new 2100 expert method file (.xsy).
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NOTE

Note that the imported files have the state method development and cannot be used
directly for a measurement.

If you imported an assay file that was generated with 2100 expert without security
pack, Bio Sizing, or Cell Fluorescence, the missing information (such as allowed
instruments or workflow information) has to be added.

If you imported a method file from 2100 expert with security pack, information such as
the instrument to be used and the workflow settings need to be updated.

To import chip data files:

1
2
3

Switch to the Data context.
From the File menu select Import to display the Open dialog box.

Select a file of any of the following types:
— .xad (2100 expert method file)

— .cld (Bio Sizing assay file)

— .cad (Cell Fluorescence assay file)

Click Open.
You need to confirm this action with your electronic signature.

The imported file appears in the Tree View Panel, and the electropherogram grid view
shows an overview of all samples.

Upon importing, the file gets converted to a new 2100 expert chip data file (.xad).
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Importing Data Analysis Setpoints

You can import data analysis setpoints from other method (.xsy) or chip data (.xad) files of
the same type.

Note the following when importing:

 Electrophoresis files to be imported must be of the same method type. This means that
you cannot import setpoints from a DNA 1000 method into a DNA 500 method, for
example.

* Flow cytometry files to be imported can be of any flow cytometric method type, but the
import will change the type of the current file to Generic.

NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

To import data analysis setpoints:
1 On the Method Properties tab, click Import Setpoints.

2 The Open dialog box appears.

3 Select the file from which you want to import, and click Open.
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NOTE

For flow cytometry files, the import will delete all existing markers and regions in the
current file, and change the current method to a Generic method. A message box
appears that prompts you to confirm this change.

Import Marker and Regions |

Azsay will be changed ko GEMERIC, Da yau wank ko cankinue ¢

4 Click Yes.

NOTE
Importing data analysis setpoints overwrites all current setpoint values.

— All files: the setpoint values are updated in the setpoint explorer, and immediately
applied to the measurement results (if any).

— Flow cytometry files: the new markers and regions are now available for evaluation,
and calculations based on the new markers and regions are immediately done.

5 From the File menu, select Save to make the changes permanent.
You need to confirm this action with your electronic signature.
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Importing Chip and Sample Information

On the Chip Summary tab, you enter the names and comments for the chip and the
samples. The information you enter here may be very similar for further chip runs or other
methods. To reuse this information, you can import it from other chip data (.xad) or
method (.xsy) files instead of typing it anew.

NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

To import chip and sample information:
1 Onthe Chip Summary tab, click Import.

2 The Import Sample Information dialog box appears.

3 Select the file that contains the information you want to import, and click Open.
The Chip Summary tab updates to show the imported data.

4 From the File menu, select Save to make the changes permanent.
You need to confirm this action with your electronic signature.
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Importing Result Flagging Rules

You can import result flagging rules into electrophoretic method (.xsy) or chip data (.xad)
files. Result flagging rules can be stored in .xml files (see “Exporting Result Flagging
Rules” on page 323).

NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

To import result flagging rules:
1 Open an electrophoretic method or chip data file in the respective context.

2 Switch to the Result Flagging Tab.

3 In the Result Flagging toolbar click =]
The Load Rules dialog box appears.

4 Select the .xml file that contains the set of result flagging rules, and click Open.
You need to confirm this action with your electronic signature.

The imported rules appear in the rule list.
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Exporting Data

2100 expert allows you to export the results of your chip runs in a variety of formats. The
exported data can be used for further evaluation with other applications, such as text
processors, graphic tools, MS Excel®, or flow cytometry applications.

You can export the chip run data of the currently loaded file either manually or
automatically:

* “Exporting Chip Run Data” on page 314
More powerful functions for exporting data files are found in the System context. See:

* “How to Export Multiple Data Files” on page 353 for exporting multiple data files.

e “Archiving Data” on page 356 for archiving complete directories (data files and .PDF
reports).

If you want to export only parts of your measurement results:
e “Exporting Tables” on page 318

e “Exporting Graphs” on page 319

e “Copying Graphs and Tables into the Clipboard” on page 321

Information that you have entered to document a chip run can be exported for reuse in
future chip runs:

e “Exporting Chip and Sample Information” on page 322

From electrophoretic method or chip data files, you can also export rule definitions for
result flagging:

e “Exporting Result Flagging Rules” on page 323
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NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.
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Exporting Chip Run Data

NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

To export chip run data:
1 Switch to the Data context.

2 In the Tree View Panel, select a chip data (.xad) .file or load a file.

3 From the File menu, select Export.

If you selected an electrophoretic chip data file, the Electrophoresis Export Options
dialog box appears.

If you selected a flow cytometric chip data file, the Flow Cytometry Export Options
dialog box appears.
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Flow Cytometry Export Options ﬂ

—— Flow Cytometry Export

¥ Result Tables
Create a csv file containing result table values,

V¥ sample Data
Export textual list files, one file per sample.

[V FCS Data
Create FCS standard files, one file per sample.

¥ Dat Plat Images | [Formats]
Export the Dot Plot image, one file per sample,

[V Histogram Images [Formats]

Export the blue and red histogram images, one file per sample.

[~ Export ko %ML
Export the complete data file into self describing XML Format.

—— Export Direckory
' Defaule:  C:h...12100 binanalyzer\2100 expertiData
' Custom:  C:...12100 binanalyzer\2100 expertiData |

[" Create daily subdirectories

Export I Cancel | Help |

4 Select the export categories, and specify a target directory.

NOTE
Keep in mind that exporting a chip data file can require up to 20 MB of disk space. In

particular, exporting electropherograms and gel-like images as .tif or .bmp files may
take up a lot of disk space.
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NOTE

If you want to access these exported files and you do not have admin rights, please
keep in mind to specify a target directory outside the SecuredArea folder.
Otherwise the data will get exported but you will not be able to access it with the
windows explorer since access is only granted to 2100 administrarors and 2100
backup operators.

5 Click Export.
You need to confirm this action with your electronic signature.
Several system dialog boxes appear, one for each export category, allowing you to

check and modify names and locations of the export files. Clicking the Save button in
these dialog boxes finally starts the export.

TIP
Chip run data can be automatically exported every time a chip run has finished. Refer
to “Exporting Chip Run Data Automatically” on page 317 for details.

The Export tab of the System context allows you to export multiple data files without
having to load them first. See “How to Export Multiple Data Files” on page 353 for details.
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Exporting Chip Run Data Automatically

NOTE

Keep in mind that exporting a chip data file can require up to 20 MB of disk space. In
particular, exporting electropherograms and gel-like images as .tif or .bmp files may
take up a lot of disk space.

NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

To enable and configure automatic export:

1
2
3

Switch to the System context and select Auto Export in the tree navigation.
Activate the Auto Export check box.

Specify the export categories that are to be included in the exported files for
electrophoretic and flow cytometric chip runs.

Switch to Default Export Directories in the tree navigation and specify the target
directories.

When leaving the System context, you need to confirm this action with your electronic
signature.

From now on, chip run data is automatically exported every time a chip run has finished.
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NOTE
If you stop a chip run, auto export does not take place.

Exporting Tables
You can export:
* Result tables, peak tables, fragment tables, and ladder tables as .csv files or .xIs files.

* Log book tables as .html or .txt files.

NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

To export a result table, peak table, fragment table, or ladder table:

1 Onthe Method Properties, Electropherogram, Gel, Histogram, or Dot Plot tab, right-click
the heading row of a table.

2 From the context menu, select Export.
The Save As dialog box appears.

3 Enter a file name and choose the destination directory.
4 Select .csv or .xls as export file format.

5 Click Save.
You need to confirm this action with your electronic signature.
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TIP
Result tables can be automatically exported every time a chip run has finished. Refer
to “Exporting Chip Run Data Automatically” on page 317 for details.

To export a log book table:
1 On the Log Book tab, right-click a table.

2 From the context menu, select Export.
The Export Data dialog box appears.

3 Click the ... button to specify the file name, the destination directory, and the file type.
You can choose between HTML file for .html output and Tabbed text file for .txt output.

4 Specify whether you want to export the Selected rows only or All visible rows.

5 Click OK.
You need to confirm this action with your electronic signature.

Exporting Graphs

You can export graphs as individual graphic files. This applies to all graphs that can be
displayed in 2100 expert such as electropherograms or dot plots.

NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.
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To export a graph:

1

Right-click the graph, and select the appropriate entry (e.g. Save Gel or Save
Electropherogram) from the context menu.

—0OR-
Click the “ button in the toolbar.

The Save As dialog box appears.

Under File name, enter a name and choose the destination directory.
Under Save as type, select a graphic file format: .bmp, .jpg, wmf, .tif or .gif.

Click Save.
You need to confirm this action with your electronic signature.

The graph is written to the specified file.

Note the following:

 Histograms: only one histogram graph is exported, either the red or the blue histogram.

* Electropherograms: if the grid view is active, an overview image of the

electropherograms (of all samples and the ladder) is exported.

TIP

Electropherograms, gel-like images, histograms, and dot plots can be automatically
exported every time a chip run has finished. Refer to “Exporting Chip Run Data
Automatically” on page 317 for details.
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Copying Graphs and Tables into the Clipboard

You can copy graphs into the clipboard. This applies to all graphs that can be displayed in
2100 expert, such as electropherograms or dot plots.

You can also copy tables (or parts of tables) into the clipboard. This applies to most of the
tables that can be displayed in 2100 expert, such as result tables or log book tables.

NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

To copy a graph or table into the clipboard:
1 Right-click the graph or table (region).

2 From the context menu, select Copy Gel/Copy Electropherogram (graphs) or Copy To
Clipboard (tables).

—0OR-
Click the i button in the toolbar.

You can now switch to a word processing, spreadsheet, graphics, or other application,
and paste the graph or table there.
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Exporting Chip and Sample Information

On the Chip Summary tab, you can enter names and comments for the chip and the
samples. The information you enter here may be very similar for further chip runs or other
methods. Once you have entered the information, you can export it into a separate file,
which you can then import into other chip data (.xad) or method (.xsy) files instead of
typing it anew.

NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

To export chip and sample information to a file:
1 On the Chip Summary tab, click Export.
The Export Sample Information dialog box appears.

2 Specify a file name and location for the file to which you want to export.

3 Click Save.
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Exporting Result Flagging Rules

You can export result flagging rules for reuse in other electrophoretic method (.xsy) or
chip data (.xad) files (see “Importing Result Flagging Rules” on page 311). Result flagging
rules are stored in .xml files.

NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

To export result flagging rules:

1 Open the electrophoretic method or chip data file with the desired result flagging rules
in the respective context.

2 Switch to the Result Flagging Tab.

3 In the Result Flagging toolbar click =1
The Save Rule Definitions dialog box appears.

4 Browse for a folder where you want to store the rules, and specify a name for the .xml
file.

b Click Save.
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Printing Reports

For documentation and presentation purposes, you can print reports for method (.xsy),
chip data (.xad), verification results (.xvd), and comparison (.xac) files.

You can print all reports manually, see “How to Print a Chip Run Report” on page 325.
When printing manually, a preview function allows you to view the printout before
starting the print job.

The 2100 expert program can also be set to print customized chip run reports
automatically at the end of the run. These reports can be set up to contain different
information (settings for the manual and automatic print functions are maintained
separately). See “How to Create a Method” on page 295 for more information.

TIP
Beside sending reports to a printer, you can also create .pdf and .html files.

Contents A324V Index



How to Print a Chip Run Report
The following information can be included in a chip run report:
* You can always include:
— Run summary—general data about the method, and sample information.
— Assay details—complete list of data analysis setpoints.
— Run Logbook
— Signature Logbhook
— Audit Trail
* For flow cytometric chip data files (.xad) you can include:
— Dot plot summary—all regions shown in an overview.
— Dot plot statistics—all statistical data of the result table.
— Histogram summary—all histograms shown in an overview.

— Histogram statistics—all statistical data of the blue and red histograms’ result
tables.

* For electrophoretic chip data files (.xad), depending on the method type you can
include:

— Electropherograms
— Gel-like image
— Result tables

— Standard curve
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— Calibration curve

NOTE

The contents of the report are specified during the method setup. If a chip run was
made based on a method that was released for use, you cannot alter the pre-defined
contents of the report.

To print a report:
1 Switch to the Data context.

2 In the Tree View Panel select the chip data (.xad) file you want to generate a report of.
3 From the File menu select Print.

Depending on the file type different dialog boxes appear.

vt x|

r—Print Item
¥ Run Summary W Dat Plat Summary W Histogram Summary [ Fun Loghook

[¥ Assay Details [ Dot Plak Statistics [v Histogram Statistics  [v Signature Loghook

I~ At Trail
—Samples Options
+ Al Samples
|6 per page 'l
" Samples
Enter sample number and/or sample ranges,
separated by commas, Example: 1,2,3-6
—Save To File

[TIPDE  FilePath: |C1\. . pert_apoptosis_00000_2005-04-27 _13-40-03.pdf |

["/HTML  File Path: |C1\. . ert_apoptosis_00000_2005-04-27_13-40-03. htrl

Page Setup...l Printer... | Preview Cancel Help |
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4 You generally have the following possibilities:
— select the items to be included in the report from the Print Item section
— select the wells to be included from the Wells section
— select the appropriate options

— specify whether you want to generate the report as a file (PDF or HTML)

Note, that you can only select the included Print I/tems and the additional Options only
unless the method is released for use.

5 Use the Page Setup and Printer buttons to access system dialog boxes, allowing you to
select a printer, and specify the print medium and page layout.

6 Click the Preview button to get a preview of the printouts or files to be generated.

7 Click Print to print out the pages or generate the file(s).
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The following example shows the “Run Summary” part of an RNA chip run report.

2100 expert_mRNA Pico_00000_2005-05-17_15-59-32.xad (¥. 1) Page 1 of 16
Assay Class: mRMNA Pico Read:! 17.05.2005 15:59:41
Data Path: C:h...NA Picol2100 expert_mRMA Pico_D0000_2005-05-17_15-59-32.xad Madified: 17.05.2005 16:02:27
Electrophoresis File Run Summary
Instrument Information:
[=] B - - T
3 2 3 3 & @ 3 3 3 3 3 3 IstumenMhmer Na Fimwarer Simulation Mode
3 £ E E E E E E E E B B el .
- - - - - - .% .E Serial#t X0 Typet UNEMCHIN
Aszay Information:
a4 — #ssay Origin Path: CiPragrammelaailent|2 100 bioanaheeri2100
expentSecuredAreaiMethod\Demeo TemplatesiRMADemo
a2 — FARNA Dhen o
Titles Derng mRMNA Pico
40 —
“ersion: 10
e Ladder Concentration: 100,00
® - Start Tirne: 15,00
34 — [ | End Time: 24,00
2 Sizing Accuracy: 15
20 Quantitation Sccuracy: 30
Pesay Corrments | Capyright @ 2003 Agilent Technologies
% —
* - chip Inforrnation;
24 — «chip Lot
22— Reagent Kit Lot:
0 — hip Cormments:
18 —
16—
L 1 2 3 4 B & 7 3 9 w 1
Sample 1 Sample 2 Sample 3
[Ful [Fu] IFul_
5
£ 2
0 0 0
T T T T T T T T T T T T T T T
20 E E) E a1 20 E E) E a1 20 E E) E a1
Sample 4 Sample 5 Sample &
[Fu] [Fu] [Fu]
4~ 2+
B 2
0 0 0
T T T T T T T T T T T T T T T
20 E E) E a5 20 E E) E a5 20 E E) E a5
Sample 7 Sample 3 Sample 3
[FU] [FU] [FU]
4] 2]
£ 2 1]
o 0 0
T T T T T T T T T T T T T T T
20 E E) E a5 20 E E) E a5 20 E E) E a5
Sample 10 Sample 11
[Fu] [FUl 4
10 4
5 2]
0 o
T T T T T T T T T T
20 E E) E a5 20 E E) E a5
2100 expert (B.02.01.51211) Copyright 2003-2005 Agilent Technologies, Inc. Printed: 17.05.2005 16:07:10
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Configuring Tables

2100 expert uses various tables to present data:
* Result tables

* Peak tables

* Fragment tables

* Log book tables

In some cases, you might want to reorganize the way the data is presented. To do so, you
can hide or show columns, change the column sequence, and adapt the table height.

Area FragmentSize | Concentraktion | Molariby Observations
1 50.29 15.00 4,20 424,24 |CalculatedLowerMarker
2 29.49 472,30 0,76 2.45
3 13.40 500,56 0,34 1.03
4 a4.13 1500.00 2,10 2,12 [CalculatedUppertarker

The following example demonstrates how to add the migration time to the Peak Table.

NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.
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Showing and Hiding Columns

To add the Aligned Migration Time column to the table:

1 Right-click the heading row of a table and select Configure Columns from the context

menu.

The Configure Columns dialog box opens.

I
Size [bp] | Conc. [ngfpl_talaeibe o] | e —
1 15,00 4| “% Export... Marker
2 472,30 1] Configure Caolumns. .. P |
3 SLiEE - l.|1‘| Copy To Clipboard L%I:rl+li
4 1500.00 2l — : ___HMarker
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2 Move any desired column headers from the Available list to the Displayed list.

Configure Columns x|
Available Displayed
= Size [bp]
Conc, [ngfpl]
Peak, Height: Malarity [nmol/T]
Peak Width Cbservations
% of Tokal
Time correcked area
Calib, Conc [ng/pl]
el
(e} [
(4 Cancel Reset Help

3 Configure the order of the column headers in the Displayed list by using the Up and
Down buttons.

4 Click OK.
A new column Aligned Migration Time is inserted in the table:
Size [bp] | Conc. [ngful] | Molarity [nmolfl] | Observations | Aligned Migration Time [=]

i 4 4,20 424, 2 |Lawer Marker 41.00
2 1.55 105.6 42,72
3 1.23 33.8 47,44
4 104 3,90 56,7 53,04
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Changing the Column Sequence

TIP

You can set the column sequence also using the Up and Down buttons in the

Configure Columns dialog box.

To change the column sequence of a table:

1 Position the mouse pointer on a column header.

2 Click and hold the left mouse button, and drag the header cell to the desired position.

While dragging, a green arrow indicates the target position.

I 1
Area | Fragment=. L akion | Malarity Observations W
MigrakiomTirme
1 50.29 m—lﬁh' 4.20 424,24 |CalculatedLowerMarker 44,14
2 29,49 472,30 " 0.76 2.45 03,54
3 13.40 500,66 0.34 1.03 05,53
4 a4.13 1500,00 2.10 2,12 |CalculakedUpperiarker 115.56

3 Release the mouse button.

The column has moved to its new position:

Area FragmentSize | MigrationTime | Concentration | Molariby Observations
1 50,29 15.00 44,14 4,20 424,24 (CalculatedLowerMarker
2 29.49 472,30 93.54 0,76 2,45
3 13.40 200,66 95,53 0,34 1.03
4 a4.13 1500,00 115.56 2.10 2,12 [iCalculatedUpperMarker
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Changing the Table Height

You can customize the view by changing the height of the table.

To increase or reduce the table height:

1 Position the mouse pointer above the heading row of the table and move it upwards
until the cursor’s shape changes to a double arrow.

2 Click and hold the left mouse button and drag up or down.

A
Area FragmentSize | MigrakionTime | Concentration | Molariby Observations
1 50.29 15.00 44,14 4,20 424, 24 | CalculatedLowerfarker
f Aeib) N L. J—" I 28 A5
3 13.40 500,66 95,53 0,34 1,03
4 a4.13 1500.00 115.56 2,10 2,12 |Calculated)pperiarker
Beszultz | Peak Table |
3 Release the mouse button.
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In this example, the Peak Table freed screen space for the gel-like image above the table:

JIE L 1 2 3 4 =t =} T H
ki

Area FragmentSize | MigrationTime | Concentration | Malarity Chservations
1 50,29 15.00 44,14 4.20 424,24 CalculatedLowerMarker
2 29,49 472,30 93,54 0.76 2.45
3 15.40 SO0, 66 95,53 0.34 1.05
4 24.13 150000 115.56 Z.10 2,12 |CalculatedUpperMarker
Besultz | Peak Table
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Administering System Functions and the Security
Pack

The 2100 expert software provides the following configuration options and system
functions:

* Users can be added, removed, and assigned various roles. See “Access Control” on
page 337 for details.

 Default data file names and directories can be specified. Also, settings such as for
automatic printing or automatic data export can be set up. See “Configuring
2100 expert” on page 344 for details.

 Chip data files can be exported and imported. See “Exporting and Importing Multiple
Data Files” on page 353 for details.

* Data can be archived to free system space. See “Archiving Data” on page 356 for
detalls.

* Log books are provided that record all important actions and messages in the
2100 expert software. See “Using Log Books™ on page 360 for details.
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NOTE

The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.
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Access Control

Among others, the 2100 expert software with the security pack license provides
functionality for access control.

With this access control functionality, only authenticated and authorized users can
access and modify data, i.e. any electronic record created or managed by 2100 expert
security pack.

How 2100 expert Manages Users and Data Access

2100 expert does not add another level of user management. It utilizes the user accounts
setup which is managed by the operating system. The users can either be managed
locally (user accounts on the computer) or in a company environment (user accounts
managed by a directory service).

Analogously, password management is taken from the Windows operating system. The
requirements in respect to user and password management posed in controlled
environments, must be achieved by configuring the operating system account and
password policies accordingly.

However, not all the users set up at the local PC or domain service are allowed to access
a 2100 expert system. A specific 2100 expert system will be configured to grant access
only to those operating system users, which have been selected by a 2100 adminstrator.

Here it is also defined, which data and functionality a user is allowed to access. The
2100 expert software uses roles to determine which data and functions a user is allowed
to access. Unless a user has already been assigned a particular role within the

2100 expert software, this user has no access to the 2100 expert data.
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There are direct consequences for a user management that is performed by the operating
system: When a user changes his/her password within the company's directory service,
this new password is also valid for the 2100 expert software.

To protect the data generated with 2100 expert from access via the Windows
environment, a so-called Secured Area is defined. This Secured Area is a file directory
where all security pack data gets stored in. It is defined as a folder belonging to the 2100
system account. This account perfoms the underlying security management tasks and is
not visible inside the 2100 expert application. The system is not assigned to any roles.

Only 2100 expert can control the data in this secured area folder. This way the data
cannot be accessed by other (2100 expert) users via the Windows explorer. Furthermore,
since the generic user has no roles, nobody can log in as this generic user and modify any
data.

As an example, you may have a PC with 15 user accounts set up in the operating system
plus the 2100 system account. Only 5 of these users are also set up as 2100 expert users
and, therefore, can access data through the 2100 expert software. But only one of them
has the role 2100 administrator and can, thus, access the data also with the Windows
explorer.

Managing User Accounts and Roles

With the security pack license installed, the user management functions are activated.
These functions are only available to users with the role administrator.

For more information on the various user roles, see “User Role Model” on page 52.
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How to Add a New User to the 2100 expert Environment
To add a new user to the 2100 expert environment:
1 Switch to the System context and go to the Users and Roles tab.

2 Select Add User from the Users and Roles menu.

3 The Select User dialog box opens.

1 Select Users 21l
Lookin:  [&) PC_ph_sK =]
Mame | In Folder -
€ Ziii0admin PC it SF
€ 2100adop PC_MM_SK
€ 2100backup PC_MM_SK
€ 2100guest PC_MM_SK ||
€ 2100stdap PC_MM_SK
€ 21005ystem PC_MM_SK
€ 2100vald PC_MM_3K |
sdd | Check Names
FC_MM_5K42100admin
QK I Cancel |
A

The appearance of this window depends on the installed operating system.

4 Select the user you want to add either from the local users or from your company’s
domain server.
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NOTE

To select a user for 2100 expert, his/her user account must already be set up in the
operating system environment. This can only be done by an operating system
administrator.

Click the Add button to add him/her to the list of selected users. You can add several
users to this list.

Click OK create user accounts for all selected users in the 2100 expert environment.
You need to confirm this action with your electronic signature.

The new users now appear in the tree view panel.

How to Assign Roles to a User

To assign roles to a user or to remove roles from a user:

1
2

Switch to the System context and go to the Users and Roles tab.

Click the name of the user in question in the tree view panel.

The User Information of the selected user is displayed.

Check the roles that you want to assign to the user. Uncheck the rules that you want to
remove from the user.

When leaving the Users and Roles tab, you need to confirm the changes with your
electronic signature.

Contents A3V Index



TIP

If you are unsure whether you selected the correct user in the tree view panel, you can
click the Full Name button to retrieve the user’s full name from the Windows user
account.

How to Enable and Disable a User Account

A 2100 expert user account may be disabled. Two possible cases cause a 2100 expert user
account to be disabled:

« If the operating system user account is disabled, the respective 2100 expert account is
also disabled. This can happen, for example, due to several failed attempts to log into
the operating system.

* The operating system user account may still be working, but the 2100 expert account is
disabled. The account could have been actively switched off by the 2100 administrator,
if access for a certain user should be prohibited. Additionally, also 2100 expert may
disable the account after too many failed attempts at login or signing.

A disabled account can only be enabled by a 2100 administrator. If the user account
cannot be enabled again within 2100 expert, the operating system administrator must
check the user’s account in the operating system and enable it again.

To enable or disable a user account within 2100 expert:
1 Switch to the System context and go to the Users and Roles tab.

2 Click the name of the user in question in the tree view panel.
The User Information including the current status of the selected user is displayed.
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3 To enable or disable a user account, right-click the user’s name in the tree view panel
and select the appropriate entry from the context menu.

The status of the user changes accordingly.

When leaving the Users and Roles tab, you need to confirm the changes with your
electronic signature.

How to Change Your Password

NOTE

The 2100 expert security pack uses the user accounts from the Windows environment.
Thus, changing your password from within the 2100 expert software will cause that
this new password will also be required for future logins to the Windows operating
system.

If for security reasons a user needs to change the password immediately, for example if it
has been spied upon, this can be done directly in 2100 expert.
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To change your password:

1 In any context, select Change Password from the File menu.

The Change Password dialog box opens.

x|
% User Mame : Iadvaoper
Dormain : [ Pc_rma_sik |
Qld Password I ********
Mew Password ¢ I ********
Confirm Passward : I ******** |
Cancel |

2 Enter your old password to authenticate yourself.

3 Enter the new password twice to verify the correct spelling.

4 Click Ok to finish the password change.
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Configuring 2100 expert

The available options for configuring the 2100 expert software can be found in the
System context on the System Wide Settings tab.

How to Specify Data File Names and Directories

The measurement results are stored automatically when the chip run is complete. To
make it easier for you to identify the chip data files, you can configure an automatic
naming scheme for the files.

However, due to the regulations of the FDA compliance, the names of the files and
directories cannot be chosen freely. You can only specify a custom prefix that will be used
for the file names.

NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.
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To specify the names for generated chip data files:
1 Switch to the System context and select the System Wide Settings tab.

2 Select Data Files in the tree navigation.
The Data Files screen becomes visible:

—— Data File Mame
Create Data file names by combining
¥ Prefix IW
¥ | Assap Class
¥ Serial Humber
¥ Date

= Tiime Example
2100 expert_ASSAYCLASS _SRMUM_2005-04-27_..
| Counter

—— DataFile Directory

Drefault Directary [ C:h. 52100 bioanalyzer'2100 experthData |

Browse. ... | Feset |

—— Data File Format
| Binary Format
1% L Format

3 Usethe Prefix field to specify a default prefix for the created files. This default prefix can
be changed by every analyst in the Instrument context for each chip run.

4 When leaving the System context, you are asked to confirm your changes with your
electronic signature.
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How to Set Run and Result Options

You can select several options such as to pause the analysis on setpoint changes or the

graph colors.

NOTE

The 2100 expert Security Pack restricts access to data and functionality to users who

are logged in with certain roles. See “User Role Model” on page 52 for details.

To set the Run and Result options:

1 Switch to the System context and select the System Wide Settings tab.

2 Select Run and Result in the tree navigation.
The Run and Result screen becomes visible:

—— Advanced

I~ | Limit the starage of system log
Upper Limit [in ME] : I ) Clearn Log |

I~ Ao Burn

I~ At Frint Settings... |

—— Analysiz

[~ Pause Analysis on Setpoint Change

—— Graph Signal Color

Signal 1 - Signal & | Signal 9 |
Signal 2 - Signal & - Signal 10 -
Signal 3 | Signal 7 | Signal 11 -
Signal 4 - Signal & - Signal 12 |
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3 In the Analysis section, you can activate the Pause Analysis on Setpoint Change
function.

If this function is not active, the measurement results are recalculated every time after
you change a setpoint. If you need to change several setpoints at once, activating this
function saves you time, because the results are only recalculated when leaving the
setpoint explorer or when starting the analysis manually with the start button.

4 Inthe Graph Signal Color section, click the colored rectangles to the right of the signals.
You can now choose a new color for the selected signal in the Color dialog box.

5 When leaving the System context, you are asked to confirm your changes with your
electronic signature.

How to Set Auto Export Options

NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

To define auto export options:
1 Switch to the System context and select the System Wide Settings tab.
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2 Select Auto Export in the tree navigation.
The Auto Export screen becomes visible:

[ Auta Expart

—— Electrophoresiz Export
¥ Result Tables
Create a csv file containing result table values,
[ Exclude Markers
[ Include Ladders
[ strip off Excluded Peaks

V¥ sample Data
Export textual list files, one file per sample.

v Gel Image
Export the gel image.
v as one image _I [Formats]
" Each lane separately _I [Formats]
IV Electropherogram Images _I [Formats]

Export the electropherogram of each sample as a separate file,

—— Flow Cytometry Export

¥ Result Tables
Create a csv file containing result table values,

V¥ sample Data
Export textual list files, one file per sample.

[V FCS Data
Create FCS standard files, one file per sample.

¥ Dat Plat Images | [Formats]
Export the Dot Plot image, one file per sample,

[V Histogram Images | [Formats]

Export the blue and red histogram images, one file per sample.

3 Activate the Auto Export check box, if you want a data file to be exported automatically
after every chip run.

4 Inthe Electrophoresis Export section, specify which elements are to be included in the
exported file for electrophoresis measurements.
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5 Inthe Flow Cytometry Export section, specify which elements are to be included in the
exported file for flow cytometry measurements.

6 Select Default Export Directories in the tree navigation and define the default
directories for the various file types. Optionally, you can activate the Create daily
subdirectories check box to automatically export the files of each day to separate
directories.

7 When leaving the System context, you are asked to confirm your changes with your
electronic signature.

How to Activate Software Licenses

By installing the 2100 expert software you have also installed a license administration
tool. This tool is used to activate the different software modules. The following licenses
can be ordered separately:

2100 electrophoresis license

2100 flow cytometry license

2100 security pack license

2100 instrument control license
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To activate an additional software license:

1 Select Registration from the Help menu to open the License Administration Tool
window.

License Administration Tool =
i Wi I Add Licence I
Select Product: IAgiIent 2100 Bioanalyzer j
Module | License Ke | Added On
Help Exit

2 Switch to the Add License tab.
3 Inthe Select Product field, the Agilent 2100 Bioanalyzer must be selected.
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4 In the Select Module field, select the license for the software module that you want to
activate.

License Administration Tool =

‘Wiew License I Add Licence I

Select Product: IAgiIent 2100 Bioanalyzer j

Select Module: 2100 electrophoresis license j

2100 electrophoresis license
12100 Flows cvbometry license
(2100 security pack license
2100 instrument control license
License Key: I - - I

Help | Exit |

5 Enter the correct License Key and click the Add button.
A message box informs you whether the license key was added successfully.
6 If you want to add more licenses, repeat the previous two steps for every license key.

7 Click the Exit button to close the License Administration Tool window.
The licensed software modules are now activated and can be used.

NOTE

If you added the license key to activate the security pack, the 2100 expert software

closes and the secured file area will be set up. Follow the instructions displayed in the
different pages of the setup wizard.
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NOTE
Store your license keys in a secure place and make sure you do not lose them.

Contents A32V Index



Exporting and Importing Multiple Data Files

NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

2100 expert allows to export and import multiple data files at once. With this functionality
you produce copies of these files outside the secured area, for example, to use them for
presentations or analysis with external tools.

NOTE
This is in contrast to the archiving functionality, which moves the files to a distinct
destination. Exporting does not remove any files from their original location.

How to Export Multiple Data Files

To export multiple 2100 expert data files:
1 Switch to the System context and go to the Import - Export tab.

On the left side of this tab, you can see the structure of the Secured Area of the
2100 expert software. On the right side you see the structure of the currently selected
import directory.

2 If you want to export data to a different directory, click the Browse button and select
the correct directory.

3 Activate the Export radio button.
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4 In the structure of the Secured Area, navigate to the folder or file to be exported (open
folders by double-clicking them) and click the >>> button.

The selected folder or file is added to the structure in the selected export directory.

If you need to export more folders or files, repeat this step for all remaining data to be
exported.

5 If you want the files to be exported including their original path, activate the /nclude
Path checkbox.

6 Click the Export button to start the actual exporting procedure.
The signature dialog opens and lists all files that are selected to be exported.

7 Confirm this action with your electronic signature.

After the exporting procedure is finished, you can click the Report button to see, whether
all files have been successfully exported or not. This information is also written to the
system log file.

The files that are exported can now be normally accessed with external tools without any
restrictions.

How to Import Multiple Data Files

To import multiple 2100 expert data files:
1 Switch to the System context and go to the Import - Export tab.

On the left side of this tab, you can see the structure of the Secured Area of the
2100 expert software. On the right side you see the structure of the currently selected
import directory.
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6

If you want to import data from a different directory, click the Browse button and select
the correct directory.

Activate the Import radio button.

In the structure of the import directory, navigate to the folder or file to be imported (open
folders by double-clicking them) and click the <<< button.

The selected folder or file is added to the list below the Secured Area.

If you need to import more folders or files, repeat this step for all remaining data to be
imported.

Click the Import button to start the actual importing procedure.
The signature dialog opens and lists all files that are selected to be imported.

Confirm this action with your electronic signature.

After the importing procedure is finished, you can click the Report button to see, whether
all files have been successfully imported or not. This information is also written to the
system log file.

The files that are imported to the Secured Area can now be normally accessed with
2100 expert.
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Archiving Data

NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

It is recommended that you regularly archive data to preserve system space and to
alleviate file handling and file search. 2100 expert will not allow deleting electronic
records, but will allow you to remove files after successfully completed archiving
operations.

Users that have the roles 2100 administrator and backup operator have the necessary
read (for performing a backup) and write (for restoring) permissions in the secured area.
Thus, they are able to both do regular copies and to apply functionality of an external
backup system to that part of the file system occupied by the secured area.

2100 expert does not provide any other backup functionality besides the read and write
permissions for backup operator and 2100 adminstrator.

How to Archive Data Files

To archive 2100 expert data files:
1 Switch to the System context and go to the Archiving tab.

On the left side of this tab, you can see the structure of the Secured Area of the
2100 expert software. On the right side you see the structure of the currently selected
archiving directory.
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6

It is recommended to archive the data to the archive folder of the secured area.
However, if you want to archive data to a different directory, click the Browse button
and select the correct directory.

Activate the Archiving radio button.

In the structure of the Secured Area, navigate to the folder or file to be archived (open
folders by double-clicking them) and click the >>> button.

The selected folder or file is added to the tree structure in the archiving directory.

If you need to archive more folders or files, repeat this step for all remaining directories
to be archived.

Click the Archive button to start the actual archiving procedure.
The signature dialog opens and lists all files that are selected to be archived.

Confirm this action with your electronic signature.

After the archiving procedure is finished, a message box opens, informing you about
whether all files have been archived successfully or not. This information is also written
to the system log file.

The files that are moved to the archiving directory can now be processed with external
archiving tools or mechanisms.
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How to De-archive Data Files

To de-archive 2100 expert data files:

1

Switch to the System context and go to the Archiving tab.

On the left side of this tab, you can see the structure of the Secured Area of the
2100 expert software. On the right side you see the structure of the currently selected
archiving directory.

If you want to de-archive data from a different archiving directory, for example, from a
CD drive, click the Browse button and select the correct directory.

Activate the De-archive radio button.

Click the <<< button.

The secured area directories and file structure follows an inherent rule. So afile carries
all information to locate it into it's correct location automatically.

If you need to de-archive more directories, repeat the previous step for all remaining
directories to be de-archived.

Click the De-archive button to start the actual de-archiving procedure.
You need to confirm this action with your electronic signature.
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How to Generate Archiving Reports

After you have archived and/or de-archived data files, it is recommended to generate and

save a report to document your work.

To generate an archiving report:
1 Click the Report button.
The Report dialog box opens.

|
Original Path Target Path I;I
C:\Programmeiagilents2100 bioanalyzert2100 C:\Programmeiagilents2100 bioanalyzert2100

@ experthSecuredireaihethody Templates\AMNANE ukarpote  experthSecureddreatdichive\Method\Templates\RNANE uk aryote
Total RHA Mano.xsy Total RHA Mano.xsy
C:\Programmeiagilents2100 bioanalyzert2100 C:\Programmeiagilents2100 bioanalyzert2100

@ experthSecuredireaihethody Templates\AMNANE ukarpote  experthSecureddreatdichive\Method\Templates\RNANE uk aryote
Total RMA Pico.xsy Total RMA Pico.xsy
C:\Programmeiagilents2100 bioanalyzert2100 C:\Programmeiagilents2100 bioanalyzert2100

@ experthSecureddreatih ethodi Templatesh\RMANMR MA experthSecureddreatdrchiveiMethod Templatesh\RHANMRMA
Mano.=sy Mano.=sy
C:\Programmeiagilents2100 bioanalyzert2100 C:\Programmeiagilents2100 bioanalyzert2100

@ experthSecureddreatih ethodi Templatesh\RMANMR MA experthSecureddreatdrchiveiMethod Templatesh\RHANMRMA
Fico.xsy Fico.xsy
C:\Programmeiagilents2100 bioanalyzert2100 C:\Programmeiagilents2100 bioanalyzert2100

@ experthSecuredireathethod Templates\AMNAProkamote  experthSecuredireatdichive\MethodsTemplates\RMNANProkarpote
Total RHA Mano.xsy Total RHA Mano.xsy
C:\Programmeiagilents2100 bioanalyzert2100 C:\Programmeiagilents2100 bioanalyzert2100

@ experthSecuredireathethod Templates\AMNAProkamote  experthSecuredireatdichive\MethodsTemplates\RMNANProkarpote
Total RMA Pico.xsy Total RMA Pico.xsy

Save | Cancel |

2 Save the report by clicking the Save button. Then select a file name and destination to

save the report as .TXT file.
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Using Log Books

2100 expert provides several log books to document all relevant actions and changes.
Due to requirements of data integrity and data security, none of the log books can be
cleared.

Run Logs

The run log books can be found in the following contexts as sub-tabs of the Log Book tab:
* Data context

* Verification context

e Comparison context

* Method context

They contain events such as the start and end time of a chip run, and any errors or
problems that occurred during the run.

General Properties ] Assay Properties ] Chip Surmary ] Gel ] Electropheragram ] Result Flagging ] Log Bookl

Time Stamp ¢

Apr-27-2005 09:34:.57

- @ Demo Run ended [Number of wells acquired: 13) Instrument Run Apr-27-2005 03:36:49

All run logs are saved in the data files within the respective context.
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Signature Logs

The signature log books can be found as sub-tabs in the following contexts:

* Data context on the Log Book tab

» System context on the System Log Book tab
They contain all actions that have been performed and confirmed with electronic

Verification context on the Log Book tab

Comparison context on the Comparison Log Book tab

Method context on the Log Book tab

signatures.

General Properties ] Assay Properties ] Chip Surmary ] Gel ] Electropheragram ] Result Flagging ] Log Bookl

+02:00)

|| Apr27-2005 125515 [GMT

All signature logs are saved in the data files within the respective context.

+02:00)

Contents

2100 Administrator | 2100 Administrator - Archived file

A 361

Timestamp ¢ |Time Zone |User Mame |F|0Ie |Meaning |E0mment Wergion

(I Apr-27-2005 03:34:55 [GMT Mr. Advanced Advanced Operator Started Chip Run 1

Apr-27-2005 03:39:37 [»f%';l:gﬂ] Mr. Advanced Advanced Operator Altered Analyziz Set Points 2

| Apr-27-2005 03:41:12 [Eal\zd'gu Mr. Advanced Advanced Operator Altered Analyziz Set Points 3
+ .

| Apr-27-2005 03:48:25 [%'\2‘150] Mr. Advanced Advanced Operator Altered Analyziz Set Points 4
+ .

| Apr-27-2005 10:01:.02 [%'\2‘150] Mr. Advanced Advanced Operator Altered Analyziz Set Points 5
+ .

| Apr-27-200510:47:10 [%'\2‘150] Mr. Advanced Advanced Operator Altered Analyziz Set Points E
+ .

| Apr-27-200510:51:35 [%'\2‘150] Mr. Advanced Advanced Operator Altered Analyziz Set Points 7
+ .

| Apr-27-2005 10:54: 34 [GMT : Mr. Advanced Advanced Operator Altered Analyziz Set Points 8

Altered Analysiz Set Pointz 3

v
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Audit Trails

The audit trails can be found as sub-tabs in the following contexts:

Data context on the Log Book tab

Verification context on the Log Book tab
e Comparison context on the Log Book tab

Method context on the Log Book tab

» System context on the System Log Book tab

They contain all actions that have been performed and confirmed with electronic
signatures. While the signature logs only contain one entry per entered signature, the
audit trails list all actions in detail.
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General Properties ] Assay Properties ] Chip Surmary ] Gel ] Electropheragram ] Result Flagging ] Log Bookl

Description | Timestamp| Time Zone

| Uszer Mame | Setpoint| Dperati0n| Oid Value| Mew Value|Version| Meaning

Samph

+| Started Chip Run

+| Modified file for Restared fils

+| Modified file far Archived file

+| Applied result flagging rule

+| Altered Chip Summary

Eyd

+| Altered Analysiz Set Points

+| Smear Region modified

Smear Region  Apr-27-2005 03:56:01 [GMT +02:00)
added

Smear Region  Apr-27-2005 03:56:01 [GMT +02:00)
added
Smear Region  Apr-27-2005 03:56:01 [GMT +02:00)
added
Smear Region  Apr-27-2005 03:56:01 [GMT +02:00)
added

Smear Region  Apr-27-2005 03:56:01 [GMT +02:00)
added

Smear Region  Apr-27-2005 03:53:55 [GMT +02:00)
added
Smear Region  Apr-27-2005 03:53:55 [GMT +02:00)
added
Smear Region  Apr-27-2005 03:53:55 [GMT +02:00)
added
Smear Region  Apr-27-2005 03:53:55 [GMT +02:00)
added

Smear Region  Apr-27-2005 03:53:55 [GMT +02:00)
added

+| Altered Analysiz Set Points

Mr. Advanced Region  Modified
Calor

Mr. Advanced Region  Modified
end size

Mr. Advanced Region  Modified
start

Mr. Advanced Region  Modified
1o]

Mr. Advanced Regions Item
added in
caollection

Mr. Advanced Region  Modified

Calor

Mr. Advanced Region  Modified

end size

Mr. Advanced Region  Modified

start

Mr. Advanced Region  Modified
1o]

Mr. Advanced Regions Item
added in
caollection

=1

=1

=1

=1

=1

=1

10465547 &
4052018 5
287724 5
2 5

5
2921737 &
5178318 &
332413 5
1 5

5

Altered Analysiz
Set Points
Altered Analysiz
Set Points
Altered Analysiz
Set Points
Altered Analysiz
Set Points
Altered Analysiz
Set Points

Altered Analysiz
Set Points
Altered Analysiz
Set Points
Altered Analysiz
Set Points
Altered Analysiz
Set Points
Altered Analysiz
Set Points

PCR I

PCR I

PCR I

PCR I

PCR I

PCR I

PCR I

PCR I

PCR I

PCR I

+| Altered Chip Summary

4

Run Log | Signature Log | Audit Trail |

All audit trails are saved in the data files within the respective context.
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System Log

The system log book can be found in the System context as a sub-tab of the Log Book
tab.

It includes start-up and shut-down events of the 2100 expert software, and, for example,
errors or problems with the connected bioanalyzers.

Users and Roles ] System Wide Settings ] Archiving ] Import - Export ] Syskem Log Bookl

|Descripti0n |Number| Source |Eategory| Sub Category Time Stamp ¢ I;I
& File haz been modified: C:%\Programmetagilents2100 binanalyzert2100 3 Security Service  System Apr-26-2005 08:10:42
(I experthS ecureddreaSpstemi S petemFile. sml
& File haz been modified: C:%\Programmetagilents2100 binanalyzert2100 3 Security Service  System Apr-26-2005 08:10:40
(I experthS ecureddreaSpstemi S petemFile. sml
User switched, new uzer is PC_MM_SKhadvaoper and old uzer was PC_MM_SK\2100admin - 0 User Interface Apr-26-2005 08:10:20
| File has been modified: C:\Programmeiagilents2100 bioanalyzert2100 3 Security Service  System Apr-26-2005 08:03:12
& expertsSecuredfreatdethodhT emplateshBNANE uk arpote Tatal RMA MNano.xsy
| & File haz been modified: C:%\Programmetagilents2100 binanalyzert2100 3 Security Service  System Apr-26-2005 08:03:12
(I experthSecureddreadchive
& File haz been modified: C:%\Programmetagilents2100 binanalyzert2100 3 Security Service  System Apr-26-2005 08:03:11
(I experthSecureddreadchive
& File haz been modified: C:%\Programmetagilents2100 binanalyzert2100 3 Security Service  System Apr-26-2005 08:03:10
(I experthSecureddreadchive
& File haz been modified: C:%\Programmetagilents2100 binanalyzert2100 3 Security Service  System Apr-26-2005 08:09:.07
(I experthS ecureddreaSpstemi S petemFile. sml
& File haz been modified: C:%\Programmetagilents2100 binanalyzert2100 3 Security Service  System Apr-26-2005 08:03:06
(I expertecureddrealpstemi S petemFile. sml
File haz been modified: C:%\Programme‘agilents2100 binanalyzert2100 3 Security Service  System Apr-26-2005 07:53:50
& expertSecuredireaMethod\Demo TemplatestdsDMAND emo DMA 7E00.xsy
| 2100 Administrator as 2100 Administrator has stated 2100 expertlersion: B.02.01.51209) 1] User Interface Apr-26-2005 07:53:18
| & File haz been modified: C:%\Programmetagilents2100 binanalyzert2100 3 Security Service  System Apr-26-2005 07:53:18
(I experthSecuredireaS peterm'\SpstemFileLogs. xml
& File haz been modified: C:%\Programmetagilents2100 binanalyzert2100 3 Security Service  System Apr-26-2005 07:53:17
(I experthSecuredireaS peterm'\SpstemFileLogs. xml
& 2100 expert security service started 1] Security Service  System Apr-26-2005 06:34:16
| & Securty Guard has been started to watch C:\Programmeidgilent’.2100 bioanalyzert2100 1] Security Service  System Apr-26-2005 06:34:16
(I experthSecuredirea
2100 expert ended [Version: B.02.01.51209] 1] User Interface Apr-25-2005 12:45:45
| 2100 Administrator a5 2100 Admiristrator has succesfully unlocked the application. 1] User Interface Apr-25-2005 12:45:40
| 2100 Administrator as 2100 Administrator has stated 2100 expertlersion: B.02.01.51209) 1] User Interface Apr-25-2005 11:02: 26

=

l

|

Syskem Log | Signature Log | Audit Trail
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The system log book is saved in SecuredArea/System/SystemLogs .xml. This file can be
exported by the 2100 administrators and the backup operators. Additionally, this log book
will be split up automatically when a certain file size is reached and saved as
SystemLogs ddddTtttt.xml, where dddd and tttt are the current date and time. These
files can be accessed via the operating system.

How to Change the Display of the Log Books

NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

To sort a log book table:
1 Click the column header you want to sort the table by.
The log book table is sorted by the entries in the selected column in ascending order.

2 Click the column header again to reverse the order.

To filter a log book table:
1 Inthe Log Book toolbar, click Filter Y.

The Filter dialog box appears.

2 To define a filter for events from a specified period of time, specify a Start Time and an
End Time.

3 To define a filter for events with certain entries in a column, specify the column name
and the value to search for.

Contents AJHY Index



Use the Filter Action radio buttons to define whether only events that match the filter

criteria are displayed (FilterActionHide) or whether those events are highlighted while
the others are still listed (FilterActionHide).

5 Click OK to apply the filter to the log book table.
The filter definition in the following example excludes all events from the Run Log in the

Data context with an Event Type other than Critical.

i

Colurnnz ITime Starnp

=
S T |2?.04.2005 j
[

End Time |2?.04.2005

v
Colurnnz Show only
£ [ Infarmation

Source
Category
Sub Category

Event Type =Warning, Critical AND Time Stamp = ;I
27.04.2005, 27.04.2005

Filter action
’7(3' Appropriate events only  © Mark inappropriate events

Help

Show All

LRl L,

Lancel

To remove the filter from a log book table:
1 In the Log Book toolbar, click Reset =
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TIP
You can hide/show any of the log table columns, and re-sort the columns by
right-clicking the table and selecting Columns from the context menu.

How to Search the Log Book

You can search the various log books for any string.

NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

To search the Log Book:
1 Inthe Log Book toolbar, click Find 2}
The Find dialog box appears.
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particular column only.

4 Select the search Direction.

Enter a search string in the Find What field.

x|

Fird what IInstrument Find Mext
Coll 5earch  |50urce -
I J Help
Direction:
Cancel

b Click Find Next.

Use the Column selection list to specify whether you want to search all columns or a

If the search string was found in an event, the event row gets highlighted in yellow.

NOTE
The search is case-sensitive!

6 To continue the search, click Find Next.
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Running Instrument Diagnostics

2100 expert provides several tests to check proper functioning of the bioanalyzer
hardware. You should perform the tests on a regular basis, or if incorrect measurements
occur.

You can test the following:

* Generic bioanalyzer tests, which can be run with both types of cartridges (electrode or
pressure cartridge)

 Bioanalyzer in combination with electrode cartridge (electrophoresis setup)

 Bioanalyzer in combination with pressure cartridge (flow cytometry setup)

NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.
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Generic Bioanalyzer Tests

Diagnostics Test

Purpose

Electronics Test

Fan Test

Lid Sensor Test

Stepper Motor Test

Temperature Test

Verifies proper functioning of all electronic boards in the
bioanalyzer.

Checks if the fan is running at the appropriate speed.

Verifies proper operation of the lid sensor, ensuring that the
laser and LED are off when the lid is open.

Checks for proper movement of the stepper motor.

Checks if the temperature ramp-up speed of the heater plate is
within specifications.

Contents
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Electrode Cartridge Tests

Diagnostics Test

Purpose

HV Stability and
Accuracy Test

HV Accuracy Test

(On-Load)
Short Circuit Test

Electrode/Diode Test

Optics Test

Electrophoresis
Autofocus Test

Laser Stability Test

Tests high voltage accuracy and stability of all 16 high voltage
power supplies and the high voltage controller. Unused chip
(DNA, RNA, or protein) required.

Check of channel-reference diode in transmission direction.

Checks for instrument leak currents using an empty chip.

Note: the limits of this test specify an ambient temperature of
25 °C and relative humidity less than or equal to 60 %. Higher
temperatures or relative humidity could result in a leak current.

Checks the photo diode and current-versus-voltage
performance of the bioanalyzer. Electrode/diode test chip
required.

Checks for proper alignment of internal optics and proper
function of the laser and LED.

Checks the focusing capability of the optical system.
Autofocus test chip required.

Measurement of stability of red laser signal.
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Pressure Cartridge Tests

Diagnostics Test

Purpose

Pressure Offset Test

Pressure Control Test

System Leak Test

Flow Cytometry
Autofocus Test

The vacuum system of the pressure cartridge consists of a
pump and the corresponding tubes. This test calibrates the
pressure sensors to zero.

Checks if the bioanalyzer is able to hold the working pressure
of -140 mbar. During the test pumps stay on, while the system
tries to regulate pressure to be kept at -140 mbar. Cell
Autofocus test chip required.

Checks if the bioanalyzer is able to maintain a vacuum.
Produces a test pressure of -100 mbar and monitors for
changes. Cell Autofocus test chip required.

Checks that the optical system of the bioanalyzer is correctly
calibrated. Cell Autofocus test chip required.

NOTE

With bioanalyzer model G2938A only diagnostic tests in combination with the
electrode cartridge can be performed.
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Test Chips

Depending on your bioanalyzer setup (electrophoresis or flow cytometry), different test
chips are required to run some of the diagnostics tests. Test chip kits are part of the
bioanalyzer electrophoresis set (G2947CA) and flow cytometry set (G2948CA):

Test Chip Kit for Electrophoresis Methods (reorder no. G2938-68100)

Test Chip

Comment Quantity

Autofocus Test Chip

Values for fluorescence and offset are printed on 1
the chip. Can be used multiple times.

Electrode/Diode Test Chip Can be used multiple times. 1

Test Chip Kit for Flow Cytometry Methods (reorder no. G2938-68200)

Test Chip

Comment Quantity

Cell Autofocus Test Chip

Required for Pressure Control Test, System 1
Leakage Test, and Optical Drive Test. Can be
used multiple times.
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How to Run Instrument Diagnostics Tests

NOTE
Diagnostics tests cannot be run while the 2100 expert software is performing a chip

run.

NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

To run diagnostics tests:
1 Switch to the Instrument context.

2 Inthe Tree View Panel, select the bioanalyzer on which you want to run the tests.

3 Switch to the Diagnostics tab.

All available tests are displayed in the Available Tests list. The tests that can be
executed depend on the type of cartridge that is installed in the bioanalyzer.

The 2100 expert software will generate an error message if a wrong cartridge type is
detected for the selected method. To run the selected test please insert the requested
cartridge type (see “Loading the Electrophoresis Chip into the Bioanalyzer” on page 80
or “Loading the Cell Chip into the Bioanalyzer” on page 212, respectively).
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4 Select the tests you want to run:
— Select the Apply check boxes to select single tests.
— Click Select All to select all available tests.

— Click Unselect All to deselect all tests.

e &l Instruments Inskrurnent ] Diagnastics l
i DEDZ000386 .
i W Instrument Mame @ Instrurent 1 Firrmware 1 01,039
Serial #: DEO2000386 Produck ID : 529334
Available Tests:
Apply Mame Description Status o Start |
b X [Electronics Tesk Tests instrument electronics, | = selected
(%] |Fan Test Tests if instrument: fan is working, |5 selected Select Al I
(%] |Lid Sensor Test Tests if the lid sensors are working. | = selected
[%]  |Temperakure Test Checks i the temperature sensors and heater a... |[7 Selected Unselect Al |
[%]  |Stepper Motar Test Tests if harizontal and vertical mokars are workin.., | 5] Selected _—
[%]  |[Electrode { Diode Test Tests conductivity of channels {pin to pin}. = selected
[%]  |High Yoltage Stability Test |Tests high voltage accuracy and stability. /= selected
[wrl LI At i mm SV P T Ay o Y =l cmlmmbmd LI
Test Properties
C
10: 29
Mame: Electronics Tesk
Description: Tests instrument electronics,
Approximate Time: Ss

b Click Start.

You need to confirm this action with your electronic signature.
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6 Follow the instructions given by the 2100 expert software. For example, exchange the

cartridge, or put a test chip in the receptacle of the bioanalyzer when requested by the

software.

Mame @ Inskrument 1
Serial #: DEO2000386

Inskrurnent l Diagniostics l

Firrmware @ C.01.030
Product ID @ 5293584

Available Tests:

j(H
Marne:

Description:

4

Temperature Tesk

Apply Tare Description Status - Skop I
[®]  [Electronics Test Tests instrumant electronics, o Executed, passed
[  |Fan Test Tests if instrument Fan is working. o Executed, passed Select &l |
[ Lid Sensor Test Tests if the lid sensars are warking. o Executed, passed
p| % |Temperature Test Checks if the temperature sensors and heater a... |¥%Executing Unselect & |
[ |Stepper Motor Test Tests if horizantal and vertical motars are warkin, .. (553 Execution pending T
[%| |Electrode / Diode Test Tests conductivity of channels {pin ko pin). (5 Execution pending
[®]  High Yalkage Stability Test |Tests high voltage accuracy and stability, 5 Execution pending
[wrl [T R P NSS! PSS SR ST SUPS  SUPSPRy S | f3 Cormm ibimm momedion LI
rF

Pleasze ingert Cartridge and an empty chipl

Checks if the temperature sensor:

Approximate Tirme: 360 5

Limits

Heater test destination Temperature ;40 <C
Heater Rarmp Timeout : 300 s

Duration of stability kst 45 s
Required Temperature Stability @ 0.4 =C

Cloze the lid and press OK,

]

Requirements

Zonfiguration |

All selected tests are performed.
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The Status column indicates the status of each test:
— Executing
— Execution pending
— Executed, passed
— Executed, failed
7 If any test failed, redo the test.

8 If failures still persist, contact Agilent service.

The results of diagnostics tests are stored in .xdy files in the 2100 expert installation
folder under “..\diagnosis”. If tests fail, send the .xdy files to the Agilent service.
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Performing Verifications

To ensure a validated Agilent 2100 bioanalyzer system, verification steps have to be
performed at installation and operation level.

2100 expert allows for detailed installation verification and system verification on both
the bioanalyzer hardware and software. Each verification comprises a series of tests and
measurements that you can run and document in the Verification context of the

2100 expert software.

NOTE
The 2100 expert Security Pack restricts access to data and functionality to users who
are logged in with certain roles. See “User Role Model” on page 52 for details.

Installation Verification

Installation verification includes tests to verify that the bioanalyzer software and
hardware are installed properly and that all electrical and pressure connections are
correct.

Installation verification must be performed once after installation.
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System Verification

System verification proves that the bioanalyzer system is suitable for its intended use,

that is, that it will function according to its operational specifications in the selected
environment.

System verification should be performed:
« at first use of the instrument,
« after relocating the instrument,

« afterchanging essential parts of the system, for example software updates or exchange
of cartridges,

« after instrument repair,

* onregular time intervals.

Verification Procedure

To perform verification tests:
1 Switch to the Verification context.

2 From the File menu select New.
3 A New Verification item appears in the Tree View Panel.

4 Under Cartridge Details, click Select and specify details on the cartridge that is currently
installed in the bioanalyzer.
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5 Under Configure 2100 Bioanalyzer HW Test Chips, enter the test chips you will use for
this verification:

New Verification

E} All verifications Configuration

E||:| Mew Verification

—Installed 2100 Bi I Set:
5] Installation Verification nstatie ! i eLs
|:| Syskem Yerification Electrophoresis Set {License : 264958350-16147633-1376230307)
Flows Cybometry Set (License : 315289990-16152224-1379275883)

— Select 2100 Bioanalyzer Instruments and Cartridges

Instrument Details : Cartridge Details :

Setial Numnber : DE34903221 Identifier : 1
Friendly Mame DE34903221

Product ID ¢ G2938C

Fi! Rewvision : C.01.048 Select ... |

—Configure 2100 Bioanalyzer HW Test Chips

Test Chip Type Lok Mumnber Offset Inkensity
1 |Autofocus Test Chip FO7CTF 270 410
2 [Electrode/Diode Test Chip F23CTE
3 |Cell Autofocus Test Chip EADSE
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6 Inthe Tree View Panel, navigate to the test category you want to execute. Select the
category via Installation/System Verification — Software/Hardware — PC
name/Bioanalyzer name — Test Category.

NOTE
To execute hardware tests (HWW branch) the bioanalyzer must be properly connected
and switched on.

The Configuration tab now lets you select verification tests to be executed in the
verification run:

New Verification  Active Verification

E} All erifications Configuration | Fesults 1 LDgBDDkI
=)+ New Verification
=) stallation Verification | Awvailable Tests:

Software

ERER st Apply | Name I Description | Exections | Status | Select Al |
B Installation X ]Instal\atmn Qualification. .. |\u'erifies that files and configurations have been installed ko their ap. .. ‘ D||§|Sa\ected ‘

@2 Hardware Unselect all |

-[=] System Verification

Test Properties

Mame: Installation Qualification Test
Description: werifies that files and configurations have been installed to their appropriate location and display correct attributes.

Approzimate Time: 300 s

To select tests, check the Apply check box next to the test(s).
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7 To start the selected tests, click Start button in the toolbar.

(D start

The Save As dialog box appears.

You need to confirm this action with your electronic signature.

8 Specify a name and location for the verification results file (.xvd) and click Save.

The selected tests are executed.

Configuration | Results ] LogBook]

Available Tests:

Rurining - Installation Qualificationrsy g

| Apply | Mame | Description | Executions |

>| [ |Installati0nQuaIiFication...|VeriFiesthatF...| 1|@Executing

Status I Select Al |

Test Properties

Lnselect Al |

ﬁ Installation qualification tool is running. This may take several minutes.,

oropriate location and display correct attributes,

Approximate Time: 300 s
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9 If a test fails, you can Repeat test execution, Abort the verification run, or skip the
current test and Continue with the next test:

2100 experk

Installation Qualificakion Test Failed!
Do wou wank o Re-Perform Inskallation
ualificakion Test ¥

Abork | Conkinue |

2100 experk

L
\:\I‘) YWalidation Run Complete,

11Click OK.
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12The Status column shows which of the tests have been run successfully, which have

failed, and which have mixed results with multiple executions.

Executions

Skaktus

of Executed, passed

of Executed, passed

" Exeruked, mixed resulks after multiple executi,., | =

o Executed, passed

o Executed, passed

of Executed, passed

of Executed, passed

of Executed, passed

>( Executed, failed after mulkiple executions

o Executed, passed

=== === P =] =

o Executed, passed
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13To view details on test execution, select the Results tab.

Configuration ] Resulks l LogBook]

Test Name: Installation Qualification Test

| Execution # | Dake and Time | Status | Comment |
» 1] 27.04.2005 16:20:25 X Failed [Failed (results beyond imits) |
E
Mame: Installation Qualification Test
Description: ‘erifies that files and configurations have been installed to their appropriate location and display correct attributes.,

Approximate Time: 300 s

Test Status: Executed, failed

3

IQ/SW results

Installation Qualification of Agilent 2100 Bioanalyzer System Software - 2100 expert Yersion (27.04,2005 16:20:28)
Check of application directory struckure ...

Passed C:iProgrammelagilent! 2100 binanalyzeri2100 expertihelp

Passed C:iProgrammelAgilentt2100 bioanalyzeri2 100 experticonfigurationivalidation OQtelectrophoresis

Passed C:iProgrammelAgilentt2100 binanalyzeri2100 expertireportsitemplates

Passed C:iProgrammelagilent! 2100 binanalyzert2100 expertireports

Passed C:iProgrammelAgilent!2100 bioanalyzeri2100 experthassays

Passed C:iProgrammelagilent! 2100 bioanalyzeri2100 expertidatalpackets

Passed C:iProgrammelAgilentt2100 bioanalyzeri2100 experthassaysidemoiflow cybometry LI

14You can now navigate to other test categories and execute additional verification tests.
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15When you close the verification result file (File > Close), try to switch to another
context, or exit 2100 expert, the following message appears:

2100 expert x|

YWalidation File will no longer be active, All results upko the last run will be saved as a read only file.
Do you wank bo continue?

If you select No, you return to the Verification context and can run further verification
tests.

If you select Yes, the verification result file (.xvd) is closed and becomes read-only.

NOTE
You can re-open verification result files only for viewing and printing.

TIP
Select File > Print to generate a printed report of the verification run.
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Products, Spare Parts, and Accessories

To buy the following products, spare parts and accessories for the Agilent 2100
bioanalyzer, please refer to the Agilent Online Store:

http://www.agilent.com/home/buyonline.html

Bundles

e G2940CA — Agilent 2100 bioanalyzer desktop system

Includes Agilent 2100 bioanalyzer, HP Compaq desktop PC, color printer, system
software, vortexer, and accessories. Cartridge and license must be purchased
separately.

* G2943CA — Agilent 2100 bioanalyzer laptop system

Includes Agilent 2100 bioanalyzer, HP Compaq laptop PC, color printer, system
software, vortexer, and accessories. Cartridge and license must be purchased
separately.
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Hardware

e (G2938C — Agilent 2100 bioanalyzer

Includes 1 chip priming station, 1 test chip kit, serial cable, Installation and Safety
Manual. Cartridge and license must be purchased separately.

e (G2947CA — Agilent 2100 bioanalyzer electrophoresis set

Includes test chip kit, electrode cartridge, license key for electrophoresis assays, and
start-up service.

* G2948CA — Agilent 2100 bioanalyzer flow cytometry set

Includes checkout kit, test chip kit, pressure cartridge, license key for flow cytometry
assays, and start-up service.

Software and Services
* G2946CA — Agilent 2100 expert software upgrade

Software package for upgrade to the latest 2100 bioanalyzer system software revision.
* G2949CA — Agilent 2100 expert security pack

Additional services for Installation Qualification (IQ) and Operation
Qualification/Performance Verification (0Q/PV) as well as assay consulting are available
and can be ordered separately.
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Spare Parts and Accessories
* 5065-4413 — Electrode cartridge
e 5065-4492 — Pressure cartridge

* 5065-4478 — Pressure Adapter Kit
Contains b plastic adapters and 1 mounting ring for use with the pressure cartridge

* (52938-68100 — Test Chip Kit for Electrophoretic Methods
Comprises 1 Autofocus, 1 Electrode/Diode, and 5 Leak Current Clips

* (G2938-68200 — Test Chip Kit for Flow Cytometric Methods
Comprises 1 Cell Autofocus Chip

* (G2938-81605 — RS 232 cable
Communication cable PC — Agilent 2100 Bioanalyzer

e 2110-0007 — Fuse
* 5042-1398 — Adjustable Clip for use as spare part for the chip priming station
* 5065-4401 — Chip Priming Station including gasket kit and adjustable clip

* (G2938-68716 — Gasket Kit
Includes spare parts for the chip priming station: 1 plastic adapter, 1 ring and 10 gaskets

e 5065-4428 — IKA Vortexer (115V)
Must be ordered at IKA (http://www.ika.de)

e 5065-4429 — IKA Vortexer (230V)
Must be ordered at IKA (http://www.ika.de)
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* 5065-9966 — Vortex Mixer Adapter for IKA vortexer

* 5065-9951 — Electrode Cleaner Box
Contains 7 electrode cleaners

e (2946-60002 — Agilent 2100 bioanalyzer How to Use Multimedia CD-ROM

Contains videos showing the chip preparation for all methods and the hardware
maintenance
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Glossary

This glossary explains terms in context with flow cytometry, electrophoresis, and
software or hardware of the Agilent 2100 bioanalyzer.

A

Area Threshold

The Area Threshold setpoint determines the minimum amount of peak area that must be
detected before a peak is recognized.

Assay

An assay is a solution with defined chip, chemicals, instrument methods, data analysis,
data output settings and data display settings.

ASY file

In Bio Sizing electrophoretic methods were stored as .asy files. 2100 expert can import
.asy files. See also XSY file.
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Audit Trail

Audit trails are available in the 2100 expert software only with the security pack installed.
They are used to record the activities of the logged-in users and cannot be modified. The
audit trails as well as log books are subject to data protection. Only authorized users are
allowed to inspect them. They are saved with the data files or into an audit file repository,
which is automatically archived.

Baseline

A baseline is established just after the First Peak Time setpoint. After the overall baseline

is established, a local baseline is calculated for each peak to compensate for baseline
drift.

For isolated peaks, the local peak baseline is simply a straight line connecting the Start
Point of the peak with the End Point. For peaks that are very close together, an average
baseline is used when the value between the peaks does not drop to the actual baseline.
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The figure below shows baselines established for DNA method peaks. Peaks for DNA
and protein methods are determined on a peak-by-peak basis (the overall baseline is
shown).
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The figure below shows baselines established for Total RNA method fragments. Total
RNA fragments are determined on a peak-by-peak basis and an overall baseline is shown
from the start to end time.
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The figure below shows baselines established for an mRNA method. mRNA fragments
are determined on a peak-by-peak basis and an overall baseline is shown from the start
to end time.
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NOTE

With RNA methods, you can move the lines marking the start and end points for data
analysis (shown by the long-dashed vertical green lines) which will adjust the entire
baseline for calculation of the area of the total sample.

Baseline Plateau

This setpoint (found in the setpoint explorer) rejects brief, low slope areas such as at
peaks and between non-baseline-resolved peaks. The signal is recognized to be at
baseline whenever the slope of the data is less than the Slope Threshold setpoint (either
positive or negative) for longer than the time set for the Baseline Plateau.

BMP file

BMP is the standard Windows image format. The BMP format supports RGB,
indexed-color, grayscale, and bitmap color modes.

Bubble

If the tip of a pipette is not positioned all the way to the bottom of a well, bubbles can
result (and sometimes bubbles happen even when you are very careful). The vortexing
step that occurs after samples are loaded into the chip is designed to rid the wells of
bubbles and is usually very effective.

If a large bubble is seen at the bottom of a well, remove the sample from the well, pipette
it back in, and continue with the loading procedure.
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C

CAD file

In Cell Fluorescence flow cytometric chip runs were stored as .cad files. 2100 expert can
import .cad files. See also XAD file.

Center Point

After locating a start point, the peak find algorithm looks for the first negative slope value
and saves the previous point as the center. If the value of the center point is less than the
Minimum Peak Height, the algorithm starts looking for a new peak.

CLD file

In Bio Sizing electrophoretic chip runs were stored as .cld files. 2100 expert can import
.cld files. See also XAD file.

COM Port
See Serial port.

CSV file

Comma-separated variable file. The simplest form of file for holding tabular data. Data is
listed in columns in a text file, each value being separated by a comma. Each new line
represents a new set of data. Import and export with Microsoft Excel is possible.

CSY file

In Cell Fluorescence flow cytometric methods were stored as .csy files. 2100 expert can
import .csy files. See also XSY file.
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D

Data Filtering

The first step 2100 expert takes in analyzing raw data is to apply data filtering. Data
filtering is done by means of a polynomial “filter” that is applied to the raw data. The
setting for the Polynomial Order in the setpoint explorer determines the amount of data
to be applied: the smaller the number, the more data that is applied and the more filtering
that takes place.

Data Points
Data points are 0.05 seconds apart.

Show Data Points is an option that enables the display of the data points used to
generate the graph.

E

Electrode Cleaner

An electrode cleaner should be used to clean the electrodes after each run is complete.
The cleaning procedure is slightly different depending upon the type of method that was
just performed (DNA or RNA).

The electrode cleaner looks like a chip except that it is clear. With RNA methods you
must use two different electrode cleaners: one for general cleaning using RNAse-free
water and another for decontamination using RNAseZAP. It is recommended to use a
permanent marker to label the electrode cleaners so as not to mix them up.
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Electrokinetic forces

Electrokinetic forces are used to move, switch and separate the samples. Active control
over voltage gradients directs the movement of materials using the phenomenon of
electrophoretic flow.

Electroosmotic Flow

A phenomenon that results from an electrical double layer formed by ions in the fluid and
surface electrical charges immobilized on the capillary walls. When an electric field is
applied, the bulk solution moves towards one of the electrodes. This phenomenon can be
used to move fluids through microfabricated channels.

Electrophoresis

A standard technique of separating molecules on the basis of their mobility
(charge-to-mass ratios). An electrical potential is applied across a capillary containing a
sample in a fluid medium. Positive molecules migrate towards the cathode and negative
molecules migrate towards the anode at different speeds, depending on their
electrophoretic mobility.

Electrophoretic flow

A macroscopic phenomenon that results from an electrical double layer formed by ions in
the fluid and surface electrical charges immobilized on the capillary walls. When an
electric field is applied, the bulk solution moves towards one of the electrodes (cathode).
Electrodes sit in the reservoirs that connect to the ends of the various channels.
Electrode potentials are applied to the various reservoirs in a time-dependent fashion to
move the fluid in the required direction. The gel-filled channels of the LabChip devices do
not exhibit a measurable flow because of dynamic channel coating and viscosity of the
polymer matrix.
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End Point

The peak find algorithm looks for a leveling off when the value of the slope is less than
the value set for the slope threshold. This is considered to be the end point of the peak.

With RNA methods, individual peak end times can be moved manually by dragging the
diamond-shaped end points shown in the single-well display.

End Time

This setpoint determines the time after the start of a run before which the last peak or
fragment will be located (any peaks appearing after this time are ignored). In RNA
methods, the end time is shown on the single-well display as a long-dashed vertical
green line.

With RNA methods, another End Time setpoint is available that controls the end time for
an individual peak. Additionally, individual peak end times can be moved manually by
dragging the diamond-shaped end points shown in the single view.

F

Filter Width

This setpoint determines the width of the polynomial (in seconds) to be applied to the
data for filtering (noise reduction). The default depends on the method selected. This
setting should be less than twice the width of the peaks of interest or the peaks will be
distorted. Peaks that are distorted by the filter have positive and negative peaks on both
sides. To see an example of such distortion, increase the filter width to 5.
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Firmware

The firmware is a program to control the hardware of the Agilent 2100 bioanalyzer. It is
downloaded from your computer to the Agilent 2100 bioanalyzer and controls, among
others, data transfer or the measurement procedures.

Flow Cytometry

A method to detect cells with certain properties. In a continuous stream, stained cells
pass through a light beam. The emitted fluorescence is used for counting and
differentiation.

Flow Cytometry Standard—FCS

The FCS file format is the standard format used in flow cytometry to exchange data
between several applications.

G

GIF file

Graphics Interchange Format, GIF is a graphics file format that uses a compression
scheme originally developed by CompuServe. Because GIF files are compressed, the file
can be quickly and easily transmitted over a network. This is why it is the most commonly
used graphics format on the World Wide Web.

H

Height Threshold

The Height Threshold setpoint determines whether a peak is kept. It represents the
minimal peak height. For each peak, the difference between the start point value and the
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center point value (local baseline) must be greater than the Height Threshold value.
This setting is chosen in the setpoint explorer.

Histogram
Histograms are bar charts to display, for example, a frequency distribution.

HTML file

HTML (Hyper Text Markup Language) is the authoring language used to create
documents on the World Wide Web. HTML defines the page structure, fonts, graphic
elements and hypertext links to other documents on the Web.

J

JPG file

Joint Photographic Experts Group Image File. A JPEG file is a compressed raster or
bitmapped graphic image. When a JPEG is created, a range of compression qualities may
be considered. JPEG compression is a lossy process, which means that you sacrifice
quality for file size the more you compress the image (the highest quality images results
in the largest file size). Whereas GIF images are limited to 256 colors (8-bit), JPEG images
may contain millions of colors (24-bit) as well as additional information including
PostScript clipping paths.
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L

Lab-on-a-chip

The generic term for a microfluidic product, signifying a chemical process or material
movement taking place on a microchip. In contrast to analysis in a standard laboratory
that relies on human intervention at several stages to manipulate or observe samples
and record results, the self-contained lab-on-a-chip represents an almost hands-free
technology.

Lab-on-a-chip technology means downsizing of analytical techniques from lab-scale to
chip-scale:

* using techniques like electrophoresis, chromatography, and sieving.
* with fluorescence, absorbance, and MS detection.

 with a higher degree of automation, integrating multiple steps of a complex protocol
into a miniaturized system.

Virtually any biochemical testing that can be done in a laboratory can theoretically be
done on a chip.

Ladder

Each electrophoretic LabChip Reagent kit contains a ladder. A ladder contains DNA, RNA
fragments or proteins of known sizes and concentrations.

A ladder well is located at the bottom right of the chip. The ladder is analyzed first before
sample analysis takes place.
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The peak sizes and markers defined for the ladder are assigned consecutively, starting
with the first peak detected in the ladder. Peaks appearing above the upper marker do not
have to be detected. The peak table for the ladder well shows the peak size and
concentration.

Lower Marker

An internal standard that is added to a sample in a well to assist in determining size of
the sample. The lower marker is the same as the first peak found in the DNA ladder.

M
Method

Methods are available in the 2100 expert software only with the security pack installed. A
method is referred to as an electrophoretic or flow cytometric assay with additional
information stored to it. This additional information includes instrument information,
study information, report settings, and workflow definitions.

Microfluidics

The movement of liquids through micro-fabricated structures by means of electrical
fields or pressure/vacuum, holding the promise of greater functionality with significantly
improved reliability:

» small glass or plastic devices with micro-channels as experimental platform

* active control of fluids without moving parts on-chip through miniature electrodes or
pumps controlled by software scripts

« emulation of conventional liquid pumps, valves, dispensers, reactors, separation
systems, etc.
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« capability of liquid transfer, separation, dilution, reactions and more

Molarity

Concentration*10% | nmol
Molarity = g5 Size [ I ]
where:

Molarity is measured in nanomoles per liter (nmol/l)

Concentration is measured in nanograms per microliter (ng/pL)

Size is measured in base pairs (bp)

660 [ 2 ]
mol * bp is the molecular weight of a single base pair

Miniaturized laboratories on a microchip
Expression used to describe lab-on-a-chip technology.

Molecular separation techniques

Processes such as gel electrophoresis, liquid chromatography and capillary
electrophoresis that can separate bimolecular organic substances from other
compounds.
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P

PDF file

PDF (Portable Document Format) is a file format created by Adobe Systems Incorporated
that preserves all of the fonts, formatting, colors, and graphics of any source document,
regardless of the software and computer platform used to create it.

Peak Baseline

A local peak baseline is calculated for each peak. For isolated peaks, the local peak
baseline is simply a straight line connecting the start point with the end point. For peaks
that are very close together, an average baseline is used when the value between the
peaks does not drop to the actual baseline.
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Peak Filter Width
The Peak Filter Width setpoint determines the minimum amount of time that must elapse

before a peak is recognized.

Peak Height

The value at the center point of the peak minus the local baseline start value.

Point-to-Point Fit

This curve fit is composed of line segments between each pair of data points that are
used to interpolate data between those points.
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Polynomial Filter

The first step 2100 expert takes in analyzing the raw data is to apply data filtering. Data
filtering is done by means of a polynomial “filter” that is applied to the raw data.

Priming Station

Consists of a chip holder that has a syringe mounted on the lid that seals over the chip.
The syringe is used to force the buffer solution loaded into the well marked “G” with a
circle around it into all the passageways inside the chip prior to running it in the
bioanalyzer.
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S

Serial port

The serial ports (COM ports) are used to connect your computer with the Agilent 2100
bioanalyzer. The number of available ports depends on the computer you use.

Signature

Signatures are available in the 2100 expert software only with the security pack installed.
All activities on data such as creating, modifying, and deleting data must be confirmed by
the user with an electronic signature (user name and password). By requesting this
signature it is ensured that only authorized users can create, modify, and delete data.
Slope Threshold

The Slope Threshold setpoint determines the difference in the slope that must occur in
order for a peak to begin. The inverse of this value is used to determine the peak end.
Standard Curve

The standard curve is obtained by plotting the size of the ladder peaks vs. time using a
point-to-point fit. For each sample peak, the center time is interpolated from the Standard
Curve to determine the peak size in base pairs.

Start Point

The peak find algorithm walks the data from time zero looking for a slope greater than the
Slope Threshold. This is considered to be the start point of a peak.

With RNA methods, individual peak start times can be moved manually by dragging the
diamond-shaped start points shown in the single view.
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Start Time

This setting determines the time after which the first peak or fragment will be located
(any peaks appearing before this time are ignored). In RNA and Protein methods, the
start time is shown on the single view display as a long-dashed vertical green line (note
that this is true for protein methods when analysis is on; the start time is shown as a
solid green line when analysis is off for protein methods).

With RNA methods, another start time setting is available that determines the start time
for an individual peak. With RNA methods, individual peak start times can be moved
manually by dragging the diamond-shaped start points shown in the single view.

T

Tool Tip

A small box containing text that describes the item indicated by the mouse pointer. To
view a Tool Tip, position the mouse pointer over an object on the screen. Leave the
mouse stationary for a moment and a Tool Tip (if one exists for that item) will appear.

TIF file

A file extension indicating one of a set of popular bitmap graphics formats. Tiffs are
commonly used in DTP work because of their support for color specification.
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U

Upper Marker

An internal standard that is added to a DNA or Protein sample in a well to assist in
determining size and concentration of the sample. The upper marker is the same as the
last peak found in the sizing ladder.

W

WALV file
A type of computer file used to store a sound digitally.

Workflow

The workflow defines the order of steps that need to be taken for a measurement to
ensure data validity and data reliability. This includes steps such as the execution of
methods, result reviews, and the final approval.

The workflow definition is part of the methods and is available in the 2100 expert
software only with the security pack installed.

WMF file

Windows Metafile. Windows metafile documents can contain any mix of vector and
raster (or bitmapped) information to describe the contents of an image. WMF graphics
are generally used on the Windows platform as a standard format for clip art and other
graphically rich information such as charts.
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X

XAD file

2100 expert chip data file. The files contain raw data, method information, data analysis
setpoints, information on chip, samples and study, and the run log information.

XAC file

2100 expert comparison file.

XLS file
Microsoft Excel spreadsheet file.

XML file

Extensible Markup Language files. XML is the Extensible Markup Language, a system for
defining specialized markup languages that are used to transmit formatted data. XML is
conceptually related to HTML, but XML is not itself a markup language. Rather itis a
metalanguage, a language used to create other specialized languages.

2100 expert uses the XML format to:
e export chip data
* save and load result flagging rules.

XSY file

2100 expert method file. The files contain the method properties, data acquisition
settings, and information on chip, samples, and study.
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XVD file

2100 expert verification result file. The files contain results of verification tests regarding
the bioanalyzer hardware and software. xvd. files are stored in the “..\validation”

subfolder of the 2100 expert installation directory. For each verification run, an .xvd file is
generated.

Date and time of the verification run are included in the file name. Example:
“Verification_23-05-2005_10-28-40".
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z

Zero Baseline

All electropherograms produced with the bioanalyzer show some amount of background
fluorescence. By default, the 2100 expert software enables the zero baseline function.
Enabling this setting offsets the graphs shown for the individual wells but does not affect
analysis. The mean of 100 points before the baseline time (derived when calculating well
noise) is used as the zero baseline value.
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To remove the zeroing, disable the Zero Baseline box in the setpoint explorer (baseline
calculation under Global and Advanced setting).
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Antibody staining, 273 Cell detection, 193
APC, 192 Chip reagents, 209
Apoptosis assays, 277 Color
Assay setpoints, 293 overlaid histograms, 255
Assays Comparing samples, 166
Creating new, 295 Comparison context, 166
Generic, 201 Configuring markers, 247
Opening, 299 Context
Predefined, 199 definition, 38
Stopping, 90, 224 Copy
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Base pair, 405 Creating new assays, 295
Baseline, 147 Cyb, 192
Bioanalyzer manuals, 9
Bioanalyzer tests, 370 D
Bubbles, how to avoid, 210 Data

specify file names and directories, 344
Data analysis setpoints, 139
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Data analysis setpoints, 293
Data files, 290
Data points, 99, 232
Documentation, related, 9
Dot Plot

generating, 197
Dyes, 191

E

Electrode cartridge, 80
Electrodes, 82, 213
Electrokinetic forces, 399
Electroosmotic Flow, 399
Electrophoresis, 399
Electrophoretic flow, 399
Event, 194

F
Fluorescence dye, 67

G
Gates
working with, 270
Gating, 238
direction, 251
Gel electrophoresis, 405
GFP, 191
GFP assays, 283
Green fluorescent protein, 191, 283
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Histogram
generating, 195
overlaying, 252

I

Inserting marker, 244
Inserting peaks, 159
Installation verification, 378
Inverse pipetting, 210

L
Lab-on-a-Chip, 403
Laboratories on a microchip, 405
Liquid chromatography, 405
Log
Run log, 360
System Log, 364

M
Manual integration, 154
Marker, 237
configuring, 247
copying, 250
inserting, 244
limits, 249
removing, 246
Micro-channels, 67
Microfluidics, 404

Molecular separation techniques, 405
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Molecular weight, 405
Multi channel mode, 96, 230

N
Navigation, 97, 231

0

Opening assays, 299

Overlay histograms, 252
color and scale, 255

P
Pressure cartridge, 212
Products, 387

R
Raw data, 290
Reagent Kit Guides, 9
Reagents, 209
Region table, 137
Regions, 198
adding, 262
configuring, 265
copying, 268
size and position, 267
Related documentation, 9
Removing peaks, 157
Result flagging, 175
defining rules, 182, 184
exporting rules, 323
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importing rules, 311
Result table
histogram values, 257
regions, 271
RIN, 113
RNA integrity number, 113
Run log, 360

)
Scale

overlaid histograms, 255
Setpoint explorer, 140
Setpoints, 293
Show data points, 101, 234
Sieving polymer, 67
Single channel mode, 96, 230
siRNA Transfection Viability, 200
Smear analysis, 135
Spare parts, 387
Staining cells, 191
Starting an assay, 86, 219
Stop assay, 90, 224
System Log, 364
System verification, 378
SYTO16, 191

U
Undo zoom, 100, 233
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Zoom
Dot Plot, 99, 232
Histogram, 99, 232
Undo, 100, 233
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